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Welcome to Panorama

Welcome to Panorama! The product you are about to use, Panorama Sheets, is one member of the larger Pan-
orama family of super fast RAM based databases. Other products in this family include Panorama Pro and
Panorama Runtime. Each of these products has different levels of capabilities, but all of them feature super fast
RAM based searching and sorting and an easy to use, fluid, user experience.

All of the products in the Panorama family also share a common file format. This means that different users
using different products in the Panorama family can easily swap data back and forth. It also males it easy to
transition from one Panorama product to another. For example, if you start with Panorama Sheets but later
decide you need the full power of Panorama Pro. you can simply upgrade the software and continue working
with your existing databases without so much as a hiccup.

Let me introduce you to each of the members of the Panorama family.

Panorama Sheets is a hybrid that combines the power of a database with the familiar user experience of a
spreadsheet. All data entry, searching, sorting, data analysis and data manipulation is handled using a
straightforward spreadsheet like interface. Data can be easily imported or exported to/from text files and
spreadsheets, and can be printed either as a table or as mailing labels. Our unique Total Recall technology pro-
tects your data thru just about anything, including power outages and system crashes.

Panorama Pro starts with all of the features of panorama sheets and adds two major capabilities: forms and
procedures. Forms allow you to graphically design you own user interface for data entry, display and printed
reports. The built-in graphical editor makes it easy to lay out your forms any way you want. Each database
can have dozens or even hundreds of forms, so you can build a form for every possible application. (of course
you can always use the basic spreadsheet interface as well.)

Panorama Pro is also completely programmable, allowing the automation of common, and not so common
tasks. Basic repetitive tasks can be automated by anyone using the “watch me” recorder - no programming
knowledge required. If you do have programming skills, Panorama Pro has all the tools you’ll need to rapidly
build sophisticated custom database applications. You can even include code written in PHP, Ruby, Perl or
Python.

Panorama Runtime is an affordable companion for Panorama Pro. It includes all of the capabilities of Panorama
Pro, but without the design tools. It allows a developer or expert user to build a custom application using
Panorama Pro, and then distribute that application to client users without requiring the client users to pur-
chase a full copy of the pro version. It’s perfect for distributing panorama databases within a company, or for
consultants that develop custom applications for clients.
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This table summarizes the features of each member of the Panorama family.

Note: Runtime means the capability is available, but must be set up using Panorama Pro.

For more information about different members of the Panorama family, including pricing, please visit the
www.ProVUE.com website.

Feature Panorama
Sheets

Panorama
Pro

Panorama
Runtime

Price 39.95 299.00 129.95

Spreadsheet style row/column grid yes yes yes

Forms and Reports no yes runtime

Mailing Labels yes yes runtime

Programmable no yes runtime

Sorting yes yes yes

Searching yes yes yes

Select Duplicates 1 field multiple 
fields runtime

Relational yes yes yes

Shared databases (with Panorama Server) no yes runtime

Design Sheet no yes no

Security no yes runtime

Customizable Hotkeys no yes runtime

Display Maps no yes runtime

Tool Palette no yes yes

Speech Synthesis no yes runtime

Send Email no yes runtime

Import/Export Text yes yes yes

Import/Export VCards no yes runtime

Import Financial Data (OFX, QFX, QIF0 no yes runtime

Custom Menus no yes runtime



    
Step-by-Step Tutorials

It’s time to jump into the database fast lane! By the time you finish the lessons in this tutorial you’ll have a
solid foundation in the basic techniques you’ll need to use Panorama Sheets effectively.

This tutorial is divided into two lessons. Each lesson builds on the previous lessons and introduces more
advanced topics. In “Lesson 1: Building Your First Mailing List Database” on page 12 you’ll learn how to cre-
ate and set up a simple mailing list database. In “Lesson 2: Building and Organizing a Checkbook” on
page 65 you’ll not only build a simple checkbook register file but also learn several techniques for organizing
and summarizing the checkbook data. Each lesson should take from 30 minutes to an hour to complete. The
lessons are designed so you can easily follow along and actually build each database as you read. There are
plenty of illustrations to show what the screen will look like at each step, so you don't need to worry about
getting lost. 

Before you begin, you’ll need to install Panorama Sheets on your computer. If you haven’t done so already,
see the ProVUE web site, www.provue.com, for installation instructions. It’s not necessary to activate Pan-
orama Sheets to complete the operations in this tutorial. If you haven’t purchased Panorama Sheets yet you
can try out the tutorials before you decide that you want to purchase Panorama Sheets.

I hear the bell—class is about to begin. It’s time to get started with your new Panorama Sheets career! I hope
you have as much fun learning Panorama Sheets as we had creating it for you.

Sincerely,
  

Jim Rea, President

P.S. This tutorial teaches you how to work with Panorama. It assumes, however, you already are familiar
with your computer and operating system. You should be able to point, click, and drag selections, and be able
to make selections from menus, use scroll bars, and edit text. If you are not familiar with these skills, you
should review the tutorial information supplied with your computer.
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Lesson 1: Building Your First Mailing List Database
Mailing List

A mailing list for storing names and addresses is one of the most basic database applications, and is very sim-
ple to create with Panorama. Double click the Panorama application to start (or, if you are using Microsoft
Windows, use the Start menu. Panorama will automatically open the New Database Wizard, shown below.
(If you are already in Panorama you can open this wizard by choosing New File from the File menu.)

To create a database start by typing in the name of the first field. You can also click on the yellow star to
choose from a list of common field names.

Type here, or...

choose here
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To add a second field, press the + button and fill in the field name, like this:

There’s a shortcut if you’re creating a field with a common name — right click on the + button (or Control-
Click), then choose the field name from the pop-up menu.

For this lesson you will create a new mailing list database with seven fields — First, Last, Address, City, State,
Zip and Phone. (See “Fields” on page 104 for a mor detailed explanation of fields.) The wizard has a favorite
for a database that has almost exactly these fields, to use this simply click on the yellow star and choose Mail-
ing List.

The fields for a mailing list are automatically filled in for you.
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This template isn’t quite what we wanted for our new database — we don’t need a Country field but we do
need a Phone field. To fix this simply click on and edit the field name, or click on the yellow star and choose
Phone from the pop-up menu.

At this point you could add more fields, or edit or re-arrange the existing fields, but for this example we are
done and ready to create the new database. To do this simply press the Make New Database button at the
bottom of the window.

click here to edit 
field name ...

or choose name from pop-up menu
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When you press the Make New Database tool the wizard will create a new database for you. The database is
displayed using a row and column format called the data sheet. The new database contains one blank record
(line) and seven fields (columns).

Entering Data Into Your New Database

The new database is ready to use immediately — you can just start typing to enter data. For example, to enter
the name Bob simply start by pressing the b key. A small pop-up window will appear over the current cell.
This pop-up window is called the Input Box and is used for all data entry in the data sheet.

Complete the entry of the name by pressing ob. Notice that Panorama automatically capitalized the first
letter of the name. We’ll show you how to turn this feature on and off later (see “Automatic Capitalization”
on page 201 if you can’t wait).

When you’ve finished with the first name press the Tab key to move on to the last name.
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Continue typing and pressing the Tab key until you get to the phone number. When you tab into the Phone
field you’ll notice that Panorama automatically types in the ( for you.

The New Database Wizard has set up an Input Pattern to make typing the phone number easier (see “Input
Patterns” on page 207 for more information). All you have to type is the numbers, for example
7024879023. Panorama will type in the punctuation for you.

Once you’ve finished entering the phone number you have a choice to make. Press the Tab key if you want to
add another line and continue editing data.

Press Return or Enter if you are done with data entry for the moment.

If you want to delete this new record choose Delete Record from the Edit menu, or simply press the Delete
key.

Panorama types in (, ), space and - for you
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Making Corrections

It’s easy to change the contents of any cell. Start by double clicking on the cell. This opens the Input Box,
allowing you to type in a new value or to make corrections.

Press the Enter key or click on another cell when you are finished. (You can also press the Tab key if you want
to skip to next cell and edit it too.)

Editing a Multi-Line Cell

If you need more room to enter your data, you can expand the size of the Input Box. For example, you might
need to expand the Input Box to enter an address with more than one line. To expand the Input Box, move the
arrow to the lower right hand corner of the box. When the mouse reaches the corner, the arrow will flip over
so that it is pointed down instead of up.

When you see the arrow flip over, press the mouse and drag the corner of the box to the size you want.

double click to edit cell

mouse “flips over” in lower right hand corner
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When you release the mouse the Input Box will expand to the new size.

Now that the Input Box has been expanded you can use the Return key to add additional lines to the data
cell. You can add as many lines as you like.

When you are finished editing the address press the Enter key. The Input Box closes and now you can only
see the first line of the data. (If you want to see more than one line of data in a cell that is not being edited you
must use a form, which is not available in Panorama Sheets. Visit www.provue.com to learn more about more
advanced members of the Panorama family.).

If you double click to edit the data cell again Panorama will remember the new size of the Input Box.

only first line of text is visible in data sheet
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You can adjust the size of the Input Box any time it is open.

If the Input Box is less than one inch high it won’t have a scroll bar.

To learn more about expanding the Input Box see also.

Saving Your Work

To permanently store your new database choose the Save command from the File menu. Using the dialog,
choose the folder you want to save the database in. Type in the name of the file and press the Save button.

After the file is saved the name of the window will change from Untitled to the name of the file, in this case
My Mailing List.

select folder you want to save file in

type in name of file
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Importing Data Into the Mailing List

If you already have data in another program (FileMaker, Access, Excel, etc.) you can transfer that data to Pan-
orama Sheets by exporting it into a text file (tab or comma delimited) and then importing it into Panorama.
Panorama includes some text files with sample data, so we’ll import one of those files now. Start by choosing
Import Text from the File menu.

name of database data will be imported into

fields in database
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The next step is to select the text file that contains the data to be imported and drag it onto the wizard. For
this tutorial we’ve prepared sample data that is ready to use. To see this file, choose Show Sample Text Files
from the Special menu.

Now drag the file 200 Sample People.txt from the sample text folder onto the Text Import Wizard window.
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Now the wizard will show the data contained in text file. In this case the imported text has 15 fields, of which
six are currently visible.

Use the Tab Width pop-up menu to make the imported columns wider or narrower.
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The next step is to assign data from the imported text to specific fields in the mailing list database. Start by
dragging the second column of imported data into the First field.

Then drag the fourth column into the Last field.
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Continue to drag each of the text fields you want to import onto the corresponding database fields.

Once all of the fields are set up press the Import button.
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The wizard will import the data from the text file into the database.

Your database now contains 201 records — the single record you typed in plus the 200 records imported by
the Text Import Wizard. The total number of records is displayed in the lower left hand corner of the window.

Before you go any further you should use the Save command (in the File menu) to save the new data in the
database. Since you have already saved this file once and given it a name, Panorama will quickly save the file
without asking you for the name and location again.

To learn more about the Text Import Wizard see “Using the Text Import Wizard” on page 360.

Adjusting Column Widths, Font, Size and Background Color

To adjust the width of a column in the data sheet, move the mouse over the right half of the column name
(left half if the column is numeric or right justified). When the mouse is over the right half of the name it will
turn into a double left/right arrow.

total number of records in the entire database

mouse turns into double left/right arrow
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To adjust the column width press and drag to the left or right.

When you release the mouse the column width will be adjusted.
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Use the Font dialog in the Special menu to change the font and size of the text displayed in the data sheet.

When you change the size of the text Panorama changes with width of each column proportionally, so that
you do not need to adjust the widths of the columns.

Use the Save command (File menu) to save the new configuration.
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To change the background color of the data choose Preferences from the Panorama menu, then click on Gen-
eral Preferences. Then click the Data Record option of the Background colors section.

Use the dialog to choose the background color you want.

click here to change background color
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When you press Ok all open data sheets will change to the color you selected.

The new color will be used permanently for all data sheets until you change it. (For the remainder of this
tutorial this book uses the default gray background color.)
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Sorting the Database

Now that the database is filled with sample data you can start trying out Panorama’s commands for organiz-
ing data. The quickest way to sort by any single field is to right click on the field name and choose Sort Up or
Sort Down from the pop-up menu (if you don’t have a two button mouse you can hold down the Control
key while you click on the field name.

Panorama will sort the database as soon as you release the mouse. If you chose Sort Up the data will be
sorted from lowest to highest, if Sort Down then from highest to lowest.

right click on field name
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You can also sort by clicking any cell in a field and then choosing Sort Up or Sort Down from the
Records>Sort menu.

Sorting By Two or More Fields

You can use the Sort Multiple Fields dialog to sort by up to five fields at once. For example, suppose you
want to sort by state, and by cities within each state. Start by choosing Records>Sort>Sort Multiple Fields.

Use the pop-up menu to select the primary sort field, in this casse State. Then click on the + button to add
another row.

select primary
sort field

click to add 
another sort field
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Now use the pop-up menu to select the secondary sort field, in this case City.

Repeat the process if you want to sort by additional fields.

When all the fields are specified, press the Sort button. The database will be sorted by the fields you have
specified (in this example by state, and by cities within each state as well).

You can use the Favorites icon (yellow star) to save your most frequently used sorts for later re-use. See also
to learn more.
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Finding a Person

It’s easy to search for anything in a Panorama database — just choose Find/Select from the Records>Search
menu.

Type some or all of the text you wish to find into the dialog. In this case we what to search for a person named
Gutierriz so we will enter the first few letters of the name. As each key is pressed Panorama instantly shows
the data that matches your search (by default Panorama searches all fields in the database, we’ll show you
how to customize that in a moment).

When you press the Find button Panorama will locate Ms. Gutierrez.

(2) press Find button(1) enter some or all of name you want to find
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Finding Multiple People

Suppose you want to look up someone who’s first name is Alan, but you’re not sure what the last name is.
Start by choosing the Find/Select command. Clear out the previous search, then type in alan. The dialog
instantly updates to show that there are five people named Alan in this database.

When you press the Find button Panorama will find the first person named Alan in the database.

If this isn’t the Alan you were looking for choose Find Next from the Records>Search menu. Panorama will
skip to the next Alan in the database.

You can continue using the Find Next command until you have located every Alan in the database, and you
can use Find Previous to skip backwards.

click here to clear previous search
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You can also use the Find/Select dialog to jump directly to any of these five people. Start by re-opening the
Find/Select dialog, then simply double click on any row in the search results to jump directly to the corre-
sponding record.

After jumping to a specific record you can use Find Next skip forward and Find Previous to skip backwards
from that point if you wish.

double click to jump directly to a specific record
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Selecting Instead Of Finding

A second way to locate every person named Alan is to select the information (see “Finding vs. Selecting” on
page 139 for an extended discussion of this topic). To do this re-open the Find/Select command, but press the
Select button instead of the Find button.

Most of the database will disappear. In fact, only the records containing alan will remain visible (selected).
Everything else is temporarily invisible. Panorama displays the number of selected records in the lower left
hand corner of the window. In this case five records contain alan. We say that these five records are the
selected records. The other 196 records are invisible (unselected).

five selected records contain the name Alan
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Selecting from a Specific Field

So far we’ve been searching thru all fields in the database. In some cases, however, that doesn’t work out so
well. For example, suppose you want to locate all addresses in the state of California. Searching all fields for
ca brings up dozens of “false positive” matches like cambridge, carl, and american (if you scroll down you’ll
see that the California records we are looking for are included also).

To get rid of the false positives, use the pop-up menu to change Any field contains to State (the field we want
to search).
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Not type in ca. This time, only records from California are shown, with no false positives.

At this point you can press the Select button to select the California records in the data sheet, you can press
the Find button to locate the first record in the California, or you can double click on any of these records to
jump directly to it.

Selecting More of the Same

If you see something in your database and want to see more items that are similar, just right-click on the data
and choose Select Same from the pop-up menu. For example if I see a person named Sandra and want to see
if there are any more, I right click on the name and choose Select Same (if you don’t have a two button
mouse, hold down the Control key while you click on the cell.)



Page 39
It turns out there are four Sandras in this database.

You can repeat this process over and over, for example to select all records in Ohio.

Here is the selection.

If a database contains dates the pop-up menu allows you to select a range of similar dates — either a day, a
week, a month, a quarter or a years (see also).
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Using the Sounds Like Option

If you don’t know exactly how something is spelled you can try using Panorama’s sounds like option. To use
this option open the Find/Select dialog, choose the field to search, then choose the Sounds Like option.

Since the name Allen “sounds like” Alan, it now shows up in the search.

The sounds like option isn’t perfect, but it can find most similar sounds and spellings. You must, however,
know the first letter of the word or name you are looking for. For example, the sounds like option will never
think that the name Ellen sounds like Alan because the two names start with different letters.

1) choose field to search

2) choose sounds like option

3) type text to search for
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Making More Complex Selections

The Find/Select dialog can make more complex selections based on multiple criteria. For example, suppose
you want to select all people with zip codes from 50000 to 69999. This search can quickly be set up with the
pop-up menus.

Now suppose that in addition to records in this zip code range, you would also like to select all records in
Connecticut. To do this, start by changing the pop-up menu from All of the following are true to Any of the
following are true.

Next, press the + button to add another row to the search criteria.

1) choose field to search 2) choose type of search 2) enter text to search for

click here

to add another search criteria row
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Now fill in this new row to select Connecticut in addition to the original zip code range.

The process can be repeated to add up to eight search criteria rows.

As was described before, at any point you can press the Select button to select the specified records, or press
Find to jump to the first specified record, or double click on any record in the Find/Select dialog to jump to it.
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Selecting Data Based on a Formula

The Find/Select dialog pop-up menus can be used to set up a wide variety of specific search criteria. How-
ever, if you can’t find the search you want in the menus you can also use any boolean (true/false) formula.
This also allows you to use parentheses to control exactly how search comparisons are combined. To perform
a formula search, start by changing the pop-up menu from Any field contains to Formula is true.

Now type in a true/false formula. The formula shown below selects everyone on the west coast (California,
Oregon or Washington) with a phone number in the database.

To learn more about selecting with a formula see “Search Options (Formula)” on page 159 and “True/False
Formulas” on page 315.
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Selecting All Records

To make all of the invisible data re-appear choose Select All from the Search menu.

Panorama will display all of the data in the database again.
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Saving Your Favorite Searches

If you need to do the same or similar searches over and over, you can save any search so that you can re-use it
later. The first step is to set up the search — for example this search selects all states along the Pacific coast of
the United States.

To save this search, click on the yellow favorites icon and choose Add to favorites. 

Enter the name for your new favorite search.



Page 46 Panorama Sheets Tutorial
Now the new favorite is included in the menu, so you can re-use it at any time.

For more information about favorite searches see “Managing Queries” on page 160.

Closing a Database

To close a database first click on it (to bring its window to the front). If the database has only one window you
can close it by clicking on the window’s close box. If the database has more than one window you can close
each window individually or you can select the Close File command from the File menu. If you are following
along with this tutorial, close the My Mailing List database now.

If the database has been modified since the last time it was saved, you will be asked if you want to save the
changes. Press the Save button to save the changes. The database is now closed, and the memory it was using
is available for use with other databases.

Re-Opening a Recently Opened Database

You can always open any database by double clicking on it in the Finder (Mac) or Windows Explorer (Win-
dows).

double click to open
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If the database was recently opened or saved by Panorama, you can also quickly open it by choosing Recent
Databases from the File menu. A list of recently accessed databases appears.

To see all of your recently opened files, choose File>Open Recent>Search Recent. The most recently opend
files are shown at the top of the list.

I can double click on any row to open it, or I can simply press the 1 key (numeric 1). In fact, any of the nine
most recently accessed databases can be opened simply by pressing the corresponding digit (for example
pressing 4 will open the Tickler file).

The Recent Databases window can display hundreds of recently accessed files. If the file you are looking for
isn’t immediately visible you can type a few letters search for it. The example below shows all recently
accessed data relating to purchases.

To learn more about this wizard see “The Recent Databases Menu and Wizard” on page 348.
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Printing the Data Sheet

Before actually printing the data sheet you’ll set up a page header to print today’s date on the top left and the
page number on the top right of each page. To do this choose Headers/Footers from the File menu. This com-
mand opens a dialog that allows you designate headers on the top left, center and right and a bottom cen-
tered footer.

Start with the top left header. Type in the words Printed on and then press the Month dd, YYYY button.

type Printed on

then press button
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Now for the top right header. Type Page and then press the Page#  button.

Once both headers are set up press the OK button. (To learn more about the header and footer options avail-
able when printing the data sheet see “Printing Data Sheet Headers & Footers” on page 331.

Next, choose the Page Setup command from the File menu. (Before you do this, make sure that the printer
you want to use is connected to your computer and selected.) The exact options available in the Page Setup
dialog depend on the operating system and what kind of printer you are using, but in general you can control
the page size, orientation (tall or wide), and print reduction factor. Here is a typical Page Setup dialog.

type Page

then press button
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Select the printing options you want to use and press the OK button. To actually print the data sheet choose
Print from the File menu. The printing dialog will appear. The exact options available in this dialog depend
on the operating system and what kind of printer you are using, but in general you can control which pages
to print, how many copies to print, and whether you want to manually feed the paper. Here is a typical Print
dialog.

For the exact details on the operation of this dialog see the documentation that came with your printer. Press
the Print button to print the data sheet. Panorama will automatically print as many sheets as necessary.

If you want to print only a portion of the database, use the Select button in the Find/Select dialog to select
the data you want before printing the database (see “Selecting Instead Of Finding” on page 36). Only the vis-
ible records will be printed.
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Printing Mailing Labels

To print mailing labels, choose File>Print Labels.

This dialog shows a preview of what your labels will look like. If everything is in order then go ahead and
press the Print Labels button to actually print the labels. When you are done, press the Close button to return
to the data sheet.

You can customize various options: the type of label, the contents of the label, and the style of the label (font,
padding, etc.). See also to learn more. 
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Temporarily Hiding One or More Fields

If you need to temporarily hide a field, simply right click on the field name and choose Hide Field from the
pop-up context menu. (If you don’t have a two button mouse, hold down the Control key when you click on
the field name. Alternately, you can click on any cell in the field and then choose Hide Field from the Fields
menu.)

right click on field name
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The field, in this case Phone, disappears. You can hide as many fields as you want as long as at least one is
visible.

To make all hidden fields visible again, choose Show All Fields from the Fields menu. Or you can choose
Hide/Show Fields from the Fields menu. This opens a dialog that allows you to choose which fields to show
and which to hide.

When you press Apply, only the checked fields will be shown.
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This technique is especially useful when you want to print only certain fields. Simply pick the fields you
want and then choose the Print command. If there is a certain set of fields you use over and over again you
can set up a favorite for them. Start by opening the Hide/Show Fields dialog and pick the fields you want to
show. Then click on the yellow star and choose Add to Favorites.

Type in a name for your new favorite.

Now you can quickly call up this field configuration at any time simply by clicking on the yellow star.
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Tidying Up

Your mailing list database is complete, so now is the time to save your work permanently. Choose Quit from
the Panorama menu (OS X) or File menu (Windows). If you have made any changes to your database since
the last time it was saved, Panorama will ask you if you wish to save the database. You do, so click the Save
button.

Congratulations! You’ve successfully created and used your first Panorama database (you were following
along on your computer, right?). Now that you’ve mastered the basics you’re ready to move on to some more
advanced techniques.

Extra Credit — Importing, Cleaning up and Adding a List of Names to the Mailing List

Suppose a colleague has sent you a spreadsheet with names you need to add to your mailing list. The names
are formatted differently from your list, but I’ll show you how Panorama can take care of that. (The spread-
sheet below is in Apple’s Numbers program, but the techniques I’m about to show you also works with
Microsoft Excel.)
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Since the data is in the wrong format I can’t import it directly into my mailing list. Instead, I’ll import it into a
new database, fix up the data, and then add it to the mailing list. I’ll start by opening the New Database Wiz-
ard, selecting all of the data in the spreadsheet, and then dragging it onto the wizard. (If you want to follow
along you can find the New Members spreadsheet by opening the New Database Wizard, then choosing
Show Sample Text Files from the Special menu.

Note: If you’re using a Windows PC system dragging to the New Database Wizard is not enabled. Instead,
you’ll need to select all of the data in the spreadsheet, copy it into the clipboard, then go to the New Database
Wizard and press the Import From Clipboard button.

Once the data has been dragged (or copied) to the new database wizard, the wizard will parse the data into
three fields. Since in this example the first row of the data contained the field names, I am ready to go. Other-
wise I would need to edit the field names now. 

To actually create the new database I press the Make New Database button.
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Here’s the data.

Now that the data has been transferred to Panorama I can get to work on fixing the data so that it matches my
mailing list. The first step is to fix the capitalization — I hate all caps! To do that I choose Manipulate Data in
Field from the Field menu.

As shown above, click the + button to add a manipulation row to the dialog. Then click on the pop-up menu
to change the selected manipulation to Modify Capitalization.

click + to get started

click for pop-up menu, change to Modify Capitalization
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Now I change All Caps to Word Caps. The instant preview shows that the names now look the way I want
them to.

I press the Apply button to actually change the database, then I repeat the same steps for the Address field.
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Now I need to split the names into separate first and last names, and the addresses into separate street
address, city, state and zip fields. I start by clicking anywhere in the Name field, then choosing Split Field
from the Fields menu. Using the dialog, choose the options to split the first and last names.

Actually splitting the field just takes a fraction of a second.

The first and last names are reversed so I click on the column header…

and drag it into position,

1) Specify how field will be split

2) Type in new field names

3) Check preview

4) Split the field
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Splitting the address is similar to splitting the name. Again I start by clicking anywhere in the Address field
and choosing Split Field from the Fields menu. It will take three passes to split this into four fields, I’ll start
with the zip code field, as shown here.

Once again, actually splitting the field only takes a fraction of a second.

Splitting off the state is pretty much the same as splitting off the zip except that the split is at the last comma
instead of the last space. (The states need to be all caps, but I’ll fix that in a moment.)

1) Specify how field will be split

2) Type in new field names

3) Check preview

4) Split the field
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Finally I split off the city, also at the last comma.

Here’s the finished result, with all the fields split. (To learn more about splitting fields, see “Splitting a Field”
on page 222. You can also merge fields, see “Merging Adjacent Fields” on page 228.)

Before I transfer the data to my mailing list I need to convert the State field to all caps. To do that I click any-
where in the field, choose Manipulate Data in Field, then set up the dialog to modify the capitalization:

I press Apply and the data is ready to transfer.
ToT



Page 62 Panorama Sheets Tutorial
To actually transfer the data I first need to save it, so I choose Save from the File menu and give the new file a
name. I’ll call it New Members.

I’m done with this new database, so I can close it and get back to my original My Mailing List database.
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With the My Mailing List database active, I choose Append Database from the File menu, then choose the
New Members file.

I am now asked how I want to match the fields in the two databases. The default (Match Fields by Name) is
fine so I simply press the Append button.
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The data has been transferred from the spreadsheet to the mailing list database, without any retyping and
without any programming or formulas.
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Lesson 2: Building and Organizing a Checkbook
Checkbook

Now that you’ve created your first simple mailing list database, you’re ready to try something more compli-
cated. In this lesson you’ll build and use a database for keeping track of a checkbook. Start by launching Pan-
orama and the New Database Wizard.

The checkbook database will have eight fields — Date, Check, Pay To, Category, Memo, Debit, Credit and
Balance. In the Lesson 1 mailing list file all of the fields were text fields, but this checkbook database will
include text, dates and two different types of numbers. I’ll start by clicking on the small yellow star and
choosing Date from the pop-up menu.

Choosing from this menu automatically sets up all of the attributes for the field (of course you can also set up
these attributes separately.

The next field will contain check numbers. Set it up using the steps shown below.

click here to choose from a list of the most common field names

name, type and other attributes fill in automatically

1) Press + to add another field

2) Type in field name 3) Switch to numeric
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The next three fields are text fields, so I just press the + button to add the field and type in the field names.
(Panorama displays a warning because the Pay To field name contains a space. Field names with spaces or
punctuation require special handling when used in a formula. Since I’m not planning to use Pay To in a for-
mula, I’ll ignore this error.)

I’ll click the Ignore Warnings checkbox to suppress the warning.

Like the Check field, the Debit field is numeric. The Debit Field, however, has two digits after the decimal
point (or you might want to use the Float or Money options, see “Numeric Data” on page 195).

Warning appears because of blank in Pay To field name

1) Press + to add another field

2) Type in field name

3) Switch to numeric

4) 2 digits after the decimal point
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After adding the Credit and Balance fields the setup is complete.

Press Make New Database to actually create the new checkbook database.

Panorama creates a new, empty database with the specified fields. It then asks if you would like to fill the
database with sample data (it doesn’t usually do this, but has been specially programmed with sample data
for some of the tutorial databases).
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Press Yes to load the database with sample data that will be used in this tutorial.

You may want to adjust the widths of some of the columns (see “Changing the Width of a Field” on
page 128).

Before continuing you should use the Save command in the File menu to save your new creation. The first
time you save any file Panorama will ask you to give it a name, I’ll call it My Checkbook.
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Analyzing the Checkbook

In the next few sections you’ll learn several techniques for extracting useful information from any database. 

Selecting Data

Suppose I’d like to look at all office supply expenditures. Since one office supply check is already visible, all I
have to do is right click on the cell and choose Select Same. (If you only have a one button mouse then hold
down the Control key and click on the cell.)

Panorama will select the 73 checks for office supplies in the database. All of the other checks will become tem-
porarily invisible.
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To see only the records in October, right click on any cell in that month and choose Select Same Month.

Now all 43 records in October are shown.
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To see only checks for Office Supplies in October, open the Find/Select dialog (from the Records>Search
menu), then set up the options as shown below.

Press the Select button (or the Enter key) to actually select the 8 checks for office supply expenses in Octo-
ber 1998.

When you want to see all of the checks again, choose Select All from the Records>Search menu. You can also
undo the sixteen most recent selections with the Undo command in the Edit menu.
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Calculating the Grand Total

To calculate the grand total of all the checks in the database simply right click anywhere in the Debit field and
choose Column Stats.

A small pop-up window displays the total, along with other information about the values in this field.

If only a subset of records is selected then the statistics will reflect that subset. For example, if only records
from July are selected then the total will include only checks from July.

Analyzing and Calculating Subtotals

Panorama has a special tool for analyzing and summarizing database information, the Analyze Data dialog.
To open this dialog, choose Summarize & Analyze from the Records>Analyze menu.
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This dialog allows you to use pop-up menus to specify how you want the database to be summarized and
calculations to be performed.

The top section of the dialog, Summary & Analysis Options, is where the Group/Calculate/Outline analysis is
set up. When you first open the dialog this section contains three rows that are preset for summary (group),
total (calculate) and outline level:
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Start by choosing the field you want to summarize by. For date columns you will also have a choice of peri-
ods (day, month, year, etc.)

Once you've selected the summarization field the dialog will show you how many different groups of data
are associated with that field, and also list all of the groups in the Group Preview area below.

Next, use the pop-up menu in the second row to choose a column you want to perform calculations on. (In
addition to totals, you can also calculate counts, averages, minimums and maximums.) Once you've chosen a
column the dialog will show you the grand total for this column.

The final row allows you to control what level of the outline is initially displayed. It defaults to the primary
summary field, so you can usually just leave it as-is. However you have a choice of any field you have sum-
marized by or you can elect to include the raw data in the display.
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To actually create the outline press the Apply button. Panorama will organize the database into an outline
with summary records for the groups you have specified.

The original data records are temporarily hidden. You’ll see how to bring them back later.

Multi-Level Summaries

The previous example create one summary level. Panorama can create up to seven nested summary levels,
for example Categories within Months, or Cities within States within Months within Years. To add an addi-
tional summary level, re-open the Summarize & Analyze dialog, then press the + button on the first row to
add a second summary level.

summaries for each month

grand total

click + to add another summary level
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Now use the pop-up menu to select the field to be summarized. The summary preview will show the groups
that will appear at this summary level.

The outline level pop-up menu now gives you the choice of either summary level or raw data. All levels at
and above the selected level will be display.
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Pressing the Apply button organizes the database into a multi-level outline.

Scrolling down to the bottom of the database shows the grand total for the entire database.

Using the same technique you can add up to seven nested summary levels. See “Data Analysis” on page 167
to learn more about analyzing data with summaries.

summaries by month

sub summaries by category (within month)

grand total
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Expanding and Collapsing the Summary Outline

A unique feature of Panorama is that summaries aren’t just static on a report, they can be dynamically
expanded or collapse to show more or less detail. You can “zoom out” to look for major trends, then “zoom
in” to examine specific details. We call this collapsing (zoom out) and expanding (zoom in). To expand a par-
ticular summary, ricght click anywhere in the summary and choose Expand One Level of Detail from the
pop-up menu (if you don’t have a two button mouse then hold down the Control key while you click).

Panorama makes the next level of detail visible.

right click and choose Expand One Level of Detail
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If the database has more than one summary level you can repeat the process all the way down to the raw
data.

In this example we are now down to the raw data for purchases in June 1998.
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To collapse a summary, right click on it and choose Collapse Underlying Detail.

Another way to collapse is to right-click on a detail record, then choose Collapse this to. This is especially
handy if the summary record you want to collapse isn’t currently visible in the window.

right click and choose Collapse Underlying Detail
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The example above shows doing this with a data record, but this trick works on any record except for the
final grand total. The menu adjusts to show exactly what is about to be collapsed, as shown below.

At the start of this section we showed how to expand one level at a time. You can also click on a summary and
ask Panorama to expand it all the way to the raw data, all in one step. To do this right click on the summary
and choose Expand ALL Underlying Detail.

right click and choose Expand ALL Underlying Detail
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This makes all subsummaries and raw detail associated with this summary record visible. In the example
below, we now can see all of the data and sub-summaries for November 1998.

Expanding and Collapsing the Overall Summary Outline

In the previous section you learned how to collapse and expand individual summary records. Sometimes,
however, you’ll want to expand or collapse the entire database as a whole. The fastest way to do this is with
the Data Sheet Context menu. Simply right click anywhere in the data sheet and choose the outline level you
want to see.

right click anywhere in data sheet

then choose the level you want to see
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If you choose RAW DATA then everything will be visible — the original data, and all summary records.

If you choose GRAND TOTAL then only one record will be visible — the grand total summary record. The
choices in between will display varying levels of summary detail.

Getting Rid of Summary Records

When you’re finished with summary records, you can simply choose Records->Analyze->Remove All Sum-
maries to get rid of them. All of the summary records will disappear, and you can get back to working with
your original data. This command is also available in the right-click context menu.
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Ranking Summaries

Panorama normally generates summaries in alphabetical order. By adding an extra rule to the Summarize &
Analyze dialog you can tell Panorama to rank the summaries by value. For example, if you are summarizing
by month they could be ranked to show the month with the highest sales (or spending, etc.) first, then the sec-
ond highest etc. Start by clicking on the + button in the outline level row of the dialog.

Panorama assumes that you want to rank by the field that is being totalled in this analysis (in this case Debit),
but you can choose another field if you wish. Then press the Apply button to see the ranked summaries.

For multi-level nested summaries you can use the outline level pop-up menu to pick which level is ranked.
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Whatever level you specified will be ranked. In this example, the category summaries are ranked within each
month.
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Ranking the summaries doesn’t affect the ability to expand detail. For example, now that the summaries are
ranked we can easily see that the purchasing category in May was a bit higher than usual. To find out why,
right click on the record and choose Expand One Level of Detail (or just click and choose the Expand tool).

Now we can see that there was a large purchase made to Stamford Manufacturing, raising the purchasing in
that month.

The ability to “zoom” in and out like this is a great tool for actually understanding your data.



Page 87
Data Entry Helpers

Now let’s switch gears. Before you can analyze data you have to get the data into the database, and that usu-
ally means data entry with the keyboard. This job is never easy, but Panorama does have tools that can make
data entry faster and less error prone. The next few sections will look at how the data entry process can be
improved for each of the fields in the checkbook database.

Dates

The first field in the database contains the check date. You can modify the way dates are displayed. Start by
clicking anywhere in the Date field and then choose the Field Properties dialog from the Fields menu (see
“Modifying the Properties of an Existing Field” on page 191). (You can also open this dialog by double click-
ing on the field name at the top of the column.) The Field Properties dialog allows you to modify many of the
attributes of each field. The New Database Wizard has already set up some of the options in this dialog,
including the Field Name, Type and Default Value.

field name

field type

default value
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To change the output pattern, click on the icon and choose the option you want.

After you select the option press the OK button to get back to the data sheet. The dates are now displayed
with your selected pattern.

The pattern can be changed at any time.

The New Database Wizard automatically set this date field to default to today’s date. To see this in action,
select Add New Record from the Records menu). The new check automatically defaults to today’s date.

click here to change pattern
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Smart Dates

Panorama is very flexible about how you type dates. We call this feature “smart dates.” You can enter dates
numerically (for instance 04/09/02 or 4/9/2) or you can spell out the date (for instance April 9th, 1997 or Apr 9
97). You can use any character as a separator between numeric dates, for example 4-9-01 or even 4.9.01.

To enter today’s date, simply type today. You can also enter yesterday or tommorow. Panorama will auto-
matically convert these entries to the correct month, day and year.

If the date is in the current week, you can simply type in the name of the day, for example saturday or tue. To
specify a day in the previous or upcoming weeks add the words last or next, for example next tuesday or last
saturday.

Play around with entering different dates, then use the Cut Record tool to delete the new record.

Check Number

The second field contains the check number. You can modify the Field Properties to automatically add one to
create a new check number each time a new check is created. Click anywhere in the Check column and then
choose the Field Properties dialog from the Setup menu (see “Modifying the Properties of an Existing Field”
on page 191). (You can also open this dialog by double clicking on the field name at the top of the column.)
The New Database Wizard has already set up some of the options in this dialog, including the Field Name
and the Type.

Type… Date Entered

field name

field type
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To set up the default value for this field, click on the icon and choose the option you want.

Choosing Automatic increment by one sets the default value to +1.

Press the OK button to get back to the data sheet. Then choose Add New Record from the Records menu. The
new check automatically defaults to today’s date and is assigned the next check number, in this case 562.

click here to change default value

or you can type in the default value here
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Pay To

The third field contains the name of the person or company the check is made out to. Since you will often
write checks out to the same people over and over again you can take advantage of a very cool Panorama fea-
ture called Clairvoyance®. Clairvoyance automatically finishes your typing for you as soon as it thinks it can
identify what you are about to type based on the previous entries (see “Clairvoyance®” on page 204). Clair-
voyance can be turned on and off with the Field Properties dialog. Click anywhere in the Pay To column and
then choose the Field Properties dialog from the Setup menu (see “Modifying the Properties of an Existing
Field” on page 191). (You may have also heard that you can open this dialog by double clicking on the field
name at the top of the column. It’s really true!). The New Database Wizard has already set up some of the
options in this dialog, including the Field Name and Type. Use pop-up menu to turn on the Auto Capitalize
option, and the checkbox to turn on the Clairvoyance option, as shown below.

Press OK to close the dialog. Now try entering Blue Cross into the Pay To data cell. Leave your finger off the
Shift key as you type because Panorama will automatically capitalize the first letter of each word for you! As
soon as you press the letter l, Panorama’s Clairvoyance® feature will complete the entry for you by typing ue
Cross.

Clairvoyance automatically finishes your typing for you as soon as it thinks it can identify what you are
about to type based on the previous entries. If Clairvoyance guesses wrong (because this is a new entry that
hasn’t appeared before) just keep typing and complete the entry yourself.

B is automatically capitalized for you because of Auto Capitalize option

Clairvoyance automatically completes the entry for you
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Clairrows

When you hold down the Command key (Mac) or Control key (Windows), the up and down arrows on the
keyboard become clairvoyant arrows, or “clairrows.” With the key held down you can use the arrows to scan
through the values that are already in the database. Each time you press Command/Control-Down Arrow
the next value appears, while each time you press Command/Control-Up Arrow the previous value appears.
You can scan through the values until you find the information you are looking for, then press the Enter key
to enter the value. To give the clairrows a head start you can type in the first few letters of the information
you are looking for. 

Category

The Category field places each check into one of 11 categories (Rent, Insurance, Telecom, etc.) One way to
handle this field would be to use Clairvoyance® as described for the Pay To field. That way you would only
have to type in the first letter or two of the category. However instead of using Clairvoyance you are going to
set up a palette of radio buttons in the pop-up Input Box (see “The Choice Palette” on page 215). This palette
will have a radio button for each category. This palette is set up with the Choices option in the Field Proper-
ties dialog.

type   b

l
Cmd/Ctl-Down Arrow

Cmd/Ctl-Down Arrow

Cmd/Ctl-Down Arrow

Cmd/Ctl-Up Arrow

Cmd/Ctl-Up Arrow

Enter
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To manually set up choices simply type in each choice, separated by a space (if a choice contains a space use
an underscore instead, for example New_York). However since this database already contains data, Pan-
orama can fill in the choices for you. Simply press the Auto button to fill in the choices that already exist in
the data.

Press the Ok button to close the Field Properties dialog and go back to the data sheet, then double click on the
empty data cell at the bottom of the Category column. The Input Box will appear, but it is so small you can
only see the first button and part of the second.

Move the mouse to the bottom right corner of the Input Box. The cursor will flip over (see “Expanding the
Input Box” on page 125). Drag the mouse to expand the Input Box.

The radio buttons will automatically flow into the expanded box as you change its shape.

The box can be tall and skinny, short and fat, or anything in between. To select a value just click on the button
and press Enter or Tab, or simply double click on the button. You can also select a value by typing in the first
few letters of the value, for example U for Utilities or Pu for Purchases.

Click the Auto button…

The choices are automatically filled in
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The radio buttons are great if you want to select from one of the predefined categories, but what if you want
to add a check in a new category? To allow this you’ll need to go back to the Field Properties dialog and type
a space and a dozen underscores at the end of the list of choices. (The underscore is just to the right of the 0
key, hold down the Shift key and press -).

Press OK to close the dialog and go back to the data sheet, then double click on the Category field.

It looks just the same as before! What’s up with that? To find out, expand the Input Box just a little bit more.

Now you can see that there is one additional radio button at the end of the list. To enter a new category click
on this radio button and then type in the new category, in this case Auto.

Press the Enter key when the entry is completed.

To learn more about this feature see “The Choice Palette” on page 215. Before going on to the next step I rec-
ommend that you Save the database one more time.
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Looking Up the Category From a Previous Record

In this database a particular Pay To will almost always go with a particular category. For example the cate-
gory for checks to Blue Cross will always be Insurance, while the category for Staples will always be Office
Supplies. Panorama can be set up to use a formula to automatically look up the category from the previous
record, if any. To do this you’ll use the Field Properties dialog again. Click on the Category field, then open
the Field Properties dialog, then choose Assistant from the Formula menu.

This assistant lists thousands of items. To find the one needed, type lookuplast( into the search box, then dou-
ble click on the lookuplast( line (or simply press the Insert button).

1) Type lookuplast( into search box

2) Double click on lookuplast( line
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Double clicking this item (or pressing Insert) closes the Programming Assistant dialog and opens a dialog for
setting up the lookup( function (see “Linking With Another Database” on page 321).

Start by selecting the database you want to look up data from, in this case the current database.

Now tell Panorama what you want to look up, in this case the Category.

We want to look up the category in the last record in the database where the Pay To value matches the Pay To
value in the current field. So select Pay To for both of the last two pop-ups. Here’s the finished dialog with
everything filled in.
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Press the OK button to build the formula for looking up the previous category. The formula is automatically
placed into the Field Properties dialog, which is still open.

To learn more about how this formula works see “Linking With Another Database” on page 321. For now just
press the Ok button to go back to the data sheet. Then start typing Staples into the Category field.

When you press the Enter key Panorama will automatically look up the appropriate category, in this case
Office Supplies.
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Sometimes the check amount is the same from check to check also, for example a rent or subscription pay-
ment. You can go back to the Field Properties dialog and use the same technique to build a formula to look
up the previous check amount. The formula is almost the same as before, but this time it looks up the Debit
field and has a default value of 0 instead of "" (see “Linking With Another Database” on page 321).

Press the Ok button to close the dialog and go back to the data sheet, then start typing Pacific Properties into
the Category field.

When you press the Enter key Panorama will look up both the category and the amount from the previous
check to Pacific Properties.

If this isn’t the correct amount you can simply tab over to the Debit field and type in the actual amount. If you
haven’t done so already, Save the database again now.
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Calculating the Checkbook Balance

Calculating the running checkbook balance is a two step process. Start by scrolling over to the Balance field
and click somewhere in the field.

Now choose the Manipulate Data in Field command from the Fields menu, then use the pop-up menu to
change the Start with Field from Balance to Credit.

change from Balance to Credit

then press the + button
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Next, press the + button to add another row. Then use the pop-up menus to set up the calculation as shown
below. 

When you press the Apply button Panorama will perform this calculation over and over again for every
record in the database.

change Add Number to Subtract Field change Balance to Debit
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To complete the balance calculation choose the Vertical Data Tabulation command from the Fields menu.
Then click on the Running Total option.

Then press the Apply button to calculate the balance after each check or deposit.

The balance calculation is complete. Before moving on, however, it’s a good idea to… you guessed it, Save
the database.
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Chapter 1: Data Structure

A database is an organized collection of data. Panorama Sheets is a software tool that helps you organize
your data in the first place, and to re-organize it over and over again as your needs change. 

The Data Sheet

Visually, Panorama Sheets uses a row and column tabular format to structure your data. This is called the
Data Sheet.

Each row in the data sheet is called a record. Each column is called a field. The intersection of a row and a col-
umn is called a data cell, or just a cell. These are the fundamental components of any database. As you work
with a database, you will constantly be adding new records, revising and removing old records, and rear-
ranging (sorting, etc.) existing records. Fields can also be added, revised, and removed, but you will do this
much less often. Once the fields are set up, you will usually leave them alone.

records

fields
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Records

A record consists of a group of related information. Here are some typical examples of database records:

• In a contact database (like the one shown on the previous page), each record contains information
about a single person or company.

• In a personnel database, each record contains information about a single employee.

• In a real estate database, each record contains information about a single property.

• In an inventory database, each record contains information about a single item of inventory.

Most databases have anywhere from a few dozen to several thousand individual records. Panorama Sheets
always displays the current number of records in the lower left hand corner of the window (the contacts data-
base shown on the previous page has 107 records).

Fields

A field is a group of information that is all of the same type. Here are some typical examples of database
fields:

• Address – contains street addresses

• Phone – contains phone numbers

• Birthday – contains dates

• Balance – contains numbers

Most databases have somewhere between five and one-hundred fields. Panorama Sheets allows up to 250
fields per database (if you need more, you can upgrade to Panorama Pro, which allows up to 2,000 fields).

Every record in a database contains exactly the same fields. If certain records don’t use a particular field it can
be left empty, but the field itself still exists for every record. For example, notice that in the contacts database
on the previous page, some of the Title and Company entries are empty.

Each field has its own separate properties, starting with the name of the field. For example, a field can contain
either text, numbers or dates. Each field can have a default value that is assigned when new records are cre-
ated, and fields can also be automatically calculated based on the values in other fields. Numeric and date
fields can have patterns associated with them to customize how these values are displayed. Overall there are
more than a dozen properties that can be assigned to each field. (The fact that properties are assigned to
fields, rather than to each cell, is a major difference between Panorama Sheets and spreadsheet software. In a
spreadsheet, properties are assigned to each individual cell. This is a disadvantage for database work because
the spreadsheet software does not understand or enforce any structure for the data, and because individual
cells may move around as you sort, search and manipulate the data. Panorama’s records and fields maintain
their structure even as data is manipulated.)
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Creating a New Database from Scratch

The first step in using Panorama is to create a new database and set up the initial fields the database will con-
tain (you can always add or remove fields later). Choose File>New Database to open the wizard that helps
you set up the new database. 

The new database structure starts with a single field, named Text. That’s probably not the name you want, so
start by typing in the actual name of the first field. You can also click on the yellow star to choose from a list of
common field names.

Type here, or...

choose here
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To add a second field, press the + button and fill in the field name (either by typing or clicking on the yellow
start), like this:

Tip: There’s a shortcut if you’re creating a field with a common name — right click on the + button (if you
have a one button mouse, hold down the Control key while you click), then choose the field name from the
pop-up menu.

Once all of the fields have been added, press the Make New Database button.

Panorama automatically sets the width of each field. See also to learn how to manually adjust the width of a
field. Before you continue you should save your new database by choosing File>Save. When you save, Pan-
orama will ask you to give the new database a name, and to specify a location for the file.
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Text, Numeric and Date Fields

In Panorama, all data is not the same. To get the most out of a database, Panorama needs to know what type
of data you intend to store in each field — text, numbers or dates (see also). The New Database Wizard nor-
mally creates fields designed for holding text. If a field will contain numbers or dates use the pop-up menu to
designate the data type. 

Numbers

Numeric data can be stored in either fixed point or floating point format. If you choose fixed point you have
a choice of 0, 1, 2, 3, or 4 digits after the decimal point (the Money type is also fixed point, 2 digits).

You may wonder why there are so many choices for storing numeric data. After all, a number is a number—
right? Not quite. By choosing different numeric storage formats you are making a trade-off between space,
speed, accuracy, and range.

Number of 
Digits After 

Decimal Point
Example Largest Value Smallest Value Typical Uses

0 93842 2,100,000,000 1 Quantities, Part Numbers

1 73.1 210,000,000 0.1 Rarely Used

2 253.22 21,000,000 0.01 Money (Dollars, Pounds, etc.)

3 0.447 2,100,000 0.001 Rarely Used

4 929.1123 210,000 0.0001 Rarely Used

Float 1.46e-12 1.7•10308 2.3•10-308 Scientific Data
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Storing numbers using floating point gives you the most accuracy and numeric range. Floating point allows
you to store extremely large or small values with up to 16 digits of accuracy. If you are in doubt, go ahead and
pick floating point format.

Fixed point storage is more limited. The accuracy is only about 9 digits. The largest number that can be stored
is about 2 billion (2•109) while the smallest fixed point number is 0.0001 (10-4). Trying to store larger or
smaller values using fixed point storage will result in errors.

On the other hand the space required for fixed point storage is up to 8 times smaller than floating point for
the same number, and Panorama can perform fixed point arithmetic somewhat faster than floating point. You
should use fixed point numeric storage whenever possible. Check the table above to see if the numbers you
will be using fit in one of the fixed point numeric ranges. (With today’s modern computers, you may not need
to worry about performance or memory usage in most applications, and it’s usually ok to use floating point
for most applications.)

Money. Usually the best way to store monetary values is using either 2-digit fixed point or Panorama’s spe-
cial Money format. The money format is the same as 2-digit fixed point but automatically enters the decimal
point for you during data entry. This table below shows how Panorama interprets data you enter into a
money field.

Both the 2-digit and money formats allow you to store monetary values up to 21 million dollars, pounds,
francs, etc. (If your business deals with values greater than 21 million you should use floating point numeric
storage.)

Guidelines for Picking Field Names

Each field in a Panorama database is identified by a field name. Field names serve several purposes: they
remind you what the field is for (i.e. the Dates field probably contains dates, the Name field probably con-
tains names, etc.), they appear at the top of each column in the data sheet, and they are used to identify fields
in formulas (for example Amount=Qty*Price).

There are no absolute restrictions on the field names you choose. Field names may be as long as you want,
and they may contain any character that can be typed from the keyboard. Field names may be split over two
or more lines. You can even have two or more fields with the same name (but we recommend that you avoid
this, see the next paragraph).

However, if you are planning to use a field in a formula, you may want to avoid some of these unusual possi-
bilities. If you have two or more fields with the same name, only the first field will be accessible to a formula.
Field names containing blanks or punctuation (for instance P/E Ratio) are more difficult to use in a formula.
To use such a field in a formula, you must surround the field name with «  and » (for example «P/E Ratio».
See “Fields” on page 286). (If you left out the «», Panorama would think you were trying to divide P by E,
with Ratio left over.) You may want to avoid field names like Date, Seconds, And, Or, and Sum. These
names can be confusing when used in a formula because Panorama has functions with the same names.

When you 
enter… it becomes

87204 872.04

3267 32.67

14 0.14

2 0.02

42. 42.00

15.4 15.40

156.78 156.78
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Default Values

You can assign a default value to any field. To default to a fixed value, simply enter the value.

To repeat the previous value in this field (ditto) use the " symbol. When the defaults are set up as shown
below, a new record will automatically contain the same date and city as the previous record.

To automatically increment a numeric or date field use plus followed by a number (+1, +2, +5, etc.), like this.
When creating a new record, Panorama will take the value in the current record, increment it as specified,
and put the new number into the specified field.

You can also use the + symbol by itself. In that situation, Panorama uses an internal counter. The counter is
increased each time a new record is added. The counter can also be changed manually if necessary using
Setup>Next Record Number.

To default to today's date use today. (This option only works for date fields).
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Automatic Capitalization

When you are creating text fields you can enable automatic capitalization, either for all characters, by word or
by sentence.

Clairvoyance® (Auto Fill)

Another option for text fields is Clairvoyance®. When enabled, Panorama will auto-complete text entry for
you based on previous entries in the database. For more information, see also.

Rearranging Fields

To re-arrange fields before you create the database, just drag on the double arrows on the right side of the
windows.

Note: Fields cannot be dragged when you are importing data (see “Creating a Database from a Text File or
Spreadsheet” on page 114), only when creating an empty new, database.
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Field Name Warnings and Errors

The New Database wizard will warn you if you create a field name that is improper or that will require spe-
cial handling in formulas. There are two types of improper field names — a blank field name, or a duplicate
field name. If you create an improper field name Panorama will display a red background behind the field
line, with a red alert icon. Click the red alert icon to see a description of the problem.
p

The New Database wizard will not allow you to create the database until the improper field names have been
fixed.

Field names that will require special handling in formulas are flagged with a yellow background and a yel-
low alert triangle.
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Unlike improper field names, the New Database Wizard will allow you to create the database without
changing these field names, though it will warn you when you actually create the database. It’s simply up to
you to make sure any formulas you create have the special handling necessary (see “Fields” on page 286). If
you enable the Ignore Warnings option then Panorama will not display any warnings or yellow icons, though
it does still show a yellow background for these fields.

Favorite Field Structures

Panorama comes pre-equipped with a set of templates for creating new databases. To choose one of these,
simply click on the yellow Favorites star.
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You can add your own templates at any time (and remove the standard templates as well). The first step is to
set up the fields in the proper configuration, then click on the Favorites star and choose Add to favorites.

The wizard will ask for a name for the new favorite.
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That’s all there is to it! The new favorite now appears in the menu (in alphabetical order).

To rename or remove a favorite, first select it from the menu. Then open the menu again and choose Remove
or Rename.

Creating a Database from a Text File or Spreadsheet

The New Database Wizard usually creates an empty database, but it can also create a database from a text
file and automatically import the text. There are four possible ways to start this process.

1) Drag a tab or comma delimited text file onto the wizard.

2) Drag data directly from a spreadsheet, word processor or text editor onto the wizard (Mac only), as shown
below.

3) Click on the Choose Import File button, then select a text file containing tab or comma delimited text.

4) Copy tab or comma delimited text into the clipboard, then press the Import from Clipboard button.
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Whatever process you choose, the wizard will use the first line of the imported data as the initial field names.

You can make adjustments to the database design before actually creating the database, including changing
the field names and types, setting up defaults, auto capitalization and Clairvoyance®. You cannot, however,
add, remove or re-arrange fields (of course this can be done later, once the database is set up).

When everything is ready press the Make New Database button. Panorama creates the new database and
brings in the data.

The new database is ready to save and use.

new field names automatically set up for you (you can change if needed)

source of imported data shown here
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Chapter 2: Using the Data Sheet

In this chapter you’ll learn how to navigate within the data sheet, how to add and remove records, how to
edit data within individual data cells, and how to adjust, add and remove fields.

Navigating the Database

Your database may contain thousands of records and hundreds of fields, so you can only see a small portion
of the data at a time. You can navigate the database manually with the scroll bars or use Panorama’s exten-
sive searching tools to automatically hone in on the exact data you are looking for.

Moving From Record to Record

Use the vertical scroll bar to scroll a data sheet to any record in the database. Click on the scroll bar arrows to
move up or down one record at a time. Click in the scroll bar’s gray area to move up or down one window at
a time. Drag the scroll bar thumb to move directly to any position in the database.

In addition to manually moving from record to record, you can let Panorama search for the information you
want to look at or modify. See also for more information about searching for and selecting data.

down one line

up one line

up one page

down one page

drag up or down
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Moving from Field to Field

Within a data sheet, you can move to another field by clicking anywhere the field’s column (if it is visible) or
by clicking on the horizontal scroll bar. (See “Splitting the Data Sheet Window” on page 119 for information
on how to split a window into two separately scrollable “panes.”)

You can also use the Goto Field dialog (in the Fields menu) to move to a specific field. This is especially use-
ful if the database dozens or hundreds of fields. Initially the dialog displays a list of all of the fields in the
database. To go to a specific field click on it and press the Goto button, or simply double click on the field
name.

You can also search for the field you want. Type in a few letters from the field name in the search area.

The first nine fields listed are numbered from (1) to (9). To go to one of these fields simply press the corre-
sponding numeric key. For example to go to the Country field in the example above you could simply press
co2.

click anywhere in a column to select a field
or use the scroll bar
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Splitting the Data Sheet Window

Data sheet windows can be split into two side by side panes. Each pane displays a different area of the data-
base. The two panes are locked together vertically, but each pane has its own horizontal scroll bar.

To split a window, drag the splitter to the right. (The splitter is the small black rectangle to the left of the hor-
izontal scroll bar.)

To remove the split, drag the splitter back to the left edge. To adjust the split location, drag the splitter into
position.

press and drag to split window

each pane may be scrolled separately drag to adjust split
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Editing Records

A new database starts out with just one lonely record. Over its lifetime hundreds or even thousands of
records will be added to a typical database. In addition, many records will become obsolete and be deleted.
Both inserting and deleting records are easy tasks with Panorama.

Adding a New Record

To add a new record to the end (bottom) of the database, choose Add New Record from the Edit Menu.

You can also add a new record by tabbing from the end of the bottom line of the data sheet.

Inserting a New Record

When you are working in the data sheet, you can insert a new record either above or below the current
record. (In a form you can only add new records at the end of the database.) To insert a new record after the
current record press the Return key.

before Add New Record after Add New Record

before Return after Return

new blank record

new blank record



Chapter 2:Using the Data Sheet Page 121
To insert a new record before the current record, click on the Insert Record tool.

Usually new records are completely blank, ready for your input (as shown in the examples above). You can,
however, ask Panorama to automatically fill in one or more cells whenever a new record is created. A field
can default to a fixed value (like yes or no, or taxable, or today’s date), an automatically incrementing num-
ber (1, 2, 3, …), or a copy of the data in a previous record. See “Default Values” on page 211 for more informa-
tion.

before Insert Record after Insert Record

new blank record
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Deleting a Record

To delete an entire record, choose Records>Delete Record.

You can also delete a record by pressing the Delete or Backspace key (upper right hand corner of the key-
board, above Return). Panorama will display an alert asking you to confirm that you really want to delete the
record. (Mac only tip: If you want to skip the alert, hold down the Option key while you delete the record.)

If you delete a line accidentally, you can use Undo to restore the line. You can also get the line back with the
Records>Duplicate>Paste Record menu command.

Tip: A Panorama database must have at least one visible record—it cannot have zero records. If your data-
base has only one record, Panorama will not allow you to delete it.

before Delete Record after Delete Record
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Deleting Multiple Records

Sometimes you may need to systematically delete large numbers of records. For example, you might need to
delete all invoices previous to 1987 or all students with below passing grades. Instead of deleting these
records one-by-one you can let Panorama do most of the work for you. First use the Find/Select command to
select either the records you want to keep or the records you want to remove. If you selected the records you
want to keep, use the Remove Unselected command to delete everything else. If you selected the records you
want to remove use Remove Selected.

Remember, however, that you cannot delete every record—you must leave at least one record in the database
at all times. See “The Find/Select Dialog” on page 144 and “Permanently Removing Unselected Data” on
page 165 for more information on these commands.

Delete All

To delete all the data in the database, use the Delete All command in the Edit Menu. This command deletes
all the data, leaving just one blank record. Before it performs this dastardly deed, Panorama asks you to con-
firm that you really know what you are doing. Keep in mind that there is no Undo after Delete All. (How-
ever, if you saved a copy of your database, you can Revert to Saved.

You can use the Delete All command to set up a clone of an existing database. First open the original data-
base, then use Save As to save it under a new name. Finally use Delete All to empty the new database. The
new “cloned” database will contain all of the forms, crosstabs and procedures of the original database, but no
data.

Duplicating a Record

In the data sheet you can easily make one or more copies of a record.

To make a copy of the current record just below the current record, choose Records>Duplicate>Duplicate
Record. If you want to make a copy somewhere else, first use Records>Duplicate>Copy Record, then move
to the spot where you want the copy to appear and choose Records>Duplicate>Paste Record. You can repeat
the Paste Record command if you need multiple copies of the record. You can also move a record to a new
position by using Records>Delete Record, then moving to the new position and choosing Records>Dupli-
cate>Paste Record.
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Editing Individual Data Cells

Data cells are the smallest unit of information handled by Panorama. Each data cell contains a single piece of
information—a person’s name, a phone number, an account balance.

The currently selected cell is called the active cell. Only one cell can be active at a time. You can activate a cell
by clicking on it, or by scrolling to it with the scroll bars. You can also move the active cell with the arrow
keys.

The Input Box

Every data cell has a pop-up Input Box that is used to edit the text within the cell. The Input Box acts like a
temporary window that pops up on top of the data cell for data entry and editing.

You can open the Input Box by double clicking on the cell, or by making the cell active and starting to type.
Once the Input Box is open, you can edit the text within the cell using the usual mouse editing (word process-
ing) techniques. Specifically, you can click the mouse to select an insertion point, drag the mouse to select a
range of characters, cut, copy or paste selected text using the clipboard, or use the keyboard to type charac-
ters at the insertion point. (If you are not familiar with these techniques you should review the operating sys-
tem documentation that came with your computer.)

typical data cells

active data cell

double click cell to open Input Box for editing contents of cell
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When you have finished editing the text within the cell, press the Enter key. This closes the Input Box and
updates the data cell with your changes. The Input Box closes automatically (and updates the data) if you
click on any other data cell or window. Tip: Clicking anywhere outside of the Input Box is the same as press-
ing the Enter key.

If the Input Box is only one line high pressing the Return key will close the Input Box and update the data
cell. If the Input Box is more than one line high the Return key adds a new line to the data cell (see the next
section).

If you would like to close the Input Box without updating the data cell, press Command-Period (Mac) or
Control-Period (Windows). Pressing the Esc key also closes the Input Box without updating the data cell. Or
you can use the Undo command to restore the original text, then press the Enter key.

Expanding the Input Box

One of the most powerful features of the Input Box is that it can be expanded to accommodate large amounts
of data. To expand the Input Box, move the mouse to the lower right corner of the box. When you reach the
corner, the arrow will flip over. In the illustration below, you see the normal arrow cursor as you approach
the corner. The arrow flips over when it reaches the corner of the Input Box. (The arrow doesn’t actually
change color as shown here, the color is simply to make the illustration more clear.)

Once you see the upside down arrow, press the mouse and drag the corner of the box to its new location.

When you release the mouse Panorama will change the size of the box.

Now you can type additional lines into the Input Box. Press Return to start a new line.
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Once you change the size of the Input Box, Panorama remembers the size permanently. In the data sheet, the
Input Box size is remembered separately for each column, while in a form the size is remembered for each
individual data cell object. (Of course Panorama will forget the sizes if you Close or Quit without saving the
database.)

If you make the Input Box more than one inch high, a scroll bar is added on the right hand side of the box.
The scroll bar allows you to enter and edit up to 32,767 characters per data cell.

Tip: The scroll bar is actually outside the Input Box. To change the size of the Input Box you must click in the
bottom corner of the box itself, just to the left of the scroll bar (as shown above). Do not try to drag the corner
of the scroll bar.

Expanding a Right Justified Input Box

If you are editing a right flush data cell, move the mouse to the lower left corner of the box instead of the
lower right hand corner.

Once the mouse is over the lower left hand corner you can expand down and/or to the left.

Now you can edit the text in the expanded input Box. Press Enter when you are finished.
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Tabbing from Cell to Cell

To make it easier to enter several cells in a row, Panorama allows you to use the Tab key to move from cell to
cell as you enter data. In the data sheet you normally move from left to right, in a form from top to bottom. If
you want to move backwards (to the left) press Shift-Tab.

Tab Down

In the data sheet the Tab key normally moves from left to right. Sometimes it may be more convenient to key
a column from top to bottom instead of across a row from left to right. For instance, you may find it easier to
key in a dozen names, then a dozen addresses, then a dozen cities, instead of keying in each record sepa-
rately.

Choose Edit>Tab Down to change the tab direction from across to down. Choose it again to change back to
normal tab operation. Panorama indicates that tab down is active by checking this menu item.

When the Tab Down option is enabled, pressing Shift-Tab moves up one cell. 
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Adjusting Fields and Field Structure

You won’t modify, add or remove fields as nearly as often as you modify records and cells, but Panorama
does make it easy and fast to change entire fields.

Changing the Width of a Field

To change the width of a field, move the mouse over the right half of column name (or the left half if the col-
umn is right aligned, like a numeric column). The mouse cursor will turn into a double headed arrow.

When you see the double headed arrow, press the mouse. A gray box appears around the column. Drag the
mouse left or right, then release the mouse when the field is the correct width.

When the mouse is released the column width is adjusted (in this case, made wider).

If the column is right aligned (for example a numeric column) the process is flipped. Instead of dragging on
the right half of the column header, you click and drag on the left half.

It sounds more complicated than it is. Just move the mouse until you see the double headed arrow, then drag
left or right.
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Automatically Setting the Field Width

If you’d like Panorama to set the field width for you, just choose the Autoset Field Width command from the
Fields menu. To set the field width, Panorama calculates the average width of entries in the field, and then
sets the width to 120% of that value. For most fields this should be close to the optimum width, but of course
you can always make your own manual adjustments as described in the previous section.

The Autoset ALL Field Widths command sets the width of all fields. This can be handy after importing a lot
of new data into a database.

Re Arranging the Field Order

To move a field to a new position within the data sheet, move the mouse over the left half of column name (or
the right half if the column is right aligned, like a numeric column). You’ll see the mouse cursor turn into a
hand.

Now drag the column to the left or right to the new spot.

When the mouse is released the column moves to the new position.

If the data sheet is split horizontally you can drag a column from one side to the other. This makes it easy to
move a column a long horizontal distance within the sheet.

In the example above, the Email field will be moved between the Last and Organization fields.

Note: You can also swap two adjacent fields with the Swap Fields command.
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Temporarily Hiding One or More Fields

If you don’t want to see one or more fields, you can temporarily hide them in the data sheet. This is great for
de-cluttering the data sheet and is also useful for printing reports. The commands for hiding and showing
fields are at the bottom of the Fields menu. (In addition to the menu bar, these commands also appear when
you right-click on a data sheet column title.)

To hide the current field, choose Hide Field (Note: You must have at least one visible field).

To make all hidden fields visible again, choose Show All Fields.

To hide and/or show a bunch of fields at once, open the Hide/Show Fields dialog.
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This dialog displays a list of all the fields in the database. Check the fields you want to be visible, then press
the Apply button. All of the unchecked fields will be hidden.

If you have a configuration that you want to use regularly, click on the Favorites icon (yellow star). This
brings up a pop-up menu listing your favorite configurations.

The first two items in the menu are permanent, and quickly show or hide all fields. The other items in this
menu are custom and are set up by you on a database by database basis.

To create a new favorite, start by choosing the fields you want to show.
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Then click on the star and choose Add to favorites….

Panorama will ask you for a name for the new favorite and then save the configuration for later use.

Adding New Fields

To add a new field, use the Add Field or Insert Field command in the Fields Menu. The only difference is
that Add Field adds the new field at the end of the database, Insert Field insert the new field in front of the
current field. If your new field has a common name you can simply click on the star and choose the name
from the pop-up menu. As shown in the diagram below, Panorama will automatically fill in all of the options
that make sense for the field name you have chosen.

Press Ok to actually create the new field. (For a detailed description of all of the options in this dialog, see See
“Advanced Field Properties” on page 191.)
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Deleting a Field

To delete a field from the database, select a cell in the field and choose Delete Field from the Fields Menu. (If
you are using the data sheet, you can also press Command-Delete (Mac) or Control-Delete (Windows) to
delete a field.) This not only deletes the field, it also deletes any data in the field. If the field contains data,
Panorama will warn you that it is about to delete the field. You must confirm that you really want to delete
the field before Panorama will proceed.

Duplicating, Splitting and Merging Fields

Panorama can duplicate an existing field (including the data), split one existing field into two (splitting the
data as well), or merge two existing fields into one (merging the data). To learn more about these operations
see also.
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Chapter 3: Sorting

Most data is more useful when it is in some kind of order. Panorama has several commands that can quickly
sort your data into whatever order you need.

Sorting a Single Field

To sort a field, right click on the field name and choose Sort Up or Sort Down from the pop-up menu. (If you
don’t have a two button mouse, hold down the Control key while you click on the field name.)

You can also sort a field by clicking on any cell in the field and choosing Records>Sort>Sort Up or
Records>Sort>Sort Down.
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Sorting Multiple Fields

To sort by multiple fields at once, open the Records>Sort>Sort Multiple Fields dialog. Then choose the pri-
mary field to sort by (in this case the last name).

Press the + button to add another row to the dialog, and then choose the secondary field to sort by (in this
case the first name).

You can specify up to five fields to be sorted. When done, press the Sort button.

This database contains seven people named Abbott. Their first names are sorted within the last name
(Anthony, James, John, Lisa etc.).

Drag to re-arrange 
order

Add or remove fields
to be sorted
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If you think you’ll want to re-use a sort later you can save it as a favorite by clicking on the yellow star and
choosing Add to favorites. Panorama will ask you to name your new favorite.

You can re-use a previously saved favorite by clicking on the yellow star and selecting the favorite from the
pop-up menu.

The other buttons at the top of the dialog allow you to reset the sort criteria (back to one row) and two skip
backwards and forwards thru the sorts you have recently performed.

Incrementally Sorting Multiple Fields

Instead of sorting multiple fields all at once, you can also sort them incrementally, one field at a time. Start by
sorting the primary field as described at the beginning of this chapter, using either Sort Up or Sort Down.
Then click on the secondary field to be sorted and choose Sort Up Within or Sort Down Within. You can con-
tinue to use the Sort...Within commands to sort 2, 3, 4, or more fields.

reset sort criteria skip back/forward thru previously used sorts
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Sorting Numbers and Dates

It is important to store numbers using the numeric data type, and dates using the date type. If you store num-
bers and dates using the text data type they will not sort correctly, as shown in this table.

If your numbers or dates are not sorting correctly, make sure they are stored using the correct data type. See
“Numeric Data” on page 195 for more information on the numeric data type. See “Dates” on page 200 for
more information on the date data type.

Sorting Right Justified Text

If your text is right justified, it will sort like a numeric field. In other words, 2 will sort before 10, and B will
sort before AA. The actual sorting rules for right justified text are—1) short data sorts before longer data (B
before AA) and 2) if two data items are the same length, they will be sorted in alphabetical order (AA before
BA).

Sorting Selected Data

Sorting is not affected by the Find/Select command. The sort commands always sort the entire database—not
just the selected records. When the invisible data is selected again you will see that it is sorted properly
within the rest of the data.

Sorting Within Groups

Later you’ll learn how Panorama can organize a database into groups, with summaries for each group (see
also). If you attempt to sort your database after it has been grouped, Panorama will automatically sort the
data within the groups instead of sorting the entire database. If you want to sort the entire database you must
remove the groups with the Records>Analyze>Remove All Summaries command.

Stored

as Numeric

(correct)

Stored

as Text

(incorrect)

9 6000

80 700

700 80

6000 9
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A Panorama database may contain dozens, hundreds, or even thousands of records. Finding a particular
piece of information could be like locating a needle in a haystack. Fortunately Panorama can easily locate
information for you.

Finding vs. Selecting

Panorama has two ways of locating information, finding and selecting. Finding is much like looking up a
name in a phone book—Panorama points out the location of the information you are looking for. For exam-
ple, you might ask Panorama to find a phone number or a price in a catalog. Panorama will locate the infor-
mation, and position the database to that spot. In this example we’ve asked Panorama to find Blue Cross.

find Blue Cross
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Selecting is like creating a whole new phone book containing only the information you are looking for. All the
selected data remains visible, while everything else temporarily vanishes. For example, you might ask Pan-
orama to select all customers that have purchased from you in the last six months, or all transactions over
$250,000.

Deciding whether to find or select is your choice. Usually find is used when you want to locate a specific item
like an address or price, while select is used when you want to locate a set of information. You can also com-
bine the two techniques—for example, first select a subset of the database, then find a specific item within
that subset.

Note: Some other database programs have a “Find” command that actually does the same thing as Pan-
orama’s Select command (for example FileMaker). These programs do not have a true find capability like
Panorama.

select Blue Cross
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Selecting with the Context Menu

If you want to select more data that is related to data you can see on the screen, the easy way to do it is to use
the context menu. To see this menu simply right click on any data cell (if you don’t have a two button mouse,
hold down the control key and click on the cell).

The selection options in the menu vary depending on the type of data you click on.

Select Same

The Select Same option selects cells that contain the same value as the cell that was clicked on. For text cells,
this will include cells that are the same except for capitalization (so pat, Pat and PAT would all be treated the
same). If you want only cells that match in all aspects including capitalization, choose Select Same (Exact).
The Select Sounds Like option uses a phonetic option, selecting all cells that sound similar, for example Guti-
eriez, Guteres, Gutierrez, etc.

Text Numeric Date
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For date fields there are additional options for different periods — same week, month, quarter or year. For exam-
ple to find all records in January, just right click on any date in January and choose Select Same Month.

For numeric fields you can use Select Within 10% to find all records that are near the clicked value. For
example if you clicked on a cell that contained 2,000 this would select all records between 1,800 and 2,200.

Select Larger/Smaller

These options apply to numeric cells. For example, right click on a cell that contain $100 and choose Select
Larger to select all records with values greater than 100.

Select Before/After

These options apply to date cells. For example, to find all records before a certain date simply right click on
the date and choose Select Before. If you clicked on a cell that contained January 1, 2007 then Panorama
would select all records from 2006 or earlier.

Select Next/Previous/First/Last

These commands allow you to “walk” through the data, one item at a time. Select Next is like Select Same,
except that instead of selecting data that is the same as the current cell, it selects the next data item. For exam-
ple, suppose you have a database field named Category that contains these seven categories.

If you right click on a cell that contains Printing and choose Select Next, Panorama will show you all of the
records that contain Rent. Choosing Select Next again will show you Shipping, then Utilities, then finally
Travel.

Select Previous goes in the opposite direction. If you right click on a cell that contains Printing and choose
Select Previous, Panorama will show you all of the records that contain Payroll. Choosing Select Next again
will show you Advertising.

Select First will show you the first value in the field. In this example you could right click on any cell in the
Category field and choose Select First to see all of the Advertising records. You could then “walk” thru each of
the different categories by choosing Select Next.

When working with date fields you can “walk” thru the data by day, week, month, quarter or year. For exam-
ple, you could start by right clicking on a cell in January and choosing Select Same Month to see all of the
records in January. Then choose Select Next Month to see all of the records in February, then again for March,
April, May, etc.

Advertising

Payroll

Printing

Rent

Shipping

Utilities

Travel
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Quick Subtotals

Once you’ve made a selection you can click on a numeric field and choose Column Stats from the context
menu to get some quick statistics about the selected records. For example, you could start by selecting all
records in April, then right click and choose Column Stats.

A small window appears displaying information about the debits in the currently selected records, including
the total, count, average and standard deviation.

Close the window when you are ready to do further processing.
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The Find/Select Dialog

Panorama locates information by scanning through the entire database looking for data that matches your
criteria. The Find/Select dialog (Records->Search) allows you to specify the criteria for locating informa-
tion— including the field (or fields) containing the data, the kind of match you want (contains, exact match,
greater than, etc.) and the match value (the data you are looking for).

Tip: You can also open the Find/Select dialog by clicking on the record count displayed in the lower left hand
corner of the window.

click in this box to open Find/Select dialog
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Here is what the Find/Select dialog looks like when you first open it.

By default the Find/Select dialog searches all fields in the database. Simply type in the word, phrase or name
you want to search for. If the Live Preview option is checked, a preview of the search results will appear
immediately as you type. Here’s an example of a search for engineer. In this example engineer has been
found in both the Organization and Title fields.
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Selecting a Subset

To actually select a subset of the database, press the Select button. Panorama will scan through the entire
database and select the records that match the criteria you have specified. The selected records remain visible,
while the records that do not match temporarily vanish. Panorama displays the number of selected records in
the lower left hand corner of the window.

To restore the invisible records, choose the Select All command from the Search Menu.

To make a different selection, simply use Find/Select again. The original selection will vanish and the new
selection will become visible. (You do not need to choose Select All before selecting another subset.)

Note: If your database is large and you have selected only a few records, you may find that Panorama seems
sluggish. Remember, Panorama may be skipping over hundreds of invisible records that are between the vis-
ible records on the screen. When you use Select All, Panorama’s normal blazing speed will return.

Note: After you have selected a subset of the data, you may find that you cannot move the data sheet scroll
bar to the very top or very bottom. This will happen if the first or last record is not one of the selected (visible)
records.

Find and Find Next

Another way to locate data is to “find” it (see “Finding vs. Selecting” on page 139). There are two ways to
find a record — either double click on it in the preview or press the Find button. Double clicking on a record
in the preview closes the dialog and causes Panorama to jump to the actual record in the database. When you
press the Find button, Panorama will go to the top of the database and start scanning. When Panorama finds
a data cell that matches what you are looking for, it stops scanning and displays the information it has found.

To resume scanning for additional matches, use the Find Next command (if there aren’t any more matches,
Panorama will beep). To scan backwards, use the Find Previous command. (You can also use Find Next and
Find Previous after double clicking on a record in the preview.)

select any field contains engineer

current selection (505 records contain engineer)
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Creating Specific Search Criteria

Panorama allows you to set up detailed criteria to narrow a search down to the exact information you are
looking for. You’ve already seen the most general search, for text contained in any field, now we’ll look at
how to narrow a search to more specific criteria.

Searching a Specific Field

To search in a specific field instead of all fields, choose the field you want to search from the pop-up menu.

Once you’ve selected a field you also have the option of selecting a comparison method for matching the data
with the field. The matching options available will change depending on the type of field you have selected
(text, number or date). Matching options are covered in more detail later in this chapter.



Page 148 Panorama Sheets
Once you’ve selected the field and matching option you can type in the data you are looking for. If the Live
Preview option is checked the preview will update as you press each key. In this example the search done
earlier in this chapter has been narrowed to show only records where the job title contains engineer, instead
of engineer being in any field.

Compound Searches

To search for multiple terms at once, press the + button at the far right end. This adds another row to the
search criteria.

add row

delete row
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In this example I’ve revised the search to show engineers in Colorado.

You can continue adding multiple search rows as necessary, for example here I’ve narrowed the search down
to engineers in Colorado born before 1965.

Once you’ve narrowed the search down to the subset you want you can press the Select or Find buttons to
apply the search to the actual database. (You can also save this search for later, see “Managing Queries” on
page 160).
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Compound Search with AND/OR

Normally when you specify multiple criteria they must all be true, in other words, each criteria is ANDed
together. In the previous example, a record matches if the Title contains engineer and the state is CO and the
birthdate is before 1965. Using the pop-up menu at the top left of the dialog you can change how multiple cri-
teria are combined.

By changing this pop-up menu I can search for anyone who is either an engineer or a supervisor.

Or, I can find anyone who is neither an engineer nor a supervisor.

click to choose
how rows are combined
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Search Options (Text)

When searching in a text field there are almost two dozen options for determining whether data is a match.

Contains — Any data cell that contains the match value will be identified as a match. For example, if you ask
Panorama to locate cities containing an, it will locate cities like Anaheim, Lansing, Los Angeles, and San Jose
since they all contain an. Notice that capitalization is ignored, so an, An, AN, and aN are all acceptable
matches.

Does Not Contain — Any data cell that does not contain the match value will be identified as a match. For
example, if you ask Panorama to locate phone numbers not containingcontaining (714) it will locate phone
numbers in other area codes. Capitalization is ignored, so an, An, AN, and aN are all equivalent as far as this
option is concerned.

Begins With — Any data cell that begins with the match value will be identified as a match. For example, if
you ask Panorama to locate states beginning with co, it will locate states like Colorado and Connecticut. Cap-
italization is ignored, so co, Co, CO, and cO are all acceptable matches.

Ends With — Any data cell that ends with the match value will be identified as a match. For example, if you
ask Panorama to locate baseball teams ending with sox it will locate both Red Sox and White Sox. Capitaliza-
tion is ignored, so sox, Sox, SOX, and sOx are all acceptable matches.

Is Equal to (=) — Any data cell that exactly matches the match value will be identified as a match. An exact
match means just that. The spelling, punctuation, and capitalization must be exactly the same—for example
red will not match RED or Red.

Is Not Equal to (≠) — Any data cell that does not exactly match the match value will be identified as a match.

Is Less Than (<) — Any data cell that is less than the value in the box on the right will be identified as a
match.

Is Greater Than (>) — Any data cell that is greater than the match value will be identified as a match.

Is Less Than or Equal to (≤) — Any data cell that is less than or equal to the match value will be identified as
a match.

Is Greater Than or Equal to (≥) — Any data cell that is greater than or equal to the match value will be iden-
tified as a match.
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Contains the Word — Any data cell that contains the specified word will be identified as a match. The word
must not be part of a larger word. For example, if you specify contains the word engineer it will not match
engineers or engineering.

Sounds Like — Any data cell that “sounds like” the match value will be identified as a match. Panorama
uses a special algorithm to determine which values sound like the match value. This algorithm is not perfect,
but it does work pretty well. For example, if you are looking for someone named Luboviski but you are not
sure if it is spelled with an i, ie, or y, the sounds like match will save the day.

The sounds like match can be used with more than one word at a time. For example, if you are searching
through a video rental database for the movie Escape from New York, the sounds like algorithm will find it
even if it is misspelled Escapade from New York. If any word in the match value sounds like any word in the
data cell, the data will be identified as a match.

Note: If two words do not start with the same letter, the sounds like algorithm will not think they sound alike.
For example, sounds like does not think that Chris and Kris sound alike.

Matches (Wildcard) — This option allows you to create a “pattern” for comparing data. The pattern allows
you to set up very flexible “wildcard” matches where some characters must match but others don’t have to.
The pattern must contain one or more “normal” characters (letters, numbers, punctuation, etc.) and also may
contain one or more of the wildcard characters ? (question mark) and * (asterisk). The ? wildcard character
will match any character in this position. The * wildcard character will match any number of characters in
this position.

A few examples should help to make the operation of the wildcard characters within the pattern clear. Sup-
pose you want to find all records where the first three digits of the zip code are 926, and you don’t care what
the last three digits are. The pattern will be 926??. This pattern will match any five digit zip code that begins
with 926. It will not match if there are less than or more than 5 characters in the zip code.

If the pattern is changed to 926*, Panorama will match with any zip code that begins with 926, no matter
what the length is. It could be three digits long or thirty — Panorama doesn’t care and will say that it matches
as long as it starts with 926.

By changing the pattern to 926??* we tell Panorama to match any zip code that starts with 926 and is at least
five characters long. The zip code could be 5, 6, 7, or 70 characters long, but will not match if it is only 3 or 4
characters long.

If you wanted to select only 9 digit zip codes we could use the pattern ?????-????. This will match any 10
character long string with a - (dash) in the sixth position.

Suppose that you wanted to find everyone in your database with the last name Johnson and the first initial J.
Assuming that the first and last names are stored in a single field, you could use the pattern j*johnson to
locate the person (or persons) you are looking for. The match option doesn’t care about upper or lower case,
so this pattern would match Jerry Johnson, jim johnson, or JOHN JOHNSON. (It will also match weird data
like j346ujohnson or j@#opcjohnson, so take care to watch for unexpected matches.) If you want upper and
lower case treated as different characters use the matches exact case option (see below).

Matches Exact Case — This option is the same as the matches (wildcard) option (see above), except that any
letters in the data must exactly match the pattern, including upper vs. lower case. For example, if the pattern
is J*Johnson, names like Jerry Johnson will match, but JERRY JOHNSON will not match.



Chapter 4:Searching Page 153
Length is Between  — When this option is selected there are two match values, the minimum and maximum
length (in characters). In this example this option is being used to search for organizations with unusually
long names (more than 35 characters).

Number of Words is Between  — When this option is selected there are two match values, the minimum and
maximum number of words. In this example this option is being used to search for job titles with only one
word in them (excluding compound titles like vice president or security analyst).

Number of Lines is Between  — When this option is selected there are two match values, the minimum and
maximum number of lines. For example, you could use this to find all records where a cell contained more
than one line by using 2 for the minimum number of lines and 9999 for the maximum.

Is All Upper Case — Any data cell that contains all upper case characters (for example AZ) will be identified
as a match.

Is All Lower Case — Any data cell that contains all lower case characters (for example west) will be identi-
fied as a match.

Is All Word Caps — Any data cell that contains words with the first character captialized (for example San
Diego) will be identified as a match.

Is Not All Upper Case — Any data cell that contains any lower case characters (for example az) will be iden-
tified as a match. This is useful for double checking that a column is all upper case (for example a column of
state abbreviations).

Is Not All Lower Case — Any data cell that contains any upper case characters (for example West) will be
identified as a match.

Is Not All Word Caps — Any data cell that contains words with the first character lower case, or any other
character upper case (for example hOusTon, CHICAGO or philadelphia) will be identified as a match. This is
useful for double checking the capitalization of fields containing proper names.
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Search Options (Numbers)

When searching in a numeric field there are over a dozen options for determining whether data is a match.

Is Equal to (=) — Any data cell that exactly matches the match value will be identified as a match.

Is Not Equal to (≠) — Any data cell that does not exactly match the match value will be identified as a match.

Is Between  — Any data cell that contains a value between the two specified match values will be identified
as a match.

Is Not Between  — Any data cell that contains a value outside the two specified match values will be identi-
fied as a match.

Is Less Than (<) — Any data cell that is less than the value in the box on the right will be identified as a
match.

Is Greater Than (>) — Any data cell that is greater than the match value will be identified as a match.

Is Less Than or Equal to (≤) — Any data cell that is less than or equal to the match value will be identified as
a match.

Is Greater Than or Equal to (≥) — Any data cell that is greater than or equal to the match value will be iden-
tified as a match.
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Is Near (10%) to  — Any data cell that is within plus or minus 10% of the specified will be identified as a
match.

Is Not Empty  — Any data cell that contains a value (even zero) will be identified as a match.

Is Empty  — Any data cell that does not contain a value will be identified as a match. In other words, this
option locates completely blank fields.

Is an Integer  — Any data cell that contains an integer value will be identified as a match. For example, 1, 2,
45 and 5,687 would match but 1.27, 9.87 and 764.12 would not.

Is a Multiple of  — Any data cell that is a multiple of the specified value will be identified as a match. For
example if you specify 2 then 2, 4, 6, 8, etc. would match, while any other numbers would not.

Search Options (Dates)

When searching in a date field there are over a dozen options for determining whether data is a match. When
specifying a date you can use Smart Dates (see “Entering Dates” on page 200), so you can use dates like
March 12, yesterday, or last tuesday.

Is Equal to (=) — Any data cell that exactly matches the match value will be identified as a match.

Is Not Equal to (≠) — Any data cell that does not exactly match the match value will be identified as a match.

Is Before — Any data cell that contains a date before the date you type into the box on the right will be iden-
tified as a match.

Is on or Before — Any data cell that contains a date before or on the date you type into the box on the right
will be identified as a match.

Is After — Any data cell that contains a date after the date you type into the box on the right will be identified
as a match.

Is on or After — Any data cell that contains a date after or on the date you type into the box on the right will
be identified as a match.
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Is Between  — Any data cell that contains a date between the two specified dates will be identified as a
match. In this example all checks between last friday and today are selected (the example was taken on
March 30, 2010).

Is Not Between  — Any data cell that contains a value outside the two specified dates will be identified as a
match.

Is Not Empty  — Any data cell that contains a any date will be identified as a match. Blank cells will not be
selected.

Is Empty  — Any data cell that does not contain a value will be identified as a match. In other words, this
option locates completely blank fields.

Is Today  — Any data cell with today’s date is identified as a match.

Is This Week  — Any data cell in the current week is identified as a match.

Is This Month  — Any data cell in the current month is identified as a match.

Is This Quarter  — Any data cell in the current quarter (3 months) is identified as a match.

Is This Year  — Any data cell in the current year is identified as a match.

Is WIthin 3 Days of  — Any data cell that contains a date within 3 days of the specified date will be identified
as a match.

Is WIthin 7 Days of  — Any data cell that contains a date within a week of the specified date will be identi-
fied as a match.

Is WIthin 1 Month of  — Any data cell that contains a date within a month of the specified date will be iden-
tified as a match.
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Query Errors

It's possible to create a query that doesn't make sense -- for example asking Panorama to match all records
with dates between a and b. When this happens Panorama will display a pink background behind the query
line that doesn't make sense, along with a red alert triangle.

Click the red alert triangle to see the exact problem (in this case Illegal Date).

Search Options (Entire Records)

Most searches are based on specific fields, but there are also about a dozen criteria that apply to entire
records. (Keep in mind that these criteria can be used in any combination with other search criteria.)

Is Already Selected — This option allows new selections to be partially based on the results of previous
selections. If this option is chosen, only records that were already matched in a previous selection will be
identified as a match. In the example below, a previous selection located all organizations with Photo in the
name. Now that selection is being revised to include only photo related organizations in Texas. (To learn
about another way to revise an existing selection see “Revising a Previous Selection” on page 163.)
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Is Not Already Selected — This option allows new selections to be partially based on the results of previous
selections. If this option is chosen, only records that were not matched in the previous selection will be identi-
fied as a match in this selection.

Is a Data Record — Any raw data record (not a summary record) will be identified as a match.

Is a Summary Record — Any summary record will be identified as a match. (This option duplicates the
Select Summaries command that was available in previous versions of Panorama.)

First NN records — This option allows you to select the first few records in the database. In this example the
first 25 records in the database will be selected.

Last NN records — This option allows you to select the last few records in the database.

Every other record (1, 3, 5…) — This option allows you to select half of the records in the database. Every
other record is selected, starting with the first record.

Every other record (2, 4, 6…) — This option allows you to select half of the records in the database. Every
other record is selected, starting with the second record.

Every 3rd record (1, 4, 7…) — This option allows you to select one third of the records in the database. Every
third record is selected, starting with the first record.

Every 3rd record (2, 5, 8…) — This option allows you to select one third of the records in the database. Every
third record is selected, starting with the second record.

Every 3rd record (3, 6, 9…) — This option allows you to select one third of the records in the database. Every
third record is selected, starting with the third record.
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Search Options (Formula)

The standard matching options can be combined in many ways to easily perform most searches, but Pan-
orama has an even more powerful option — searching with a boolean formula. This option is a bit “geeky”,
but allows you to locate virtually anything that can be described by Panorama’s powerful formulas. 

The formula is true option relies on the ability of a formula to make comparisons and true-false decisions.
See “True/False Formulas” on page 315 for a detailed explanation of true-false logic. Here is an example that
shows how a formula can be used to combine both and and or operators into a single query.

The formula is true option allows you to select data based on calculations or comparisons between two
fields. For example, the formula

Price/Cost > 2

allows you to quickly locate items with high profit margins, like this.
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Panorama has hundreds of different functions that can be used in a formula to perform very specific selec-
tions. In the example below the upperword( function has been used to locate cities where a character other
than the first character in a word has been capitalized (in most cases a space is missing). The formula has
instantly located the 12 records (out of ten thousand) in this database where the city name has been incor-
rectly capitalized. With any other database program the only way to find these mistakes would be to search
the entire database by hand.

Managing Queries

The tools in the upper left corner of the Find/Select dialog allow you to manage and easily re-use previous
queries.

Clear Query — This button clears the current query. It resets the dialog to a simple query of searching all
fields for a word or phrase. (If you press Clear Query by mistake you you can press Previous Query to go
back.)

Previous Query, Next Query — This pair of buttons allows you to go back to previously used queries. (Note:
Only queries that you actually "finalized" by pressing the Find or Select buttons are included in the list of
previously used queries.)
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Favorites — This button displays a pop-up menu of favorite queries, along with options for adding and
removing favorites. To select a favorite you’ve saved previously, just click on the star and choose the favorite
from the menu.

The query is restored just as it was saved. You can use it as is by pressing Select or Find, or you can modify it
first.

To save a new favorite, first set up the query specification, then click on the star and choose Add to favor-
ites…

Enter a name for the new favorite.
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Your new favorite now appears in the pop-up menu.

To delete or rename a favorite, first select the favorite from the pop-up menu. Then choose Remove or
Rename, as shown above.

Show Formula — This button opens a small window that shows the internal formula associated with the
current query. Normally you would never need to use this, but it can be handy if you want to copy the for-
mula for use in a procedure.

Live Preview

The Live Preview area of the dialog displays a preview of the search you are about to perform. For small to
medium sized databases the live preview area will update instantaneously as you change the search. If your
database contains tens of thousands of records, or if you are using an older computer, updating the preview
may take a second or two. While the preview is updating the number of records will display in gray in the
lower left hand corner of the dialog. When the preview is complete the number will turn green.

Note: The Live Preview area will only show up to about 1,000 records. If there are more than 1,000 matches
the number of records displayed will not be accurate (a + is added to the number to indicate that there are
additional matches not counted). To see the exact number of matches use the Select button.

turns green when live preview update is complete
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If your database is large or your computer is slow, you may want to temporarily turn off Live Preview updat-
ing while you set up the query. Simply uncheck the Live Preview checkbox in the upper right corner. To
resume the live preview simply re-check the checkbox.

If you want to leave the Live Preview option off by default, open Preferences from the Panorama menu, then
open the General Preferences panel, then uncheck Enable Live Preview in the Search Options area.

Revising a Previous Selection

As you have seen, the Find/Select dialog makes it easy to make selections based on multiple criteria at once.
Sometimes, however, you don’t know in advance exactly what you are working for. Panorama has two
options that let you build a selection incrementally — Select Within and Select Additional. The Select
Within option allows you to whittle your data down gradually until you’ve extracted just the nugget of
information you really need. The Select Additional button lets you assemble the pieces of information you
need piece by piece.

To use these options, first make a regular selection, then open the Find/Select dialog again. When there is
already a previous selection you’ll see an additional +/- button at the top of the dialog.

Set up the revised selection criteria and then click on the +/- button to choose either Select Within or Select
Additional from the pop-up menu.

To demonstrate this, I’ll start by selecting Office Supplies in this checkbook database.
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Now I want to revise this selection to show only office supply purchases greater than $500. To do that, I open
the Find/Select dialog and set up the selection for checks (Debit) greater than 500. Notice that the preview
shows all checks greater than 500, not just office supplies. When you revise selections this way, the preview
does not show you what the revised selection will look like.

To actually revise the selection, click on the +/- button and choose Select Within Current Subset from the
pop-up menu.

Now the revised selection appears -- there are only two checks for office supplies greater than $500.
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Of course, you could obtain the same effect by combining multiple criteria in the first place. But you don’t
always know in advance exactly what you are looking for. The Select Within option allows you to whittle
your data down gradually until you’ve extracted just the nugget of information you really need.

The Select Additional option is similar, but allows you to select a superset of the currently selected records.
For example, if you have already selected names in Ohio, you could use Select Additional to also select
names in Illinois. The result would be the subset containing all names in either Ohio or Illinois. The Select
Additional option lets you assemble the pieces of information you need piece by piece.

Select Reverse

The Select Reverse command (in the Records->Search menu) reverses selected and deselected records. For
instance, if you have selected all transactions greater than $600, the Select Reverse command will select all
transactions less than or equal to $600.

Undo Select

The Undo command can reverse the effects of the last 16 select operations, including Select, Select Within,
Select Additional, and Select Reverse. As long as you do not use any other commands or tools, you can use
the Undo command up to 16 times in a row.

The quickest way to select the entire database is the Select All command (Command-A).

Customizing the Find/Select Dialog

The Find/Select dialog has several options that can be customized. To access these options, open the Prefer-
ences dialog, then click on the General Preferences button. This opens a window with many types of prefer-
ences, but at the moment we’re only interested in the Search options.

The first option is Default Search. If the All Fields option is checked, the dialog will initially default to search-
ing all fields when it is first opened. If the Current Field option is checked, the dialog will default to searching
just the currently selected field (this is similar to previous versions of Panorama).

The Reset search criteria option controls whether the Find/Select dialog starts fresh each time it opens. If this
option is checked, the dialog will always start empty when it opens, ready for a new search (you can recall
the previous search by pressing the Previous Query icon, see “Managing Queries” on page 160). If this
option is not checked, the dialog will start out with the previous search. You can then modify the search, or
you can start over by pressing the Clear Query icon (see “Managing Queries” on page 160).

The Enable Live Preview option controls whether Live Preview is enabled when you first open the dialog.
This is normally on, but if you have a slower computer or use extremely large databases you may want to
turn Live Preview off to make the dialog more responsive. See “Live Preview” on page 162.

Permanently Removing Unselected Data

Unselected data is hidden, but it is still part of the database. You can restore the invisible data with the Select
All command. Sometimes, however, you may wish to free the memory occupied by the hidden records. The
Remove Selected and Remove Unselected command in the Records->Search Menu allow you to perma-
nently remove records from the database based on a selection.
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If you have saved a copy of the data on disk prior to using Remove Selected or Remove Unselected, you can
still recover the data with the Revert to Saved command (until you save again). Even after you have saved
the database, you can still recover the previous data with Panorama’s Time Lapse feature (see “Time Lapse” on
page 354).

Select Duplicates

The Records>Search>Select Duplicates command provides a fast and easy way to locate duplicate information
in a database. The Select Duplicates command does not remove the duplicates, it simply selects them so you can
examine them. You can then decide what to do about each duplicate on a case-by-case basis. Panorama Sheets can
select duplicates based on a single field (for example, all duplicate company names). (Panorama Pro can select
duplicates based on multiple fields (for example, all records with duplicate address, city, and state), or on a for-
mula that may combine fields or use partial fields (for example, all records containing duplicate area codes).)

To select duplicates in a field, click in any cell in that field and choose Records>Search>Select Duplicates.
For example, here is a conference registration database that may contain duplicate company information.

Here is the same database after Records>Search>Select Duplicates has been used. The duplicate records are
selected, while all other records are invisible. 

As you can see, there are two duplicate copmanies in this database, BayShore Typesetting and State of Texas,
Dept Of Education.
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It is very difficult to look at a database containing thousands of records and make much sense of it. There’s
simply too much information to cope with. To make the information more understandable, it needs to be
summarized. Panorama can rapidly summarize a database according to the criteria you specify.

The Summarize & Analyze Dialog

Panorama’s primary tool for creating a summary outline is the Summarize & Analyze dialog. This dialog
allows you to use pop-up menus to control how the database is divided into groups and how totals are calcu-
lated. The dialog also allows you to preview the analysis before you actually apply it to the database.
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The top section of the dialog, Summary & Analysis Options, is where the analysis is set up. When you first
open the dialog this section contains three rows that are preset for summary (group), total (calculate) and out-
line level:

Start by choosing the field you want to summarize by. For date columns you will also have a choice of peri-
ods (day, month, year, etc.)

Once you've selected the summarization field the dialog will show you how many different groups of data
are associated with that field, and also list all of the groups in the Group Preview area below.
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Next, use the pop-up menu in the second row to choose a column you want to perform calculations on. (In
addition to totals, you can also calculate counts, averages, minimums and maximums.) Once you've chosen a
column the dialog will show you the grand total for this column.

The final row allows you to control what level of the outline is initially displayed. It defaults to the primary
summary field, so you can usually just leave it as-is. However you have a choice of any field you have sum-
marized by or you can elect to include the raw data in the display.

To actually create the outline press the Apply button. Panorama will organize the database into an outline
with summary records for the groups you have specified.
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Multi-Level Summaries

The previous example create one summary level. Panorama can create up to seven nested summary levels,
for example Categories within Months, or Cities within States within Months within Years. To add an addi-
tional summary level, re-open the Summarize & Analyze dialog, then press the + button on the first row to
add a second summary level.

Now use the pop-up menu to select the field to be summarized. The summary preview will show the groups
that will appear at this summary level.

click + to add another summary level
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The outline level pop-up menu now gives you the choice of either summary level or raw data. All levels at
and above the selected level will be display.

Pressing the Apply button organizes the database into a multi-level outline.

summaries by month

sub summaries by category (within month)
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Scrolling down to the bottom of the database shows the grand total for the entire database.

Using the same technique you can add up to seven nested summary levels.

grand total
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Expanding and Collapsing the Summary Outline

A unique feature of Panorama is that summaries aren’t just static on a report, they can be dynamically
expanded or collapse to show more or less detail. You can “zoom out” to look for major trends, then “zoom
in” to examine specific details. We call this collapsing (zoom out) and expanding (zoom in). To expand a par-
ticular summary right click on the summary and choose Expand One Level of Detail from the pop-up menu
(you can right click on any cell in the line, or if you have a one button mouse, press the Control key while you
click).

Panorama makes the next level of detail visible.

right click and choose Expand One Level of Detail
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If the database has more than one summary level you can repeat the process all the way down to the raw
data.

In this example we are now down to the raw data for purchases in October 2009.



Chapter 5:Data Analysis Page 175
To collapse a summary, right click on it (anywhere in the line) and choose Collapse Underlying Detail. (If
you have a one button mouse, hold down the Control key while you click.)

Another way to collapse is to right-click on a detail record, then choose Collapse this to. This is especially
handy if the summary record you want to collapse isn’t currently visible in the window.

or right click and choose Collapse Underlying Detail
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The example above shows doing this with a data record, but this trick works on any record except for the
final grand total. The menu adjusts to show exactly what is about to be collapsed, as shown below.

At the start of this section we showed how to expand one level at a time. You can also click on a summary and
ask Panorama to expand it all the way to the raw data, all in one step. To do this, right click on the summary
and choose Expand ALL Underlying Detail (if you have a one button mouse hold down the Control key).

right click and choose Expand ALL Underlying Detail
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This makes all subsummaries and raw detail associated with this summary record visible. In the example
below, we now can see all of the data and sub-summaries for October 2010.

Expanding and Collapsing the Overall Summary Outline

In the previous section you learned how to collapse and expand individual summary records. Sometimes,
however, you’ll want to expand or collapse the entire database as a whole. The fastest way to do this is with
the Data Sheet Context menu. Simply right click anywhere in the data sheet and choose the outline level you
want to see.

right click anywhere in data sheet

then choose the level you want to see
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If you choose RAW DATA then everything will be visible — the original data, and all summary records.

If you choose GRAND TOTAL then only one record will be visible — the grand total summary record. The
choices in between will display varying levels of summary detail.

Getting Rid of Summary Records

When you’re finished with summary records, you can simply choose Records->Analyze->Remove All Sum-
maries to get rid of them. All of the summary records will disappear, and you can get back to working with
your original data. This command is also available in the right-click context menu.

Ranking Summaries

Panorama normally generates summaries in alphabetical order. By adding an extra rule to the Summarize &
Analyze dialog you can tell Panorama to rank the summaries by value. For example, if you are summarizing
by month they could be ranked to show the month with the highest sales (or spending, etc.) first, then the sec-
ond highest etc. Start by clicking on the + button in the outline level row of the dialog.
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Panorama assumes that you want to rank by the field that is being totalled in this analysis (in this case Debit),
but you can choose another field if you wish. Then press the Apply button to see the ranked summaries.

For multi-level nested summaries you can use the outline level pop-up menu to pick which level is ranked.
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Whatever level you specified will be ranked. In this example, the category summaries are ranked within each
month.
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Ranking the summaries doesn’t affect the ability to expand detail. For example, now that the summaries are
ranked we can easily see that the purchasing category in May was a bit higher than usual. To find out why,
right click on the record and choose Expand One Level of Detail (or just click and choose the Expand tool).
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Now we can see that there was a large purchase made to Stamford Manufacturing, raising the purchasing in
that month.

The ability to “zoom” in and out like this is a great tool for actually understanding your data.
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Additional Calculation Options 

The summaries shown so far have totalled a single field. However you can also perform counts, averages, etc.
and you can also perform calculations on multiple fields. To change the type of calculation, choose from the
pop-up menu.

To perform additional calculations, click the + button on the right.
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Then use the pop-up menus to choose the type of calculation (Total, Average, etc.) and the field to perform
the calculations on.

It’s possible to perform multiple calculations on the same field, for example both the total and the average, as
shown below.

Both calculations will be displayed in the preview (as shown above). However, when you press Apply only
the last calculation will appear in the database itself (in other words in the actual database only one calcula-
tion can be performed per field).

Hiding Non-Analyzed Fields

Sometimes a database will contain many fields but only a few are of interest for summaries or analysis. For
example this database has over a dozen fields but a typical analysis might include only two fields, Date and
Total.
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In this situation, simply check the Hide non-analyzed fields option.

When you press the Apply button, Panorama will automatically hide all of the fields that aren’t involved in
the summary or calculation. This makes it much easier to examine the summary information.

Sometimes you might want to leave one or more fields visible even if they aren’t part of the summary or cal-
culations. To do this, add extra rows to the analysis and specify Show for these fields, as shown below.
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The primary reason why you might want to show these additional fields is so that the raw data in the fields is
visible when you expand details of the summary, like this:

Of course you can customize which fields are visible at any time, see “Temporarily Hiding One or More
Fields” on page 130.
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Previewing Subtotals

The Summarize & Analyze dialog allows you to preview summary results right in the dialog. When you click
on a summary, the subtotal and preview areas update to reflect the item you clicked on. In the database
shown below, there were 120 orders placed in February 2010, for a total of $32,927.96.
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If you’ve grouped by multiple columns, you can click on multiple summary items to preview them. The illus-
tration below shows that there were 3 orders placed from Arizona in February 2010, and you can see exactly
who these orders were from. You can click around to preview any summary you like. If you click a selected
summary, it will become unselected (for example if you want to see the grand total again.)

Using this technique you’ll sometimes be able to get the answers you need right from the dialog, without
even pressing the Apply button.
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Managing Analyses

The tools in the upper left corner of the Summarize & Analyze dialog allow you to manage and easily re-use
previous analyses.

Clear Analysis — This button clears the current analysis, reseting the dialog. (If you press Clear Analysis by
mistake you you can press Previous Analysis to go back.)

Previous Analysis, Next Analysis — This pair of buttons allows you to go back to previously used analyses.
(Note: Only analyses that you actually "finalized" by pressing the Apply button are included in the list of pre-
viously used analyses.)

Favorites — This button displays a pop-up menu of favorite analyses, along with options for adding and
removing favorites. To select a favorite you’ve saved previously, just click on the star and choose the favorite
from the menu.

The analysis is restored just as it was saved. You can use it as is by pressing Apply, or you can modify it first.
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To save a new favorite, first set up the query specification, then click on the star and choose Add to favor-
ites…

Enter a name for the new favorite.

Your new favorite now appears in the pop-up menu.

To delete or rename a favorite, first select the favorite from the pop-up menu. Then choose Remove or
Rename, as shown above.



Chapter 6: Advanced Field Properties

Earlier in this book the concept of field properties was introduced, and basic field properties were discussed.
This chapter covers the subject of field properties in detail. Learning about the properties described in this
chapter is optional, but they can help you make your databases faster, easier to use, and more error free.

Modifying the Properties of an Existing Field

To modify a field’s properties, choose Field Properties from the Fields menu, or simply double click on the
name of the field at the top of the data sheet. There are nearly two dozen properties that you can customize.
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Field Name

Each field in a Panorama database is identified by a field name. Field names serve several purposes: they
remind you what the field is for (i.e. the Dates field probably contains dates, the Name field probably con-
tains names, etc.), they appear at the top of each column in the data sheet, and they are used to identify fields
in formulas (for example Amount=Qty*Price).

There are no absolute restrictions on the field names you choose. Field names may be as long as you want,
and they may contain any character that can be typed from the keyboard. Field names may be split over two
or more lines. You can even have two or more fields with the same name (but we recommend that you avoid
this, see the next paragraph).

However, if you are planning to use a field in a formula, you may want to avoid some of these unusual possi-
bilities. If you have two or more fields with the same name, only the first field will be accessible to a formula.
Field names containing blanks or punctuation (for instance P/E Ratio) are more difficult to use in a formula.
To use such a field in a formula, you must surround the field name with «  and » (for example «P/E Ratio».
See “Fields” on page 286). (If you left out the «», Panorama would think you were trying to divide P by E,
with Ratio left over.) You may want to avoid field names like Date, Seconds, And, Or, and Sum. These
names can be confusing when used in a formula because Panorama has functions with the same names.

Multi-Line Field Names

A field name can be split across one or more lines, like this:

In the data sheet, the title of this field will also be split over multiple lines. As you can see in the example
below, you can mix field names that have one, two, three or more lines.

In a formula, any carriage returns in the field name are represented by spaces. For example, the fields in the
database above would be represented in a formula by T, «First Name», «Last Name», «Company Name»,
etc. The « and » characters are necessary because of the space in the field name.
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Field Data Type

In Panorama Sheets, all data is not the same. Just as Eskimos distinguish between 16 types of snow, Pan-
orama distinguishes between four types of data—text, numeric, date, and choices. To get the most out of a
database, Panorama needs to know what type of data you intend to store in each field. This lets Panorama
store the data efficiently and check for data entry errors. It also tells Panorama how to compare different val-
ues (numbers, text, and dates are all compared differently) which is important for sorting and selecting data.
The data type also tells Panorama how to format some kinds of data (numbers and dates).

As mentioned above, Panorama databases can contain five different types of data. When you create the data-
base, you specify what type of data will be stored in each field.

The text data type is used for storing ordinary text—names, addresses, descriptions, etc. Panorama cannot
perform mathematical calculations (add, subtract, etc.) on data that is stored as text.

The numeric data type is used for storing numbers—prices, quantities, etc. Use the numeric data type for any
field you want to use in a calculation. The numeric data type has several variations that are discussed later in
this chapter.

It’s not always necessary to store numbers in numeric fields. For example, zip codes and phone numbers are
usually stored in text fields, not numeric fields. This allows the use of nine digit zip codes (for example 92867-
3482) and foreign postal codes and phone numbers. In general, use a numeric field if you want to perform
numeric calculations (addition, multiplication, etc.) and/or if you want to select or sort the information in
numeric order (1, 2, 3, … 10, 20, 30, … etc.)

The date data type is self explanatory—it is used for storing dates (for instance March 1, 2009). Panorama
understands the properties of dates—it knows that May 1st follows April 30th and that there are six days
between May 28th and June 3rd. Panorama can handle dates from 100 A.D. to well past the year 20,000 A.D.

The choices data type is used for storing data that has only a few possible values—for instance yes/no, gold/
silver/bronze, or coach/first class. The choices data type saves space by storing a special code instead of the
entire text. When Panorama was introduced in 1988 these memory savings were important, but now this
option is rarely used.

Data Types and Memory Usage

When we started writing Panorama in 1986, a typical personal computer had about 1 megabyte of memory.
Because Panorama loads the entire database into RAM, it was critical to store the data as efficiently as possi-
ble. To do this we created a variety of data types, allowing you to pick the data type that was most efficient
for each field (for example, there are 6 different numeric data types).

Nowadays a typical computer has several hundred megabytes or even gigabytes of RAM. For most applica-
tions it is no longer necessary to be hypervigilant about choosing the most efficient data type. For example,
for numbers, it’s usually fine to simply use the most flexible floating point option, even though this con-
sumes a little bit more memory. It’s also rarely necessary to use the choice data type—you can simply use the
text data type instead. Throughout the rest of this chapter you’ll find a lot of discussion about picking the
most efficient data type for each field. If you are working with small to moderate size databases (from 10 to
20,000 records) you probably don’t need to worry about picking the most efficient data types. You can simply
stick with three basic data types—text, floating point numbers, and dates. That being said, you can probably
skip over most of the material in the rest of this chapter!

 Data Type Uses Examples

Text Names, Addresses, Descriptions, etc. John, 234 Peach Avenue

Numeric Prices, Quantities, etc. 4, 78.23, 4.9e-2

Date Dates. 9/18/2002

Choices Multiple Choice Options Yes/No, Gold/Silver/Bronze
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Modifying a Field’s Data Type

The data type of a field can be specified using the Field Properties command in the Field menu. The Field
Properties dialog box contains a pop-up menu for selecting the data type. Tip: You can also open the Field
Properties dialog box by double clicking on the name of the field on the data sheet.

Data Type Conversion Problems

When you change the data type of an existing field it is possible that you may lose some of the data in that
field. For example, if you convert a field from text to numeric, any letters or punctuation will be lost in the
conversion. Panorama will warn you if this situation occurs.

The alert gives you three options:

OK — Pressing this button tells Panorama to complete the conversion. Any data that cannot be converted
will be removed. For example, if you are converting a field from text to numeric any non-numeric data will
be lost in the conversion.

Cancel — Pressing this button cancels the conversion

Select Problem Data Pressing this button tells Panorama to cancel the conversion and show you the data that
is causing the problem. This option lets you look at the data that is causing the problem and decide what to
do next. If necessary, you can make manual adjustments to the data, or you may decide that you don’t want
to change the data type after all.

For example, suppose you wanted to change the Zip code field in the database below to numeric.
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When you attempted to make the conversion, Panorama would display the conversion warning alert. Press
Select Problem Data to see what is causing the problem.

Aha! The problem is the Canadian postal codes, which have letters instead of numbers. At this point you
would probably want to rethink the idea of converting the Zip field to numeric.

If you did decide to go ahead with the conversion, Panorama would strip the letters from the Canadian
postal codes.

When you are done looking at the problem data, choose the Select All command (Search Menu) to make all
the data visible again.

Numeric Data

Numeric data can be stored in either fixed point or floating point format. If you choose fixed point you have
a choice of 0, 1, 2, 3, or 4 digits after the decimal point.

You may wonder why there are so many choices for storing numeric data. After all, a number is a number—
right? Not quite. By choosing different numeric storage formats you are making a trade-off between space,
speed, accuracy, and range.

Storing numbers using floating point gives you the most accuracy and numeric range. Floating point allows
you to store extremely large or small values with up to 16 digits of accuracy. If you are in doubt, go ahead and
pick floating point format.

Fixed point storage is more limited. The accuracy is only about 9 digits. The largest number that can be stored
is about 2 billion (2•109) while the smallest fixed point number is 0.0001 (10-4). Trying to store larger or
smaller values using fixed point storage will result in errors.

On the other hand the space required for fixed point storage is up to 8 times smaller than floating point for
the same number, and Panorama can perform fixed point arithmetic much faster than floating point. You
should use fixed point numeric storage whenever possible. Check the table above to see if the numbers you
will be using fit in one of the fixed point numeric ranges.

Number of 
Digits After 

Decimal Point
Example Largest Value Smallest Value Typical Uses

0 93842 2,100,000,000 1 Quantities, Part Numbers

1 73.1 210,000,000 0.1 Rarely Used

2 253.22 21,000,000 0.01 Money (Dollars, Pounds, etc.)

3 0.447 2,100,000 0.001 Rarely Used

4 929.1123 210,000 0.0001 Rarely Used

Float 1.46e-12 1.7•10308 2.3•10-308 Scientific Data
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You can set the number of digits via a pop-up menu in the Field Properties dialog box.

Money

Usually the best way to store monetary values is using either 2-digit fixed point or Panorama’s special Money
format. The money format is the same as 2-digit fixed point but automatically enters the decimal point for
you during data entry. This table below shows how Panorama interprets data you enter into a money field.

Both the 2-digit and money formats allow you to store monetary values up to 21 million dollars, pounds,
francs, etc. (If your business deals with values greater than 21 million you should use floating point numeric
storage.)

Numeric Output Patterns

Output patterns allow you to control the way a number is displayed. In the Fields>Field Properties dialog,
output patterns can be used to control how numbers are displayed in the data sheet. Output patterns can also
be used in a formula.

Below are some ways the same number may be displayed using different output patterns. Remember, the
way a number is displayed does not change its internal value. All the numbers listed below have the value
2654.

2654
2,654
$2,654.00
002654
2.654e+3
26-54
Two thousand six hundred fifty four

When you 
enter… it becomes

87204 872.04

3267 32.67

14 0.14

2 0.02

42. 42.00

15.4 15.40

156.78 156.78
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Numeric output patterns consist of a string of characters containing one or more # symbols. The # symbol
tells Panorama how and where to print the number.

The overall output pattern for a field can be set using the Output Pattern section of the Field Properties dia-
log box.

If you choose Other from the pop-up menu a secondary dialog appears:

Simply choose the options you want using the checkboxes and pop-up menus. Close the window when you
are done.

type pattern here, or…

choose from pop-up
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Fixed Decimal Point Patterns. The table below shows how the output pattern can be used to display num-
bers with a specified number of digits after the decimal point. These output patterns force a fixed point dis-
play even if you are displaying floating point numbers. They also allow you to override the natural display of
fixed point numbers. For example, a money field can be set up to display only dollars, while still keeping
track of cents for calculation purposes.

Notice that if the number of # symbols after the decimal point is less than the number of digits in the number,
Panorama will round the number rather than truncating it.

Numbers with Commas, Punctuation, and Measurement Units. If a comma is added to the pattern, the
number will be printed with a comma every third digit. Other characters can also be added to the beginning
or end and will be displayed unchanged. For example, you can add a currency symbol or measurement unit
to the pattern, as shown below:

Scientific Notation. If an E or e is added at the end of the output pattern, the number will be displayed using
scientific notation. Any number may be displayed in scientific notation, including fixed point numbers.

Number Pattern Display

1234.56 1234.56

1234.56 # 1235

1234.56 #.# 1234.6

1234.56 #.## 1234.56

1234.56 #.#### 1234.5600

Number Pattern Display

1234.56 #,.## 1,234.56

1234.56 $#,.## $1,234.56

1234.56 #,.## kg 1,234.56 kg

Number Pattern Display

1234.56 #e 1e+3

1234.56 #.#E 1.2e+3

1234.56 #.##e 1.23e+3

1234.56 #.###E 1.235e+3

1234.56 #.####E 1.2346e+3

1234.56 #.#####E 1.23456e+3

1234.56 #.######E 1.234560e+3

1234.56 #.#E kg 1.2e+3 kg
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Special Patterns for Negative Numbers. Negative numbers are usually displayed with a minus sign in the
front of the number. This can be changed to a trailing minus sign or to enclosing parentheses.

Leading Zeros. You can use an output pattern to force Panorama to display leading zeros. To do this, put sev-
eral # symbols in a row without a decimal point.

Tip: If you are storing US Zip codes in a numeric field, use ##### as the output pattern. This pattern makes
sure that all 5 zip code digits are displayed, even if the first digit is zero.

If your database also contains Canadian postal codes, the zip codes must be stored in a text field. In that case
no output pattern is necessary.

Plural Suffixes. If a pattern contains measurement units you may want to properly pluralize the units
depending on the value being displayed. Use the ~ symbol to do this.

Displaying Numbers as Words. If you wish, numbers can be displayed as words instead of digits. To do this,
use the § symbol instead of the # symbol. Only one § symbol should be used. To make the § symbol on a
Macintosh, press Option-6. On the PC, press Alt-0167. Only the integer part of the number will be dis-
played—any fractional part will be ignored.

If you are displaying money, you’ll probably want to display the fractional part (cents) as well as the integer
part. You can do this with the ¢ (cents) symbol. On the Macintosh, press Option-4 to create the ¢ symbol. On
the PC, press Alt-0162. Use one ¢ for each digit you want display (usually 2).

Number Pattern Display

-1234.56 #.## -1234.56

1234.56 #.## 1234.56

-1234.56 #.##- 1234.56-

1234.56 #.##- 1234.56

-1234.56 (#.##) (1234.56)

1234.56 (#.##) 1234.56

Number Pattern Display

123 ##### 00123

1234 ##### 01234

12345 ##### 12345

Number Pattern Display

1 # mile~ 1 mile

5 # mile~ 5 miles

Number Pattern Display

312 § Three hundred twelve

42.29 § dollar~ and ¢¢/100 Forty two dollars and 29/100
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Dates

Panorama has a special data type for storing dates. When you use the date type to store your dates, Pan-
orama can sort your dates in the correct order, check your dates for validity as they are entered, and calculate
the number of days between two dates. Dates are quite compact; almost any date in the 20th or 21st century
will take only two bytes of storage.

Entering Dates

Panorama is very flexible about how you type dates. We call this feature “smart dates.” You can enter dates
numerically (for instance 04/09/02 or 4/9/2) or you can spell out the date (for instance April 9th, 1997 or Apr 9
97). You can use any character as a separator between numeric dates, for example 4-9-01 or even 4.9.01.

To enter today’s date, simply type today. You can also enter yesterday or tomorrow. Panorama will automat-
ically convert these entries to the correct month, day and year.

If the date is in the current week, you can simply type in the name of the day, for example saturday or tue. To
specify a day in the previous or upcoming weeks add the words last or next, for example next tuesday or last
saturday.

When a date is edited, Panorama normally displays the date in the format mm/dd/yy. However, if you have
set up an output pattern that Panorama understands for data entry, it will use that pattern instead. Patterns
that can be used for data entry include Month dd, yyyy, Mon dd yy, and mm/dd/yyyy.

If you are using an international system and you enter the date as numbers you must use the format dd/mm/
yy. Panorama does not understand the format 7-Aug-1998. (However you may use any delimiter character
you want, for example 7/8/98 or 7-8-98 or even 7.8.98.)

Default Year and Century. When you enter a date, you can leave the year off and let Panorama figure it out
for you. Panorama will automatically round the date to the nearest year. For instance, if today’s date is 3/9/
02 and you enter the date 4/1 then Panorama will assume you mean 4/1/02. But if you enter 12/1 (or
December 1) Panorama will assume you mean 12/1/01, not 12/1/02, because 12/1/01 is closer to 3/9/02
than 12/1/02 is.

Panorama also rounds dates to the current century. If the current year is 2002 (or even 1992) and you enter the
date 7/2/23 Panorama will assume you mean 7/2/2023. If you want to enter a date more than 50 years from
the current date you must enter the full date, for example 7/2/1923

Date Output Patterns

Output patterns allow you to control the format Panorama uses to display dates. A date output pattern con-
sists of a number of individual components (month, day, year, etc.) that are strung together. For example, the
pattern mm/dd/yy contains three components and will display in the format 3/11/04.
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Automatic Capitalization

Panorama has four options for automatic capitalization: off, all, word, and sentence. You can set up automatic
capitalization with the Field Properties dialog.

The All option tells Panorama to capitalize every letter entered into the field. Use this option for fields con-
taining abbreviations—CA, NY, etc.

The Word option tells Panorama to capitalize the first letter of each word. Use this option for fields contain-
ing names, addresses, etc.

Sometimes you may need to override Panorama’s automatic word capitalization. If you need an extra capital
letter simply press the Shift key (for instance McDonald). If you want the first letter of a word to be lower
case type the letter twice (Bank Oof America), then delete the upper case letter (Bank of America).

The Sentence option tells Panorama to capitalize the first letter of each sentence. Use this option for fields
containing paragraphs of text—for instance catalog descriptions or correspondence.

Changing Capitalization of Existing Data

Automatic capitalization only applies to new data as it is typed into the database. It does not change data that
has already been entered. It also does not automatically capitalize imported data or data pasted into the data-
base. If you want to change the capitalization of existing data, you must use the Manipulate Data dialog.
This is best explained with an example. Suppose you wanted to convert the last names in the database below
to all upper case. Start by clicking anywhere in the Last column.
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Now choose Manipulate Data in Field from the Fields Menu.

Click the + button (on the right) to add another row to the dialog, then choose Modify Capitalization from
the pop-up menu.

Now choose the type of capitalization you want.

When you press the Apply button, the field will be converted to all upper case.

See “The Manipulate Data Dialog” on page 230 for further details about this dialog.

start by pressing +
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Checking for Duplicate Data

Panorama usually does not care if you enter duplicate information into a database. However, if you wish you
can ask Panorama to check for duplicate data every time you enter or edit a data cell in a given field.

Panorama has three options for checking duplicate data—Yes, No Duplicates and No Unique. You can set up
duplicate checking with the Field Properties dialog.

The Yes option simply tells Panorama to allow duplicates. This is the default.

Use the No Duplicates option to make sure that a value is not entered more than once. For instance, a check-
book database should never have duplicate check numbers.

The No Unique option tells Panorama to warn you if you attempt to enter a value that is not already in the
database. For instance if a field contains only Yes/No values, this option would warn you if you attempted to
enter True or False.

When Panorama encounters a duplicate or unique value (depending on the option), it warns you. However,
it does not prevent you from entering the value. You are given the option of entering the data even though it
conflicts with the existing data—it’s up to you.

Checking for Duplicates in Existing Data

Checking for duplicates only happens when new data is typed into the database. Panorama does not check
data that has already been entered, and it does not check data that is imported or pasted into the database.
There are, however, several techniques for checking for duplicates in existing data. See “Select Duplicates” on
page 166 to learn how to use the Select Duplicates command. Another method is to sort the data and then
use the UnPropagate command to identify the duplicates (by searching for blank cells). See “Using UnPropa-
gate to Eliminate Duplicates” on page 266 for details.



Page 204 Panorama Sheets
Clairvoyance®

Many databases contain fields where the same information is repeated over and over. For instance, a check-
book will contain the same bills month after month—rent, phone, utilities, charge cards. Another example is
an inventory database that contains many items from each vendor, with the vendor name repeated over and
over. Panorama’s Clairvoyance feature anticipates when you are about to enter data that has been entered
before, and completes the entry for you. This can save you a lot of typing, and helps improve consistency as
well.

How Clairvoyance® Works

How can Panorama anticipate what you are about to type? The secret lies in Panorama’s ability to scan the
database in a fraction of a second. When you are using Clairvoyance, Panorama scans the entire database
each time you enter a character. As it scans the database, it checks the characters you have typed against the
data already in the database. When there is only one possible match, Clairvoyance guesses that you are about
to repeat yourself and completes the word or phrase for you.

Of course, Clairvoyance can only be helpful when you are repeating a word or phrase that is already in the
database. If you are entering a new word or phrase, Clairvoyance cannot help you—but it won’t get in your
way, either. As you type in a new word or phrase Clairvoyance may guess that you are entering an old word
or phrase. Just keep typing, and Clairvoyance will automatically erase its guess when it no longer matches
what you have typed.
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Turning Clairvoyance® On or Off

Clairvoyance can be turned on or off with the Field Properties dialog box.

Clairvoyance® Helps Insure Data Consistency

One problem when building large databases is making sure that information always gets entered the same
way, especially when more than one person is keying in the data. For example, a single company could be
entered in your inventory database many ways—

Fuji
Fuji, Inc
Fuji USA
Fuji Photo, Inc
Fuji Photo Film USA
Fuji USA, Inc.

Clairvoyance helps solve this problem by accurately repeating the information time after time. You may find
that Clairvoyance’s ability to insure data consistency is more important than the keystroke savings.
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Clairrows

When you hold down the Command key (Mac) or Control key (Windows), the up and down arrows on the
keyboard become clairvoyant arrows, or “clairrows.” With the key held down you can use the arrows to scan
through the values that are already in the database. Each time you press Command/Control-Down Arrow
the next value appears, while each time you press Command/Control-Up Arrow the previous value appears.
You can scan through the values until you find the information you are looking for, then press the Enter key
to enter the value.

To give the clairrows a head start you can type in the first few letters of the information you are looking for.
For example, suppose that you are looking through a travel database for a particular Best Western Hotel.
Start by typing Best, then press Command/Control-Down Arrow. The first hotel with a name beginning with
Best will appear. Each time you press Command/Control-Down Arrow the name of next hotel (alphabeti-
cally) will appear—for example Best Western Aspenalt Lodge, Best Western Bar X Motel, Best Western Boul-
der Inn, etc. Press Command/Control-Up Arrow to move backwards through the hotel names. Continue
until the hotel you are looking for appears, then press Enter.
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Input Patterns

Sometimes you may wish to force the data being entered into a specific pattern. For instance in the United
States and Canada long distance phone numbers almost always use the pattern (999) 999-9999. Panorama’s
Input Pattern can take care of entering the pattern for you. Once the pattern is set up, you only type the
actual data (in this case the digits of the phone number). Panorama combines the data you enter with the pat-
tern to produce the actual data. For example, combining the input pattern (_ _ _)   _ _ _-_ _ _ _
with 3124562468 produces the data (312) 456-2468. 

An input pattern consists of a string of characters with an underscore in each spot where actual data will be
entered. The input pattern is just like fill in the blanks, but instead of filling in the blanks you fill in the under-
scores. (Press Shift-Dash to enter the underscore character. The dash key is in the top row of the keyboard,
just to the right of the 0 key.) The table below lists some common input patterns.

You can set up the input pattern with the Field Properties dialog.

Tip: Input patterns should not be used with numeric fields. If you want to add a pattern to a numeric value,
you should use an output pattern (see “Numeric Output Patterns” on page 196 and “Date Output Patterns”
on page 200).

Type of Data Input Pattern Example

Phone Number (_ _ _)  _ _ _-_ _ _ (312) 456-2469

Social Security Number _ _ _ - _ _ - _ _ _ _ 234-54-5476

License Plate _ _ _   _ _ _ AGB 287

Date _ _ / _ _ / _ _ 03/24/05

Time _ _ : _ _ : _ _  _ _ 11:24:36 PM

Choose from a pop-up menu of common input patterns, or…

type the input pattern into the box
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Entering Data with an Input Pattern

This illustration shows an example of entering a phone number with an input pattern.

The input pattern is only active when you are adding new characters at the end of the text. It does not adjust
the data when you are inserting text in the middle of the cell. For example, it does not prevent you from cre-
ating a four digit area code, like this:

Using Input Patterns with Dates

The purpose of input patterns is to save keystrokes in data entry by inserting constantly occurring dashes,
colons, parentheses, or other punctuation. When it comes to date fields, you must decide how you like to
enter dates. Using the input pattern _ _ /_ _ /_ _ removes the need to type /’s (or some other separator)
between the month, day and year. However, using the pattern requires that you type leading zeros in front of
single digit months and days. For instance, to enter January 1st you must type 0101. Without the pattern you
can enter a single digit, for example 1/1. (Keep in mind that Panorama allows any non-numeric character as
the separator, so you could also type 1.1 on a numeric keypad—very fast.) It’s up to you which method you
prefer.

One other point to keep in mind—the input pattern can interfere with Panorama’s Smart Date feature (see
“Entering Dates” on page 200). For example, with a pattern if you attempt to enter yesterday you will get ye/
st/erday, and if you enter tuesday you will get tu/es/day. You can go back and edit out the /’s, but if you are
going to use Smart Dates frequently you might want to forego the input pattern.

An input pattern can be used to override Panorama’s century rounding feature. If you want to enter all dates
in the 20th century you can use the pattern _ _ /_ _ /19_ _ . If you are using this pattern then Panorama will
treat 030423 as 3/4/1923, not 3/4/2023. (Remember, Panorama normally rounds the year to the nearest cen-
tury (within 50 years) if you do not specify all four digits of the year.)

type   3

1

2

4

5

6

2

4

6

8

click in middle of text

type 4
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Restricting Character Types

Panorama normally allows you to enter any character that can be typed from the keyboard. If necessary you
can restrict the kinds of characters that can be entered into each field. Panorama has five different character
restriction levels—Any, Alphabetic, Numeric, AlphaNumeric, and Custom.

You can choose basic character entry restrictions with the pop-up menu in Field Properties dialog.

If you choose the Other… option an advanced dialog opens. Simply check the all of the character sets you
want to allow, then close the window.
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Custom Character Restrictions

The Custom option allows you to exactly specify the characters you want to allow and disallow in this field.
The actual characters allowed are defined by one or more pairs of characters. Each pair specifies a range of
characters that are allowed. For example the pair 09 would allow all characters in the range 0…9, while the
pair az would allow all lower case letters. You can combine several pairs to create a more complex range, for
example az09 for all lower case letters or numbers. A pair may specify a single character as both the begin-
ning and end of the range, for instance %% (only the percent symbol allowed), or 09%% (numerals and the
percent symbol, but not the decimal point). If you wish to allow spaces, one of the pairs should be a pair of
spaces, for instance AZ  az09. To preview the effect of a character range you can use the ASCII Chart wizard.

The table below shows some common examples of custom character restrictions. For each range a sample of
Ok data and bad data is shown, with the disallowed characters shown in red.

If you are using the Field Properties dialog, you can set up a custom restriction by typing the custom range
directly into the dialog.

Custom Range Ok Data Bad Data Comments

09 936 923.77 Only digits, no decimal point, spaces or 
other punctuation allowed.

09.. 156.23 1,294.48 Basic fixed point numbers

09..%% 67.82% 67.82  % Percentages (no spaces)

09// 5/23/02 March 1st Numeric format dates

09:: 1:24:83 1:24 PM Time

09  ::AAaaMMmmPPpp 5:32 PM 5:32 DL Time (am/pm)

AZ SEATTLE Seattle Upper case letters only—no punctuation or 
lower case letters

Azaz John John Smith Letters but no spaces

AZaz@@.. sue@my.net sue$my.net Handy for email addresses

09  (())-- (213) 444-1234 342-3982 ext 12 Basic US phone numbers

!~ Check# El Niño Everything ok except spaces, international 
characters and special symbols

!Ù Niño El Niño Everything ok except spaces
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Default Values

When a new record is added to a database, it is usually completely empty. You can, however, set up a default
value for each field. One way to set up default values is with the Field Properties dialog. The dialog below is
for a State field which defaults to CA (California).

The simplest default is a fixed value, as shown in the example above. For example you might want the Coun-
try field to default to your home country, a shipping field to default to your preferred shipper. Once defaults
are set up, they are automatically entered whenever a new record is created.

new record with default values
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Default to Today’s Date

To default to today’s date, choose Today from the pop-up menu (or you can just type in today).

Note: The today default only works for fields that use the date data type. If you use the default value today
with a text field you will simply get the word today. See “Dates” on page 200 for more information on the
date data type.

“Ditto” Defaults Based on the Previous Record

Instead of being fixed, a default value can be based on the data in the previous record. You can produce this
type of “ditto” default by using the default value ". This is the quote character, which is produced by holding
down the Shift key and pressing the " key (just to the right of the semicolon key). (Some people mistakenly
call this the double-quote character.)

When you create a new record, the fields using the ditto default will contain the same values as the previous
record.

“ditto” defaults for City, State and Zip
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Automatically Incrementing Defaults (1, 2, 3, …) Based on the Previous Record

For a numeric field you can specify a default that is created by adding to the previous value in the field. To do
this, use a default of +nn, where nn is the amount to add to the previous value. For example +1 causes the
value to increment by one for each new record.

You can use any number, even a negative number like +-5. This default would cause Panorama to add nega-
tive 5 (same as subtracting 5) to the value each time a new record is created. If the numeric type allows it, you
can even use non-integer values like 2.5 or 0.1.

As new records are added to the database, they are numbered automatically, like this.

automatically incrementing check numbers

this field set up to default to today’s date
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Be sure to keep in mind that an incrementing default like +1 is based on the previous record, not on the larg-
est value in the entire database. So if you insert a record in the middle of the database, the incremented value
will be based on the value just above it, not on the value at the end of the database.

If you want to generate a unique incrementing number for use as a record ID (for instance an invoice number
or check number), use the technique described in the next section.

Creating a Unique Record Number

Many databases applications require that each record contain a unique number that can be used to identify
the record. Common examples include invoice numbers, batch ID's, employee numbers, etc. Panorama can
automatically assign a unique number to each new record as it is created, even if several people are using the
database simultaneously over a network.

The field containing the record number must be a numeric field. To specify that this field should contain a
unique record number, the default should be + . Do not specify any increment value, just use a single + char-
acter.

Each database contains a counter for keeping track of the next record number. Every time a new record is cre-
ated the counter is incremented by one. Even if the record is later deleted, the number will never be re-used
(unless you Quit Panorama or close the database without saving your changes, or unless you reset the
counter manually as described below).

If necessary you can manually change the record number using the Setup>Next Record Number command.

records inserted in the middle have incorrect numbers
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The Choice Palette

The choice palette provides a completely different way to use the Input Box. Instead of entering the data with
the keyboard, you pick the value from a list of buttons.

The choice palette can be used with any data type except pictures. All you have to do is create a list of choices
(see below).

Changing the Shape of the Choice Palette

Panorama automatically arranges the buttons in the choice palette for the best fit in the Input Box. By chang-
ing the size and shape of the Input Box you can arrange the buttons vertically, horizontally, or in a grid of
rows and columns.
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Creating the List of Choices

Set up the list of choices with the Field Properties dialog.

You can key in the list manually or you can press the Auto button to ask Panorama to automatically create
the list for you. If you press the Auto button, Panorama scans the database and creates a list of all the choices
already in the data. If you key in the list of choices manually, you must separate each choice with a space. If a
choice contains a space (US Mail) you must represent the space with an underscore character (US_Mail).
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Allowing Choice Exceptions

An option for any choice palette is an exception box. The exception box lets you type any value into the data
cell, even if the choice palette doesn’t contain a button for it. Use the exception box when you have a few
common choices, but cannot anticipate every value in advance. To create an exception box, simply type in a
line of underscores at the end of the choice list.

The exception box is always one line high. The width of the exception box is controlled by the number of
underscores.

To make the exception box wider, add more underscores.

The Choice Palette vs. the Choices Data Type

If you’ve already read about the choices data type, you may be wondering how the choice palette relates to
the choices data type.

The choice palette is a way to enter data. It provides a way to enter or edit data by picking from a list of
choices instead of typing from the keyboard. Using the choice palette does not affect how that data is stored,
however. The data can be stored as text, as a number, a date, or using the choices data type.

The choices data type is a way to store data. This data type is efficient (saves memory) for storing data that
has only a few possible values.

The choices data type can be used with a choice palette (and it usually is), but you can also use regular key-
board editing to enter choice values. A choice data type field will use regular keyboard editing (instead of the
choice palette) if you set the number of digits to 1.

Automatically Calculated Field Values

If the value of a field can be calculated with a formula, Panorama can calculate the value for you using the
Formula option in the Field Properties dialog. See also to learn how to set up calculations.
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Generic Fields

Panorama allows you to designate certain fields in your database as “Generic” fields.

Databases come in all sizes and shapes. Generic fields allow different databases to share information even if
they have different field names or slightly different configurations. For example, one database may store
company names in a field named Company, while another may have a similar field named Organization. By
setting up generic fields for each database, you build a bridge so that Panorama knows that these two fields,
though named differently, contain the same type of information. Once this bridge is built Panorama can
exchange data between these two databases (for example by drag and drop), and between Panorama and
other applications that can share information (for example Apple’s Address Book).

Unlike normal Panorama fields, generic fields don’t actually store any information themselves. Instead, a
generic field simply references one or more normal Panorama fields that contain the same information. When
Panorama needs to access the information in the generic field, it examines the generic field definition (see
below) to extract the data from the actual database fields.

Standard Generic Fields

While ordinary Panorama fields can store an unlimited variety of information, there are only about two
dozen generic fields to choose from (this list may grow in future releases). Not all databases will be able to
support all of these generic fields, but a database that contains contact information (mailing lists, phone
books, etc.) will be able to support many of them.

Category Generic Field Description Examples

Contact

Name A person’s first and last name. John Wilson, Mary Furnare

Nickname A person’s nickname. Sammy, Beth

Prefix A person’s honorific. Mr., Ms., Dr.

First A person’s first name. John, Mary

Middle A person’s middle name or initial. August, Walker

Last A person’s last name. Wilson, Furnare

Suffix A person’s suffix. Jr., D.D.S

Formal A person’s honorific and last name. Dr. Wilson, Ms. Furnare

FullName A person’s complete name. Dr. John August Wilson

Affiliation

Position A person’s title or position within an organi-
zation. President, Sales Manager

Organization The company, school, agency or other organi-
zation this person is affiliated with (if any). Acme Construction

Division The major division or group this person is 
affiliated with (if any). Communications Products

Department The department this person is affiliated with 
(if any). Human Resources

Address

Address Street address. 1892 North Glendale Blvd.

Suite Suite, apartment or room number (if any) Room 463

City City or town. Saskatoon

State State or province. SK

Zip Zip or postal code 4Y2 A8G

Country Country Canada
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If you are familiar with the vCard specification (RFC 2426) for exchanging data between programs you’ll rec-
ognize that many of these generic fields correspond to vCard fields.

Internet
Email Email address. This field may contain multi-

ple e-mail addresses, one per line. maryf@acme.com

Web URL for web site http://www.acme.com/cp/hr/

Telephone
(separate)

Voice Primary phone number. (303) 442-9011

Fax Fax phone number. (888) 763-1290

Cell Cell or mobile phone number. (909) 487-2063

Home Home phone number. (562) 491-3992

Work Word phone number (324) 987-3367 ext 2384

Pager Pager number. (817) 335-9832

Telephone
(line items/

array)

PhoneType

The PhoneType and Phone fields are compos-
ite fields designed for holding multiple phone 
numbers. Use these generic fields when the 
underlying database contains phone numbers 
in line items or an array instead of in separate 
fields. Each line in these fields corresponds to 
a single phone number. Each line in the Pho-
neType generic field contains the type of the 
corresponding phone number: Home, Office, 
Cell, Fax, etc. Each line in the Phone generic 
field contains the actual phone number.

Voice
Cell
Fax

Phone
(303) 442-9011
(909) 487-2063
(888) 763-1290

Other Notes Notes, memos, comments, etc.

Category Generic Field Description Examples
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Setting Up Generic Fields

When you create a new database with the New Database wizard, Panorama will normally set up generic
fields for you if you use standard field names like Name, Address, City, State and Zip. If your database con-
tains address or contact information and doesn’t have Generic fields, you can set them up with the Field
Properties dialog. To specify that a field is a generic field, open the Field Properties dialog and select from
the Generic Field pop-up menu.

That’s it!



Chapter 7: Data Manipulation

This chapter describes some of the most powerful commands in Panorama. These commands allow you to
automatically transform and modify large amounts of existing data. Many different kinds of transformations
are possible, including mathematical calculations, re-arranging characters or words, transforming individual
characters (for example converting from lower to upper case), and transformations based on patterns in the
data.

The commands described in this chapter are very powerful. In a few seconds you may be able to make
changes to your data that would otherwise require tedious hours of manual data entry. Like any power tool,
these commands should be treated with respect. For insurance, you should Save your database before you
begin trying to transform it. If you mangle your data, you can always get the original data back with the
Revert to Saved command, or with Panorama’s Time Lapse function (see also).

Duplicating a Field

To make a copy of a field, click anywhere in the field and chose the Duplicate Field command from the
Fields menu.

The duplicate will be named “Copy of ” original field, as shown above. To change the name just double click
on the name to open the Field Properties dialog.

original duplicate
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Splitting a Field

Sometimes you’ll need to take an existing field that already has data in it and split it apart. This can be accom-
plished with the Split Field dialog. For example, this database contains a combined Name field that we’d like
to split into separate First and Last fields.

To split the field, click on it then choose Split Field from the Fields menu. The preview area shows how the
data will be split. Since splitting at the first space is the default for this dialog, the split looks perfect.

Before actually performing the split you have the change to assign the names for the new fields. Just type in
the names you want to use.

Press the Split button to actually split the field into two fields.
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Controlling the Split Location

Panorama can split a field at any of three dozen different characters or symbols, or at a specific character posi-
tion. For example, an e-mail address can be split into user name and ISP by splitting at the @ symbol.



Page 224 Panorama Sheets
You don’t have to split at the first instance of a character - you can choose any of the first or last nine
instances. In this example the split occurs after the second / symbol.

If you choose to split at a character position instead of at a character or symbol, the pop-up menu expands to
allow you to select up to the first 99 positions. In this example a phone number is split into separate area
codes and local numbers by splitting after the sixth character (this is just one way to split a phone number,
another method will be described later).
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Stripping Extra Spaces and Punctuation

Sometimes after you split a field there will be extra spaces or punctuation that needs to be removed. For
example, suppose you want to split this name field into separate last and first names.

This can easily be done by splitting on the comma, like this.

But … there’s a problem — an extra space at the beginning of each first name. To remove this extra space
check the Strip surrounding Blanks checkbox.

Sometimes you’ll need to strip off punctuation in addition to or instead of blanks. In this example the dialog
is splitting a phone number into separate area codes and local numbers.
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To eliminate the ( and ) around the area code check the Strip Surrounding Punctuation option.

If necessary, you can always perform additional cleanup with the Manipulate Data dialog after the fields
have been split (see “The Manipulate Data Dialog” on page 230).

Partial Splits

Usually splitting involves turning one field into two, but sometimes you just want to keep one part of the
original field and discard the rest. To do that just uncheck the side of split that you don’t want. For example,
this dialog splits off the http portion of the URL.

We really don’t need a field that just contains http over and over. By unchecking the LEFT option, only the
right portion of the data is retained.

A useful option is to do a partial split combined with keeping the original field. For example, suppose I want
to start with this database and create a field that contains the email ISP name (aol.com, me.com, etc.)
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Here’s the setup for the Split Field dialog.

Here’s the final split.

Splitting Non-Text Fields

It's possible, though unusual, to split number or date fields. The number or date is converted to text before
being split, and the resulting fields are always text fields. Here's an example (please note that you may need
to set the output pattern for the date or number field before you split it to get the format you want).
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Merging Adjacent Fields

To merge two adjacent fields, click on the leftmost field you want to merge and choose Merge Fields from the
Fields menu. To illustrate this we’ll merge the Last and First name fields in this database.

When the Merge Fields dialog is first opened it defaults to merging the fields with a single space in between.

Use the pop-up menu to select the text to appear between the merged fields.

The preview shows what the merged field will look like. Edit the field name and you’re ready to merge.
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Here’s the finished result.

Merge Field Options

You can type any text you want to be inserted between the merged fields.

Normally the Merge Fields dialog intelligently omits the text in between the fields if one or both of the fields
are missing.

If necessary, however, you can tell Panorama to always include this text even if one or both fields are missing.

The final option is Keep Original Fields, which allows you to merge the fields while still keeping the original
split fields.
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Transforming Selected Data

The transformation commands described in the rest of chapter may be used on an entire database, or on a
selected subset. The Find/Select (or Formula Find/Select) command is used to select the data you want to
transform, then the commands described in this chapter are used to transform the data. Only the selected
data will be transformed—the invisible data will be left untouched. See “The Find/Select Dialog” on
page 144 for more information on selecting a subset of the database.

The same rules apply to data that has been collapsed with the outline tools. If data is invisible because it has
been collapsed, it will not be transformed. Only data that is both selected and expanded will be transformed.
See “Data Analysis” on page 167 for more information on outlines.

The Manipulate Data Dialog

This dialog, in the Fields menu, is the workhorse of data manipulation. (If you’ve used previous versions of
Panorama, the Manipulate Data dialog replaces Fill, Formula Fill, Empty Fill and Sequence commands you
are used to.) When you first open this dialog you’ll see that it is split into three sections:

There are three components to a manipulation — the data source, the manipulations, and the destination. The
destination is the current field when the dialog is opened (to remind you, this field is shown in the title bar of
the dialog). Any data already in the destination field will be overwritten when you press the Apply button.
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Specifying the Data Source

The first step in performing a manipulation is specifying a data source. There are four data source options:
Field, Text/Number/Date, Sequence and Formula. Use the pop-up menu to choose the source you want to use:

Start with Field

You’ll usually want to manipulate data that is in an existing field in the database. Simply choose the field you
want to manipulate from the pop-up menu. The simplest manipulation you can perform is to copy the data
from one existing field to another. To illustrate this I’ll copy the data in this database from the Color field to
the X field. I start by clicking on the destination field, X.

Now I open the Manipulate Data dialog (either from the Field menu, or by right clicking the field name, or
by pressing Command-=). Then I choose the field I want to copy (Color) from the pop-up menu.

Once I’ve chosen the data source field the preview area shows what the result will look like. The BEFORE
area shows the current contents of the X field (which is empty), the AFTER area shows what it will look like
after the manipulation (in this case a copy of the Color field). The preview area always lets you know what is
going to happen before you actually commit to modifying the original data.
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To actually copy the data I press the Apply button. Now I have two copies of this field.

Of course most manipulations are more complicated than this, but the basic steps remain the same: Click on
the destination field, open the dialog, choose the data source, choose the manipulations, then apply.

Start with a Fixed Value (Text/Number/Date)

Choose this option if you want to fill all of the selected cells in the current field with the same value. For
example, suppose you wanted to mark all of the checks in this database as Posted.

The first step is to select only the records that should be modified -- in this case, with a check number larger
than 0. I can easily do that by right clicking on the check number of a deposit (it should be blank) and choos-
ing Select Larger.
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As you can see below, the 462 checks in this database are now selected, while deposits and other transactions
are not selected. Now I click anywhere in the field I want to modify, in this case Posted.

The database is ready to be manipulated. Open the Manipulate Data dialog and set up the options to fill
every record with the same, fixed value.

Press the Apply button to modify the actual data.

1) choose from pop-up menu 2) type in text, number or date (depending on type of destination field)
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Choosing Select All shows all of the records again. As you can see, the unselected records were not modified.

The new data must be compatible with the field that is being filled. For example, you cannot fill a date field
with n/a because n/a is not a date value. Panorama will warn you if you attempt to fill a field with an incom-
patible value.

Click on the red triangle to find out more information about the problem (in this case, Illegal Date).

Starting with a Sequence

Choose this option if you want to fill the field with a incrementing or decrementing sequence, for example 1,
2, 3, 4, … 100, 110, 120, … 99, 98, 97, etc. When using this option you specify the starting value and the
amount to increase or decrease for each record.

The preview shows what the sequence will look like, so just play with the values until you get the sequence
you want.

1) start value 2) increment or decrement
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Sequencing a Date Field

If the destination is a date field the start value must be a valid date (Panorama’s “smart dates” are allowed, so
you can specify today, yesterday, tomorrow, monday, tue, next tue, etc. This example will generate a sequence
every day starting with May 1st.

The example below generates a record for each week, starting with next Monday. If I wanted an event every
two weeks, I would change the 7 to 14.

When manipulating a date field, an extra option appears in the Data Source pop-up menu — Start with
Sequence by Month. This option allows date sequences to be generated by months, quarters or years.

To generate the sequence by quarter, change the 1 to 3, for by year, change to 12.
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Starting with a Formula

If none of the other options fit the bill you can use a formula as the starting point for your manipulation. Once
you learn how to use them, formulas give you incredible power for any kind of manipulation you want to do.
Formulas are covered in detail elsewhere (see “Calculations & Formulas” on page 273), but let’s look at a sim-
ple example to see how a formula can be used in this dialog. In this example the database has three fields,
First, Last and Name. The formula below combines the first and last names into a combined Name field.

If you’ve used formulas in a programming language or spreadsheet before, this may look natural to you.
Otherwise, it probably just looks like a geeky mystery. Fortunately many common manipulations can be per-
formed simply by selecting from pop-up menus. Here’s an alternate method for combining the first and last
names:

The following sections will explain how to set up these kinds of simple non-formula manipulations.
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Manipulating the Data

Unless you’re doing something really simple like copying a field or filling with a fixed value, the second step
is to add one or more manipulations to your data source. To add a manipulation, press the + button on the far
right hand side of the dialog.

There are many standard manipulations you can choose from. Use the pop-up menu to pick the manipula-
tion you want to use.

add manipulation
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In most cases there will be one or two options you can specify to control the manipulation, either with a pop-
up menu or by typing in an option.

You can add up to seven manipulations, just keep pressing the + button.

When there are multiple manipulations they are performed in order from top to bottom. In some cases the
order of the manipulations may be important. You can insert a new manipulation in any spot by pressing the
appropriate + button, the new manipulation will be inserted just below the button you pressed. You can also
re-arrange the order of the manipulations by dragging on the arrows on the left hand side. Keep your eye on
the preview area to make sure that the manipulations are doing what you want them to.
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Manipulating Text

The types of manipulation you can perform varies depending on the type of data you are manipulating —
text, numbers or dates. There are about two dozen different manipulations available for text.

The following sections discuss each of these manipulation options.

Add Prefix/Suffix

This option allows you to add a prefix to the beginning of the text, or a suffix on the end, or both (as shown
below).
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Sandwich Prefix/Suffix

This option also adds a prefix and/or a suffix. However, unlike the Add Prefix/Suffix option, when the
“sandwich” option is used the prefix and/or suffix are only added if the source text is non-blank. In other
words, if there is no “meat” then this sandwich doesn’t include any “bread” either.

Add FIeld to End

This option appends a database field to the end of the manipulated text. It also allows you to specify “connec-
tor” text between the existing text and the field being added (in the example below the connector text is a
comma and a space).
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Panorama is smart about adding the connector text -- the connector is only added if necessary. In the example
below either the city or state is missing for some records. The connector is omitted in that case.

If necessary, you can append multiple fields, one after the next.
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Add Field to Start

This option is just like Add Field to End, but the field is added at the beginning of the manipulated text. In
the example below a space has been typed into the connector option.

Modify Capitalization

This option changes the capitalization of the text. Use the pop-up menu to select all upper case, all lower case,
or capitalization of the first letter of each word.

Strip Surrounding Blanks

This option strips off any extra blanks at the beginning or end of the text.

space
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Strip Surrounding Punctuation

This option strips off any punctuation at the beginning or end of the data. (Punctuation in the middle of the
data is left intact.) Punctuation is defined as any non-alphanumeric character, so this can be used to strip off
extra parentheses, braces, periods, question marks, spaces etc.

Eliminate Repeating Blanks

This option converts strings of two or more spaces in a row into single spaces.

punctuation in the middle is left intact
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Keep Alphabetic Characters

This option strips out all non-alphabetic characters. In other words, anything other than A to Z and a to z will
be stripped from the text.

Keep Numeric Characters

This option strips out all non-numeric characters. In other words, anything other than 0 to 9 will be stripped
from the text.

Keep Custom Characters

This option is more flexible than the previous two, but also a bit more complicated. It allows you to specify
exactly what characters to keep and what to strip out. The character to keep are specified as a series of charac-
ter pairs. The example below includes three pairs: AZ (A to Z), space-space (space) and az (a to z). The result
is that all characters except for letters and spaces are stripped.
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Here are some common pairs:

If you want to include a single character rather than a range, simply include that character twice to make a
pair. For example to allow semicolons use ;;, to allow exclamation points use !!. You can use as many pairs as
you need, but make sure there is no punctuation or spaces between the pairs (of course punctuation and
spaces can be used as part of a pair). Here are some typical custom character specifications you might want to
use.

Keep First

This option keeps the first few letters, words or lines of the data, removing the rest. For example, you could
use this to convert a name into an initial.

Pair Description

AZ Upper case characters

az Lower case characters

09 Numeric digits

Åü International characters

() Parentheses

!~ All non-blank characters

Spec Description

AZaz Alphabetic

AZ  az Letters & spaces

AZaz09 Alphanumeric

09()-- Phone numbers

09..++-- Positive or negative numbers

09// Dates (mm/dd/yy)

09::AAaaMMmmPPpp Times

$$09..-- Money (US)
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This might not seem that useful, but remember that you can combine multiple manipulations. Here I’ve
added a second step that gives us the first initial and last name.

I can edit the number of characters, in this example keeping the first 15 characters of the organization name.

The pop-up menu allows you to pick whether you want to keep text by character, by word or by line.
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Keep Last

This option is similar to Keep First, but keeps characters, words or lines at the end of the data. In this exam-
ple this option has been used to extract the last word from the organization name.

Remove First

This option removes characters, words or lines from the beginning of the text. In this example the first two
words (number and direction) have been removed from the address, leaving only the street name.

Remove Last

This option removes characters, words or lines from the end of the text. In this example the last word (Ave,
Place, Blvd, St. etc.) has been removed from the address.
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Keep Text Before

This option keeps the text before the specified matching text, discarding whatever is after. In this example
only text before the comma is kept. 

The matching text can be more than one character long, as shown here.
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Keep Text After

This option keeps the text after the specified matching text, discarding whatever is after. In this example
we’re keeping the ISP name, while discarding the user name.

The matching text can be more than one character long, as shown here.
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Replace

This option replaces a sequence of characters with another sequence of characters.

The original sequence of characters must match exactly, including upper and lower case. In the example
above it means that only Atty. will be replaced, not atty. or ATTY. For more flexibility in replacing text see
“Change (Find and Replace)” on page 270.

Insert Text at Spot

This option inserts one or more characters at a specified spot within the text. In this example we’re inserting a
dash before the 4th character of the phone number.

If the insertion spot is a negative number it is relative to the end of the text instead of the beginning.

text to insert (one or more characters) insertion spot
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Extract Between

This option is like a combination of Keep After and Keep Before. It returns text that is after the first matching
string and before the second matching string. In this example it is extracting the area code phone numbers.

The matching strings can be more than one character. This example extracts the name of the first image refer-
enced in the text (in this case the text contains HTML markup).

With one additional step I can extract just the name of the image, without the folder.
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Strip Tags

This option strips out all text that appears between beginning and end tags. If the tags are < and >, this option
will strip out all HTML markup from the specified text, leaving just the text itself.

The tags don’t have to be single characters. In this example only image tags are stripped out — all other
HTML tags will be left in the text.

Count

This option counts the number of characters, words or lines in the text. (If you use the lines option, Panorama
is actually counting the number of carriage returns in the text.)
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Add Sequence to End

This option adds a numeric sequence to the end of the text. You can specify the starting number and the
amount to increase or decrease for each record.

Formula

If none of the option so far will do the job then it’s time to pull out the big gun — a formula. You can use a for-
mula all on its own (see “Starting with a Formula” on page 236) but you can also use a formula in combina-
tion with other manipulations. When used this way, the «◊» symbol will expand into the text produced by
the previous manipulations. Then the result of the formula will be fed into any additional manipulations
below it. This example expands the abbreviations for North, South, East and West in an address.
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The «◊» symbol can be used more than once in the formula. This formula checks to see if the text contains a
comma, and if so, swaps it.

As you can see, formulas are very powerful, but there’s also a lot to learn. To find out more about the details,
see “Calculations & Formulas” on page 273.

Manipulating Numbers

There are about a half dozen different manipulations available for numbers.

The following sections discuss each of these manipulation options.
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Add Number

This option adds a fixed value to each cell.

If you want to subtract, use a negative number.

Multiply by Number

This option multiplies each number by a fixed amount.

Multiply by Percentage

This option multiplies each number by a percentage.
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Add Field

This option adds another numeric field to the data source.

Subtract Field

This option subtracts another numeric field from the data source.

Multiply by Field

This option multiplies the data source by a numeric field.

Divide by Field

This option divides the data source by a numeric field.

Formula

For more complex calculations you can use a formula. You can use a formula all on its own (see “Starting
with a Formula” on page 236) but you can also use a formula in combination with other manipulations.
When used this way, the «◊» symbol will expand into the number produced by the previous manipulations.
Then the result of the formula will be fed into any additional manipulations below it. The example below cal-
culates the square root of X*Y.

To learn more about numeric formulas see “Arithmetic Formulas” on page 289.



Chapter 7:Data Manipulation Page 257
Manipulating Dates

There are about a just a handful of manipulations available for dates.

The following sections discuss each of these manipulation options.

Add/Subtract Days

This option adds or subtracts a fixed number of days to the data source.

Add/Subtract Months

This option adds or subtracts a fixed number of months to the data source.

Add/Subtract Years

This option adds or subtracts a fixed number of years to the data source. For example, I can easily bring this
sample data forward ten years.
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Formula

For more complex calculations you can use a formula. You can use a formula all on its own (see “Starting
with a Formula” on page 236) but you can also use a formula in combination with other manipulations.
When used this way, the «◊» symbol will expand into the number produced by the previous manipulations.
Then the result of the formula will be fed into any additional manipulations below it. For example, this for-
mula turns all dates into Mondays.

To learn more about date calculations see “Date Arithmetic” on page 307.

Managing Manipulations

The tools in the upper left corner of the Manipulate Data dialog allow you to manage and easily re-use pre-
vious manipulations.

Clear Manipulation — This button clears the current manipulation, reseting the dialog. (If you press Clear
Manipulation by mistake you you can press Previous Manipulation to go back.)

Previous Manipulation, Next Manipulation — This pair of buttons allows you to go back to previously used
manipulations. (Note: Only manipulations that you actually "finalized" by pressing the Apply button are
included in the list of previously used manipulations.)
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Favorites — This button displays a pop-up menu of favorite manipulations, along with options for adding
and removing favorites. To select a favorite you’ve saved previously, just click on the star and choose the
favorite from the menu.

The manipulation is restored just as it was saved. You can use it as is by pressing Apply, or you can modify it
first.

To save a new favorite, first set up the query specification, then click on the star and choose Add to favor-
ites…

Enter a name for the new favorite.
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Your new favorite now appears in the pop-up menu.

To delete or rename a favorite, first select the favorite from the pop-up menu. Then choose Remove or
Rename, as shown above.

The Modify Empty Cells Only Option

The Manipulate Data dialog normally modifies all selected cells when you press the Apply button. However,
if the Modify Empty Cells Only box is checked, only empty cells will be modified. Any cells that already con-
tain a value will not be changed. In the example below all empty cells are changed to n/a, while cells that
contain memos are left untouched.

Live Preview

The bottom section of the Manipulate Data dialog shows a live preview of the manipulations you have spec-
ified. (For speed, only the first 100 records are shown.) The preview is divided into two sections. On the left is
the original data in the field you are manipulating. On the right is the manipulated version of data. The pre-
view updates instantly as you modify the manipulation options, making it easy to see the effects of the
options you choose.

Note: If your data contains carriage returns, they will be displayed using the ¶ symbol.
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Customizing the Manipulate Data Dialog

The Manipulate dialog has several options that can be customized. To access these options, open the Prefer-
ences dialog. This opens a window with many types of preferences, but at the moment we’re only interested
in the Data Manipulation options.

The first option is Default to formula. If this option is checked, the dialog will initially default to Start with
Formula (instead of Start with Field) when it is first opened. If you are a formula wizard you may find this
option more convenient. This essentially makes this dialog default to behaving like the Formula Fill com-
mand in earlier (5.5 and before) versions of Panorama.

The Reset manipulation criteria option controls whether the Manipulate Data dialog starts fresh each time it
opens. If this option is checked, the dialog will always start empty when it opens, ready for a new manipula-
tion (you can recall the previous search by pressing the Previous Manipulation icon, see “Managing Manip-
ulations” on page 258). If this option is not checked, the dialog will start out with the previous manipulation.
You can then modify the manipulation, or you can start over by pressing the Clear Manipulation icon (see
“Managing Manipulations” on page 258).
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Vertical Data Tabulation

The Manipulate Data dialog manipulates each record independently. The Vertical Data Tabulation dialog,
on the other hand, manipulates data vertically across multiple records.

The dialog contains six vertical data manipulations options. Choose the option you want, then press the
Apply button.



Chapter 7:Data Manipulation Page 263
Propagate

he Propagate option fills all the empty cells in the current field, leaving the previously filled cells untouched.
The Propagate option propagates filled data cells into the empty data cells (if any) below them.

To illustrate, here is a database where the date was only entered for the first check written each day. For
example, checks 123, 124 and 125 were all written on January 12th, but the date has only been filled in for
check 123.

The Propagate option will fill in the empty cells, as shown by the arrows in this illustration.
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Here is the actual result after the Propagate has completed.

The Propagate Up option performs the same operation upside down, propagating filled data cells into the
empty data cells above them.
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UnPropagate

This option performs the exact inverse of Propagate. If the same value appears in two or more consecutive
data cells, the Unpropagate option empties the second and subsequent data cells. Here is a database that has
been sorted by city.

The Unpropagate option eliminates all but the first entry for each city.

The Unpropagate Up option performs the same operation upside down, leaving the last of several duplicate
values while clearing the others.
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Using UnPropagate to Eliminate Duplicates

The UnPropagate command can be used to eliminate duplicate values in a database. The first step is to click
on the field that contains the potentially duplicate values, for example Name or Company. If you want to
eliminate duplicates over multiple fields (for example an entire address) you must create a new field and use
the Manipulate Data dialog to combine the data into a single field.

The next step is SortUp the database. This brings all the duplicate values together. For example, there are two
Bayshore Typesetting entries in this database.

The next step is to UnPropagate with the Vertical Data Tabulation dialog. Wherever a duplicate value
appears in the data cell, the UnPropagate option clears the cell.
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Now use the Find/Select dialog to select the non-empty data cells.

All of the duplicate records will disappear when you press the Select button. In this database there were two
duplicate companies, so there are now 120 selected (non-duplicate) records.

The final step is to permanently remove the duplicate records with the Remove Unselected command.

Tip: One possible problem with this technique is that all cells that start out empty will be removed. For exam-
ple if you are removing duplicate company names but some records don’t contain company names, the
records without company names will be removed.
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To fix this problem, use the Manipulate Data in Field command to fill the empty names with a unique value
like NO_NAME before you start. Be sure to pick a value that doesn’t occur in the database. Since you only
want blank names to be affected, check the Modify Empty Cells Only option.

Since we don’t want the empty cells to be flagged as duplicates, add a numeric sequence to the end of the
inserted text.
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Press the Apply button, then remove the duplicates using the technique described earlier — sort up, unprop-
agate (using Vertical Data Tabulation), then select non-blanks and remove unselected. At this point, the
duplicates are removed but the originally blank fields still contains NO_NAME. To fix this, use the Find/
Select dialog to select all fields that start with NO_NAME.

Press the Select button, then use Manipulate Data in Field to fill these cells with blanks again.

The duplicate company names have been removed from the database, but the records without any company
names have been preserved.
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Warning: Keep in mind that all of these techniques will blindly remove all but the first duplicate entry. In this
example, there were two entries for Bayshore Typesetting. However, they were probably not really dupli-
cates, since one was in Washington, DC and the other in San Rafael, CA. There is no way for an automatic
technique like this to know which of these is really correct, or even if they are really duplicates at all. If you
want to manually examine duplicate records instead of blindly deleting them, use the Select Duplicates com-
mand in the Search Menu. See “Select Duplicates” on page 166 for more information on this command.

Change (Find and Replace)

The Change command (in the Search menu) finds and replaces a word or phrase in the current field. For
example, you can use the Change command to replace every occurrence of Inc. to Incorporated, or every
occurrence of Purchase Order to P.O.

The Change dialog allows you to specify the original (From) and the new (To) word or phrase.

The Adjust Capitalization option allows you to specify whether you want capitalization to be adjusted as the
word or phrase is replaced. If you check this option, Panorama will automatically adjust the capitalization of
the new word or phrase as it is inserted into the database. If you leave this option off, capitalization is not
adjusted. In fact, if the Adjust Capitalization option is off, only words or phrases that exactly match the capi-
talization typed into the dialog will be replaced. The table below shows the result of replacing Inc. with Incor-
porated with Adjust Capitalization both off and on.

The Replace Entire Words Only option tells Panorama to replace only entire words, not sections of words. For
example, if you ask Panorama to change is to was, it will also change this to thwas. This is, of course, wrong.
To prevent this, just check the Replace Entire Words Only option.

Original Adjust Capitalization OFF Adjust Capitalization ON

 Inc. Incorporated Incorporated

INC. INC. INCORPORATED

inc. inc. incorporated
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Changing with the Replace( Function

The Change command is not the only way to replace words or phrases. You can also use the Manipulate
Data in Field command and the replace( or replacemultiple( functions (see “String Modification
Functions” on page 298). This technique is especially handy if you need to replace several words or phrases
at once. For example, consider the addresses in the database below.

Suppose you wanted to expand the abbreviations in these addresses: St. to Street, Dr. to Drive, etc. You could
do this by using the Change command over and over again. Or you can simply use the replacemultiple(
function to replace all of the abbreviations in one fell swoop.
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Press Apply to replace all of the abbreviations at once:

See “Starting with a Formula” on page 236 for more information on using formulas to modify data.
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The result we proceed to divide, as you see,
by Nine Hundred and Ninety Two:

Then subtract seventeen, and the answer must be
Exactly and perfectly true.

- Lewis Carrol, The Hunting of the Snark

Panorama Sheets can automatically perform calculations for you, ensuring speed and accuracy. You may
think of calculations as something that happens with numbers (like 2+2=4), but Panorama calculations can be
used with any type of data. In Panorama, any automatic transformation of any type of data is considered a
calculation. So Panorama calculations can perform operations like calculating a date 4 weeks in the future,
extract the first or last word from a sentence, combine two or more names together into one, or more tradi-
tional calculations like addition and multiplication.

Formulas In Action

Panorama Sheets can automatically perform calculations in three situations: 1) One or more calculations can
be automatically performed immediately when data is entered into the database, 2) A calculation can be per-
formed one time for all of the cells in a field, or 3) A calculation can be performed for each record in a data-
base to select/unselect data based on the results of the formula. Let’s look at each of these three options in
more detail.

Automatic Calculations as Data is Entered

If the value of a field can be calculated with a formula, Panorama can calculate the value for you. For exam-
ple, in this Product List database the Dealer Price is always equal to the Retail Price multiplied by the dis-
count, which in this example is 25%.

Dealer Price = Retail Price times Discount
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To set up this calculation, click anywhere in the Dealer field and choose Setup>Field Properties (or double
click on the Dealer field title. Then type in the calculation formula.

The light blue area below the formula shows a preview of the formula results. This value is the result of the
formula when applied to the current record in the database. When the formula is set up correctly, close the
Field Properties dialog by pressing the Ok button. From now on, Panorama will automatically calculate the
value of the Dealer field whenever the Retail or Discount fields are modified. So when a new retail price is
entered…

the Dealer price is automatically calculated when the Return or Enter key is pressed.

It’s possible to edit the Dealer price (or any calculated field) directly and override the calculation. Just double
click and edit it like any other data cell. However, if you later edit the Retail fields, the Dealer price will be
recalculated and your edited price will be forgotten.

If you later decide to change the discount percentage, simply re-open the Field Properties dialog for the
Dealer field and edit the formula. When you change the formula, you need to decide whether you want the
formula to apply to just new data that is entered, or if you also want the formula to apply to all of the previ-
ously entered data as well. If the later is what you want, check the Recalculate all records when closing dialog
option.

preview of formula result

new discount
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Press the Ok button to close the Field Properties dialog and recalculate all of the dealer prices.

One Time Calculations (Manipulate Data in Field)

Sometimes you’ll want to perform a calculation just one time, rather than over and over again each time data
is entered. For example, suppose that due to inflation you need to increase everything in your price list by
8%. Start by clicking in any cell in the field you want to recalculate (in this case, Retail).

Now choose Field>Manipulate Data in Field, then use the pop-up menu to switch from Start with Field to
Start with Formula.

Discount changed to 30%
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Now type in the formula. As you modify the formula the dialog shows a live preview of what the new calcu-
lated values will be. In this example you could change the percentage and instantly see what the new prices
will be.

Once the formula is complete and double checked, press the Apply button. Panorama will re-calculate all of
the retail prices.

It’s also possible to recalculate only a selected portion instead of the entire database. Start by selecting only
the data you want to modify, in this case items with retail prices greater than fifty dollars.

formula

original data preview of recalculated data
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Now we’ll increase the price of just these items by an additional 4%.

Press Apply to recalculate just these four prices.
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All of these prices increases have affected the retail price only, not the dealer price. If you want the dealer
prices to be updated you must manually tell Panorama to update them. The easiest way to do that is to dou-
ble click on the field title (in this case Dealer) to open the Field Preferences dialog, then check the Recalculate
all records when closing dialog option.

Then press the Ok button to recalculate the dealer prices, in this case with a 25% discount from the revised
retail prices.

Note: If you’ve used the Manipulate Data in Field dialog before, you may realize that the simple calculations
performed in this example can be performed without a formula.

The real benefit of the formula option kicks in for complex calculations. By using a formula, you can perform
even the most complicated calculations instantly.
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Using Calculations to Find or Select Data

Calculations aren’t just for modifying data, they can also be used to locate specific data. To do that you need
to construct a formula that can be true or false. Panorama will then scan the database, calculate the formula
for each record, and show the records for which the formula is true.

To illustrate this we’ll use the same price list database used for previous calculations. In this case the dealer
discount has automatically be set to 25%, but for some items the dealer price has been manually edited to a
higher or lower discount.

If the database is small you may be able to spot these edited prices by eye, but Panorama can use a formula to
quickly and accurately find every instance, even if there are only a few out of thousands of records. The first step is
to open the Records>Search>Find/Select dialog, then use the pop-up menu to switch to Formula is true mode.

Now type in the formula that specifies the information you want to locate, in this case records where the dealer
prices is more than 75% as much as the retail price. The dialog shows a preview of the records that match.

To actually find or select these records in the database itself, press the Find or Select button. With a bit of
ingenuity you can almost come up with a formula to locate or select even the most obscure information.

manually edited prices
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Formula Components

Just as a sentence is constructed from basic words, a formula is created by combining simple elements — val-
ues (also called operands), operators and functions. Values (operands) are roughly equivalent to nouns,
while operators and functions act as verbs. This illustration show the components that go into a typical for-
mula.

Formula Grammar

Panorama formulas have grammar rules just as languages like English and Spanish do. These rules tell how
values, operands and functions can be combined to make a valid formula.

The simplest formula is a single data value. Here are four examples of such simple formulas.

A

47

"Oregami"

ShippingMethod

Two values can be combined with an operator in between. The first example below adds two numbers
together. The second example multiplies two numbers together. The third example appends two text values
together (to produce a value like Mr. Jones).

2 + 2

Total * TaxRate

"Mr. " + LastName

The values must be the appropriate type for the operator. For example, you can multiply two numbers
together like this

2 * 2

but you cannot multiply two text values together like this (see “Grammar Errors” on page 284).

"Mr. " * LastName

You can combine three or more data values with an operator between each pair of values.

7 + 3 * 4 / 2

FirstName + " " + MiddleInitial + " " + LastName

function
value value

operator operator

value

operator

value
operator

value
value
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Calculation Order and Parentheses

When a formula contains more than one operator, the calculations are performed from left to right unless one
of the operators has a higher precedence (priority). This is the natural arithmetic order—multiply and divi-
sion first, then addition and subtraction. This table lists the order of precedence for all operators.

For example, consider the formula below.

7 + 3 * 4 / 2

Panorama first multiplies 3 * 4 to get 12, then divides this by 2 to get 6. Finally it adds 7 (addition is last
because of its low precedence) to get the final result, 13.

You can override the natural calculation order with parentheses. For example, the parentheses in the formula
below force the addition to be calculated first, then the multiplication and division.

(7 + 3) * 4 / 2

Now the final result is 20 instead of 13. When in doubt you can always add parentheses to force Panorama to
calculate the formula in any order you want.

Functions

A function is a formula component that calculates a value. It may calculate the value out of thin air (for exam-
ple, calculating the value of the current date or time) or it can calculate the value from other values (for exam-
ple trigonometry functions calculate values from angles). Panorama has several hundred functions available.
Each function has a name, and is always followed by parentheses. For example, the tan( function calculates
the tangent (a trigonometry function) of an angle.

tan(30)

A function can be used in a formula anywhere a regular value can be used. Just as with ordinary values, you
can use operators to combine functions with other values (and functions).

3 + tan(30)

The value operated on by the function is called a parameter.

1. Unary minus (example: -12)

2. Raise to power (example: 10^5)

3. Multiply and Divide

4. Integer Divide

5. MOD (remainder)

6. Add and Subtract

7. Comparisons (=, <>, <, >, …)

8. NOT

9. AND

10. OR and XOR

function parameter

tan(30)
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A function takes the parameter value (in this case 30) and transforms it into another value (in this case -
6.4053, the tangent of 30). The parameter can be a formula itself, like this.

tan( A + B )

In this case Panorama first calculates the value A+B, then computes the tangent of that sum. A parameter
may be as complex a formula as you need, with additional parentheses and even other functions nested
inside the first function.

tan( sqr( A + B ) + 1 )

The parameter to the sqr( function is A+B, while the parameter to the tan( function is sqr(A+B)+1. (The
sqr( function, by the way, calculates square roots.) Panorama will always calculate the formula from the
inside out until the entire formula has been computed.

Multi-Parameter Functions

Many functions use more than one parameter. When more than one parameter is required each parameter is
separated from the next by a comma. All of the parameters are surrounded by parentheses, just as with single
parameter functions. For example, the pattern( function (shown below) requires two parameters. The first
parameter must be a numeric value (in this case a calculated average) and the second parameter must be a
text value containing a pattern for formatting the number (see “Numeric Output Patterns” on page 196).

Some functions require as many as six parameters. You must always supply every parameter — you cannot
leave one out (see “Grammar Errors” on page 284).

Zero Parameter Functions

A small handful of functions don’t require any parameters at all. These functions generate a value all by
themselves, either by consulting the computer hardware (current date, current time), querying internal Pan-
orama data (line number, imported data) or by generating a completely random number each time the for-
mula is computed.

today() -- current date

now() -- current time

seq() -- line number

import() -- line of text from import file

rnd() -- random number

As you can see, these functions simply have both parentheses next to each other, with no parameter in
between. You cannot omit the parentheses — you are required to include them as shown in the examples
above.

function
first parameter second parameter

comma

pattern(Price/Earnings,”#.##”)
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Whitespace

Most of the examples you’ve seen so far have extra spaces between the components, like these.

7 + 3 * 4 / 2

FirstName + " " + MiddleInitial + " " + LastName

tan( sqr( A + B ) + 1 )

Panorama ignores spaces between components. You can leave out the spaces, like this.

7+3*4/2

FirstName+" "+MiddleInitial+" "+LastName

tan(sqr(A+B)+1)

Or you can add extra spaces between components, or even carriage returns, like this. (Note: Some dialogs do
not allow you to enter carriage returns, because pressing the Return key closes the dialog.)

7 + 3   *     4 / 2

FirstName + " " +
  MiddleInitial + " " +
  LastName

tan(   sqr( A + B ) + 1    )

Spaces are only ignored between components, not within components. A common mistake is to place a space
in between the function name and the left parenthesis. This is not allowed. The formula below will not work
(see “Grammar Errors” on page 284) because of the spaces after tan and sqr.

tan ( sqr ( A + B ) + 1 )

Another common problem is spaces or other punctuation in field names. If your database has fields named
First Name, Middle Initial and Last Name you might be tempted to try a formula like this.

First Name + " " + Middle Initial + " " + Last Name

Sorry, but it won’t work (see “Grammar Errors” on page 284). Because of the spaces inside the field names,
Panorama will think that First and Name, Middle and Initial and Last and Name are separate components.
The solution is to place chevron (« and ») characters around the field names. In many cases you can use the
Field menu to type in the field name with chevrons for you. Otherwise, on the Macintosh press Option-\ to
create the « chevron character and Shift-Option-\ to create the » chevron character. On Windows systems
press Alt-0171 to create the « chevron character and Alt-0187 to create the » chevron character. Here’s the
revised formula, which will work perfectly

«First Name» + " " + «Middle Initial» + " " + «Last Name»

You’ll also need to put chevrons around a field or variable name that contains punctuation, for example «P/E
Ratio». Without the chevrons Panorama will think that this is four separate components — P, /, E and Ratio.
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Grammar Errors

Unlike a human listener, Panorama is not able to tolerate incorrect or sloppy grammar. If you ask Panorama
to calculate a formula that has incorrect grammar it will refuse to comply until you correct the mistake. A red
triangle with an exclamation point appears on the left to indicate that the formula contains one or more gram-
mar errors. Click on the red triangle to see a description of the error.

The error message tells you that Panorama expected an operand (value) after the + operator. The solution is
either to remove the extra + operator or add another value in between the two + symbols. Once the error is
corrected you can press the Apply button (or Ok, Find or Select, depending on the dialog) to calculate the
formula.

Values

Values are the raw material that formulas work with—numbers and text. A value may be embedded in the
formula itself (a constant), or it may be stored in a database field.

Constants

When a value is embedded in the database itself it is called a constant. A numeric constant may be in fixed
point format, like the numbers in this example (the numeric constants are highlighted in purple).

x + 2

today() - 90

Total * 0.0625

A numeric constant may also be in floating point format, which consists of the mantissa followed by the letter
e followed by the exponent. The example below is equivalent to the mathematical formula x • 6.0223.

x * 6.02e23

click red triangle to see error message

can’t have two operators in a fow
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A formula may also contain text constants. A text constant is a series of characters surrounded by quotes.
When writing a text constant you may choose from five different types of quotes, as shown in this table.

The primary reason for different types is to allow quotes themselves to be used in a text constant. Suppose
that you needed to use the text The shim was 6" high in a formula. Using double quotes around the constant
will cause a grammar error, because Panorama won’t know what to do with the text after 6" (shown in red
below).

"The shim was 6" high"

One possible solution is to use a different quote character around the constant. Any of the examples shown
below will work.

'The shim was 6" high'

{The shim was 6" high}

“The shim was 6" high”

‘The shim was 6" high’

Another solution is put two double quotes in a row (as highlighted dark blue in the example below). Pan-
orama will convert these into a single quote and continue with the text constant.

"The shim was 6"" high"

Build in Constants: Pi, Carriage Return and Tab

Panorama has one built in numeric constant—pi. Use the Greek π symbol to access this value. For example
the area of a circle can be calculated with this formula.

π * radius^2

To create the π symbol on the Macintosh press Option-P. On the PC, type Alt-0254. You can also use the pi()
function.

Panorama has two built in text constants—¶ (Carriage Return) and¬ (Tab). For example three line address
can be included in a formula like this.

"Suzette Elliot"+¶+892 Melody Lane"+¶+"Fullerton, CA 92831"

To create the ¶ symbol on the Macintosh press Option-7. On the PC, type Alt-0182. You can also use the cr()
function.

To create the ¬ symbol on the Macintosh press Option-L. On the PC, type Alt-0172. You can also use the
tab() function.

Type Open Close Example

Double Quote " " "January"

Single Quote ' ' 'Tuesday'

Curly Braces { } {San Francisco}

Smart Double Quote “ ” “Gothic”

Smart Single Quote ‘ ’ ‘Bohemian’

Pipes
|, ||, 
||| 
etc.

|, ||, 
||| 
etc.

|||abc|||
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Fields

To use a field within a formula, type the name of the field into the formula. This formula adds up the sum of
three fields.

SubTotal+Shipping+Tax

When a field is used in a formula it always refers to the value of that field in the current record in the current
database (the database belonging to the topmost window). As you move from record to record the result of
the computation will change depending on the values in that particular record. (The only exception to this
rule is the lookup( and grabdata( functions, which may refer to fields in other records or even other data-
bases.)

If a field name contains spaces, numbers, or punctuation marks in it, you must surround the name with chev-
ron characters (« and »). (On the Macintosh press Option-\ to create the « chevron character and Shift-
Option-\ to create the » chevron character. On Windows systems press Alt-0171 to create the « chevron char-
acter and Alt-0187 to create the » chevron character.) If the field name contains carriage returns, they must be
represented with spaces. Here is a database with some unusual field names.

The first two names can be used without chevrons, but the last two require chevrons because of spaces and
punctuation in the names.

Price

Quantity

«Zip Code»

«P/E Ratio»

Formulas require field names to be spelled exactly as they appear in the database, with no typos allowed.
Fortunately, Panorama can help you out with this. Start by positioning the insertion point where you want
the field to appear, then click on the blue f icon. This displays a pop-up menu — the first submenu lists all of
the fields in every open database, starting with the current database.

fields in this database
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Choose the field you want to use and it will be inserted into the formula, including chevron characters if nec-
essary.

If the chevrons are not necessary (for example for Price or Quantity) Panorama will not include them.

Using the Current Field

A formula may use «» (see “Special Characters” on page 288) to refer to the current field without having to
know what the current field is. For example, this formula converts the current cell to upper case.

upper(«»)

If necessary, a formula can find out what the current field name is with the info("fieldname") function.

Help Typing Functions and Operators

If you’re not sure how a function or operator is spelled, Panorama can type it for you. To do this, click on the
blue f icon. This displays a pop-up menu — the second submenu of this menu, Formula, has submenus that
list all of the functions and operators available to be used in a formula. As you can see, there is a wide selec-
tion of available functions and operators.

You can choose any function or operator you want to insert it into your formula.
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The first option in the Formula menu, Assistant…, opens a dialog that allows you to search for the function
or operator you need.

Simply type in a few characters from the function or operator you are looking for, then double click on the
exact function you need to insert it into the formula.

Special Characters

Formulas are very picky about special characters. You’ve got to use the right special character in the right
spot—no substitutes are allowed.

For example, some people mistake the bracket [] characters for the parentheses (). On your keyboard, the
parentheses are created by pressing Shift and the 9 or 0 keys. Another common mistake is using the \ (back-
slash) instead of the / (slash) for divide. The table below lists all the special characters used by formulas and
shows how to type them.

Character Name Mac PC

( left parenthesis Shift-9 Shift-9

) right parenthesis Shift-0 Shift-0

[ left bracket [ [

] right bracket ] ]

{ left curly brace Shift-[ Shift-]

} right curly brace Shift-] Shift-]

« left chevron Option-\ Alt-0171

» right chevron Shift-Option-\ Alt-0187

^ caret (raise to power) Shift-6 Shift-6

* asterisk (multiply) Shift-8 Shift-8

÷ divide Option-/ not available, use /

= equal = =

≠ not equal Option-= not available, use <>

< less than < <

> greater than > >

≤ less than or equal Option-< not available, use <=
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To use the Alt key on the PC you must hold down the Alt key, then press the numeric digits (for example
0182) then release the Alt key. When you release the Alt key the special symbol will appear.

Arithmetic Formulas

Panorama formulas are very adept at performing arithmetic—from simple addition to complex financial cal-
culations. Arithmetic formulas usually work just like the ones you learned about in high school. Panorama
has seven arithmetic operators, as shown in this table.

The ^ operator (press Shift-6) raises the operand on the left to the power specified on the right. For example
the formula

2^3

means raise 2 to the third power (equivalent to the mathematical formula 23).

≥ greater than or equal Option-> not available, use >=

¶ paragraph Option-7 Alt-0182

¬ export tab Option-L Alt-0172

§ section mark Option-6 Alt-0167

¢ cents Option-4 Alt-0162

‘ left smart quote Option-] Alt-0145

’ right smart quote Shift-Option-] Alt-0146

“ left smart double quote Option-[ Alt-0147

” right smart double quote Shift-Option-] Alt-0148

Ω omega (line items) Option-Z Alt-0166

π pi Option-P Alt-0254

symbol operator

+ add

- subtract

* multiply

/ or ÷ divide

^ raise to power

\ integer divide

mod modulo 
(remainder)

Character Name Mac PC
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Dividing by Zero

Dividing by zero is, of course, a no-no. If you do attempt to divide by zero, Panorama will display an alert
reminding you of this arithmetical impossibility. Sometimes, however, you may want to defy mathematical
reality and divide by zero without getting slapped on the wrist. For example, since formulas treat empty data
cells as zeros, attempting to divide by a cell that hasn’t been entered yet will result in a divide by zero error.
To bypass the error message, use the divzero( function instead of the / operator. The divzero( function
returns zero if you attempt to divide by zero. For example, using the formula

Price/Qty

can result in a divide by zero error if Qty field is empty, but

divzero(Price,Qty)

will not.

Overflow/Underflow Problems

A number is a number, right? Well, not quite. You may remember that Panorama actually stores two different
kinds of numbers—fixed digit and floating point, with fixed digit numbers being further divided into 0, 1, 2,
3, and 4 digit precision. In a formula these differences may be important, since some numbers are too big or
too small to be represented in some of the fixed point formats.

Formulas try to perform arithmetic using the final numeric type required for the answer. For example, if the
result of a formula will be placed in a fixed 2 digit field, calculations will be performed in a fixed 2 digit for-
mat unless you force the formula to use another format. If the final destination is not a numeric field, arith-
metic will be performed using floating point. Floating point is also used when the answer is not going to be
stored in a field—for example formulas that are merged into auto-wrap text object or Text Display SuperOb-
ject.

Since the internal format used for arithmetic can vary depending on the final destination of the answer, the
same formula can give different results depending on where it is used. For example, the formula

1/4 

gives the result 0.25 if the result is a floating point field, but 0 if the result is a fixed 0 digit field.

A more subtle problem can occur if an intermediate calculation causes an overflow, underflow, or loss of pre-
cision. Often this can be fixed by re-arranging the formula. For example, this formula for computing sales tax
can have problems if the result will be stored in a 2-digit fixed field.

total*taxrate/100

If the tax rate is 6.5%, the intermediate result of the division is 0.065. But since 2-digit fixed point arithmetic is
being used, this intermediate result will be rounded to 0.07, resulting in an incorrect calculation. You can fix
this formula by doing the multiplication first.

(total*taxrate)/100

You can also fix this formula by forcing all the numbers to floating point using the float( function.

float(total)*float(taxrate)/float(100)

If all the operands are in the same numeric format, the formula will calculate the result using that format, in
this case floating point.

If you don’t want to worry about overflow/underflow problems one solution is simply to make all numeric
fields floating point. Floating point fields take up slightly more RAM than fixed point fields, but for most
databases the difference isn’t critical.
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Basic Numeric Functions

These functions perform various mathematical operations. Each of these functions takes one or more numeric
parameters and returns a numeric result.

Function Description

abs(number)
This function returns the absolute (positive) value of the numeric param-
eter. In other words, negative numbers are converted to positive numbers
while positive numbers remain positive.

divzero(numerator,denominator)
This function divides two numbers. However, unlike the / operator, the
divzero( function does not care if you attempt to divide by zero. If you
attempt to divide by zero, this function simply returns zero.

fix(number)

This function truncates a number to an integer. It always truncates
towards zero. For example fix(-4.6) is -4, while int(-4.6) is -5. For positive
numbers the int( and fix( functions are identical.

Don’t confuse this function with the fixed( function, which converts num-
bers from floating to fixed point format.

fixed(number)

This function forces a number to fixed point format, using the least num-
ber of digits possible. Since formulas usually perform this conversion
automatically, you probably won’t ever need this function. Don’t confuse
this function with the fix( function, which truncates a number to an inte-
ger but does not change the type of the data.

float(number)
This function forces a number to a floating point format. You may need to
use floating point to get around overflow, underflow, and accuracy prob-
lems that can occur when using fixed point arithmetic.

int(number)
This function truncates a number to an integer. It always truncates
towards negative infinity. For example int(-4.6) is -5, while fix(-4.6) is -4.
For positive numbers the int( and fix( functions are identical.

max(number,number)
This function compares two numbers and returns the larger value. If you
need to compare more than two numbers, you can nest this function
within itself, for example max(a,max(b,c)).

min(number,number)
This function compares two numbers and returns the smaller value. If
you need to compare more than two numbers, you can nest this function
within itself, for example min(a,min(b,c)).

randominteger(startnum,endnum) Returns a random integer value greater than or equal to the startnumber
and less than or equal to the end number.

round(number,step)

This function rounds a number to the nearest step. You can use any value
you want for the step: 1, 10, 0.5, whatever. 

For example, you could use the formula round(Quantity,12) to round the
quantity to the nearest dozen. The quantity 16 will be rounded to 12; the
quantity 20 will be rounded to 24.

zeroblank(number)

This function tells Panorama to store zero as an empty space. If the final
formula result is not zero, this function has no effect. The zeroblank(
function is handy when you want to leave the result of a calculation
blank if one of the operands are blank. For example, if you use the for-
mula zeroblank(Qty*Price), the result will be empty if either the quantity
or price is empty.
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Scientific Functions

These functions perform various log, trig, and exponential calculations. Each of these functions takes one or
more numeric parameters and returns a numeric result.

The trig functions listed in this table use radians to measure angles (1 radian = 180/π degrees). If you need to
convert degrees into radians you can use the degreestoradians( function. For example to calculate the
tangent of 30 degrees, use this formula:

 tan(degreestoradians(30))

To convert radians into degrees, use the radianstodegrees( function.

Function Description

arccos(number) This function calculates the inverse cosine of a number. The number must
be between -1 and +1.

arccosh(number) This function calculates the inverse hyperbolic cosine of a number. The
number must be between 1 and ∞.

arcsin(number) This function calculates the inverse sine of a number. The number must
be between -1 and +1.

arcsinh(number) This function calculates the inverse hyperbolic sine of a number.

arctan(number) This function calculates the inverse tangent of a number. The result is in
radians,

arctanh(number) This function calculates the inverse hyperbolic tangent of a number. The
number must be between -1 and +1.

cos(number) This function calculates the cosine of an angle. The angle is specified in
radians, not degrees (see above).

cosh(number) This function calculates the hyperbolic cosine of a number. The result will
be a value between 1 and ∞.

exp(number)
This function raises e to a number. For example, the formula exp(10.2) is
equivalent to e10.2. Incidentally, e is a constant that is used in many math-
ematical formulas. Its approximate value is 2.71828.

fact(number)
This function calculates the factorial of a number. For example, the for-
mula fact(4) is equivalent to 4! or 4*3*2*1. You can calculate the factorial
of any integer from 0 to 170.

log(number) This function calculates the natural logarithm (base e) of a number.

log10(number) This function calculates the common logarithm (base 10) of a number.

sin(angle) This function calculates the sine of an angle. The angle is specified in
radians, not degrees (see above).

sinh(angle) This function calculates the hyperbolic sine of a number.

sqr(angle) This function returns the square root of the number.

tan(angle) This function calculates the tangent of an angle. The angle is specified in
radians, not degrees (see above).

tanh(number) This function calculates the hyperbolic tangent of a number. The result
will be a value between -1 and +1.
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Financial Functions

These functions calculate financial data, including loan payments, future value, and present value. They are
designed to be compatible with the same functions in Microsoft Excel®. The financial functions are based on
the following formula.

pv(1+rate)periods+payment(1+rate × begin)×((1+rate)periods-1)/rate+fv=0

Function Description

pmt(rate,periods,amount,fv,begin)

This function calculates the periodic payment required to pay off a loan.
The rate is the interest rate of the loan per period. Periods is the term of
the loan expressed in payment periods, for example 36 months for a three
year loan that is paid monthly. Amount is the amount being borrowed.
The fv (future value) and begin values are optional, and should usually
be set to zero.

For example, suppose you are taking out a 36 month loan of $20,000 to
buy a car. If the annual interest rate is 13.5% (1.125% compounded
monthly), what would the monthly payment be?

pmt( 0.135/12 , 36 , 20000 , 0 , 0 )

The monthly payment is $678.71.

fv(rate,periods,payment,pv,begin)

This function calculates the future value of an investment. Rate is the
interest rate per period. Periods is the term of the investment, for exam-
ple ten years or 48 months. The pv is the present value of the investment,
for example the starting balance in a savings account. Begin should be
either 1 or 0; 1 if the payments occur at the beginning of the period, 0 if
the payments occur at the end of the period.

For example, to calculate the final balance in a savings plan when you
invest $500 per year for 10 years at 9% annual interest use the formula—

fv( 0.09 , 10 , -500 , 0 , 1 )

At the end of ten years you would have $8280.15. What if this savings
plan already has $2000 in it at the time you start this 10 year savings pro-
gram? The new formula would be—

fv( 0.09 , 10 , -500 , -2000 , 1 )

At the end of 10 years you would have $13,014.87.

pv(rate,periods,payment,fv,begin)

This function calculates the present value of an investment. Rate is the
discount rate, periods is the periodic investment, and payment is the
periodic payment. The fv is an optional lump sum at the end of the final
period; use zero if there is no lump sum. Begin specifies whether pay-
ments are received at the beginning or end of each period—1 for begin-
ning or 0 for end.

Present value is a variation of the old theme that a bird in the hand is
worth two…well, you know. It’s better to get $1000 now instead of $1000
next year, but how much better? The present value computation puts a
numeric value on time and money.

For example, suppose you find an investment opportunity that promises
to pay you $1,000 per year for the next 3 years. Assuming the current
interest rate is 10% per year, how much are these payments worth right
now?

pv( 0.1 , 3 , 1000 , 0 , 0 )

The computation shows that $3000 paid over 3 years is worth $2486 right
now (assuming 10% interest).
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Text Formulas

Formulas can work on text as well as numbers. Formulas can combine two or more pieces of text, extract a
portion of a piece of text (for example the area code or last name), or even re-arrange the text. Formulas can
also convert numbers into text and back again.

Programmers call a piece of text a string, referring to the fact that the text is made up of a string of characters.
Since this is such a handy term we’ll use it ourselves. So whenever you see the word string think “piece of
text.”

Where do strings come from? Most strings come from the database itself. Any text or choice field can be used
as a string. You can also put a string right into the formula itself (see “Constants” on page 284).

Gluing Strings Together

The simplest operation that can be performed on two strings is sticking them together, also called concatena-
tion. To glue strings together use the + operator. This operator attaches the string on the right to the end of
the string on the left. For example the formula

"abc"+"def"

produces the result abcdef. To attach the word Mr. to the beginning of a last name field use the formula

"Mr. "+«Last Name»

(Of course, you better be sure everyone in the database is a man!).

You can use more than one + operator to stick several strings together at once. For example to combine sepa-
rate first and last names into a single string using the format Last, First use this formula:

 «Last Name»+", "+«First Name»

Another way to glue strings together is with the sandwich( function. This function combines up to three
items of text: a prefix, a suffix, and the root text. The prefix and suffix are slapped on the ends of the root, just
like a sandwich. However, if the root is empty (sort of like a sandwich with no meat!) the prefix and suffix are
also left off, just as you wouldn’t bother to make a sandwich without any meat.

Let’s revisit our previous example with the sandwich( function. The previous formula will work fine as
long as there is a first name. But if the first name is empty, the formula will produce an extra comma, for
example Jones, . The sandwich function can solve this problem:

«Last Name»+sandwich(", ",«First Name»,"")

If the First Name field contains a name, the sandwich( function will slap the prefix in front of the name (in
this case the prefix is a comma and a space). But if the First Name field is empty, the sandwich( function will
also leave off the prefix. All the formula will produce is the Last Name, with no extra comma and space.
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Functions for Taking Strings Apart

These functions return portions of a string. See also “Taking Strings Apart (Text Funnels)” on page 296,
“String Modification Functions” on page 298, “Text Arrays” on page 302 and “Date Arithmetic” on page 307.

Function Description

after(text,tag) This function extracts all of text after a specified tag (sequence of charac-
ters. If the tag doesn’t exist within the text the function returns "".

before(text,tag) This function extracts all of text before a specified tag (sequence of char-
acters. If the tag doesn’t exist within the text the function returns "".

firstline(string) This function extracts the first line from the text.

firstword(string) This function extracts the first word from the text (the text up to the first
space).

lastline(string) This function extracts the last line from the text.

lastword(string) This function extracts the last word from the text (the text from the last
space to the end).

left(string,len) Extracts characters from the left edge of the text. For example left(text,2)
extracts the leftmost two characters.

mid(string,len) Extracts characters from the middle of the text. For example mid(text,6,4)
extracts four characters starting with the sixth character.

nthline(string,num) This function extracts the nth line from the text. For example nth-
line(text,4) extracts fourth line.

nthword(string,num) This function extracts the nth word from the text. For example nth-
word(text,7) extracts seventh word.

removeprefix(text,prefix) This function checks to see if a text item starts with a prefix. If it does, the
prefix is removed.

removesuffix(text,suffix) This function checks to see if a text item starts with a suffix. If it does, the
suffix is removed .

right(string,len) Extracts characters from the right edge of the text. For example
right(text,7) extracts the rightmost seven characters from the text.

snip(string,startposition,count)

This function removes (snips!) one or more characters from the middle of
an item of text. The startposition specifies the first character removed, the
count is the number of characters to remove. (Note: This function
requires the startposition to be a positive number.) If count is -1 then all
the text from the start position to the end of the text is snipped, otherwise
the count must be a positive number.

textafter(string,tag)

This function extracts the text after the tag. The tag many be one or more
characters long. If the tag doesn't occur in the text then the entire original
string is returned. For example textafter("someone@isp.net","@") will
return isp.net.

textbefore(string,tag)

This function extracts the text before the tag. The tag many be one or
more characters long. For example textbefore("someone@isp.net","@")
will return someone. If the tag doesn't occur in the text then the entire
original string is returned.

trim(string,len) This function removes characters from the right edge of the text. For
example trim(text,4) removes the last four characters from the text.

trimleft(string,len) This function removes characters from the left edge of the text. For exam-
ple trimleft(text,2) removes the first two characters from the text.
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Taking Strings Apart (Text Funnels)

Sometimes you may have an item of text where you only need a portion of the text and want to strip off the
beginning and or the end of the text. In addition to the functions in the previous section Panorama has a spe-
cial tool for stripping off the ends of a text item. This tool is called a text funnel. Text funnels are powerful
tools, however, many users find them a bit difficult to figure out. In recent years we’ve added many functions
that can perform most of the operations that a text tool can perform. Before deciding to use a text funnel you
may want to check out “Functions for Taking Strings Apart” on page 295, “String Modification Functions” on
page 298, “Text Arrays” on page 302 and “Date Arithmetic” on page 307. 

A text funnel is used a bit differently than other Panorama functions and operators. The text funnel always
follows the text item that is being “stripped.” In a sense a text funnel has three parameters, the text item, start,
and end. But as you can see below, these parameters are arranged quite differently than they are for other
functions:

<text item>[<start>,<end>]

The first parameter, text item, is the item of text which will be stripped to get the final result. This may be a
field, a variable, or an entire formula (as long as it produces a text item as its final result). If you use an entire
formula you should put parentheses around the formula.

The second parameter, start, specifies the first character you want to include in the final output. For example
if you want to strip off the first three characters the start should be 4 (because the 4th character is the first one
we want to keep). If the starting position is past the end of the text all the text will be stripped out and the for-
mula is left with an empty text item.

The third parameter, end, specifies the last character you want to include. For example, if you want to strip
off everything after the 12th character, the end should be 12. If the starting position is after the ending posi-
tion, all the text will be stripped and the formula is left with an empty text item.

The real trick in setting up text funnels is deciding what the start and end parameters should be. The follow-
ing sections will describe several techniques for setting up these parameters.

Numeric Start and End Positions

The simplest way to specify starting and ending positions is with a number. Positive numbers are counted
from the beginning of the original text item (1 is the first character in the original text item). Negative num-
bers are counted from the last character of the original text item (-1 is the last character).

Our first example removes the first character from the Notes field.

Notes[2,-1]

The next example does the exact opposite—it removes the last character from the Notes field.

Notes[1,-2]

By using the same number for the start and end a text funnel can strip out a single character. The procedure
below uses the text funnel [1,1] to check to see if the first character of the phone number is a (. If so, it uses
another text funnel to strip out the area code.

if Phone[1,1]="("
AreaCode=Phone[2,4]

endif
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A procedure can use a variable to pre-load the start and end positions. The procedure below will strip out
everything starting with the phrase Private Notes Below ---.

local X
X=search(Notes,"Private Notes Below ---")
if X≠0

PublicNotes=Notes[1,X-1]
else

PublicNotes=Notes
endif

Specifying Numeric Length Instead of Position

An alternate form of text funnel allows you to specify the length of the text to be stripped out, instead of the
ending position. This alternate form simply uses a semicolon instead of a comma:

<text item>[<start>;<length>]

The length specifies the number of characters from the starting position. A positive length means that the
stripped text begins at the starting position and extends to the right. A negative length means that the
stripped text begins at the starting position and extends to the left. The character at the starting position is
always included (unless the length is zero).

Let’s look at two examples of this technique. The first extracts the area code from a long distance phone num-
ber.

Phone[2;3]

The next example strips out the local phone number (the last 8 characters).

Phone[-1;-8]

If the original text item is too short to fulfill the request the text funnel will take whatever it can get. For
example, if the phone number is only 3 characters long, the value in LocalNumber will be 3 characters long.

String Testing Functions

These functions return information about the content of a string.

Function Description

length(string) This function counts the number of characters in a string. The result is an
integer. If the string is empty, the result will be zero.

linecount(string) This function counts the number of lines in the text.

rangecontains(thetext,therange)

This function checks to see if the text contains any characters in the speci-
fied range. The range must be a series of character pairs, for example AZ
for upper case alphabetic characters, AZaz for upper and lower case, 09
for numeric digits, etc. If the text contains any characters in the specified
range the function returns true, otherwise it returns false. For example,
rangecontains(Company,"09") will return true if the company name con-
tains any numeric digits, false if it doesn't..

rangematch(string,range)

This function checks text to see if the text matches the specified range.
The range must be a series of character pairs, for example AZ for upper
case alphabetic characters, AZaz for upper and lower case, 09 for numeric
digits, etc. If it matches the function returns true, if it doesn't match, it
returns false. For example, rangematch(Address,"AZaz09  ") will return
true if the address contains only letters, numbers and spaces, false if it
contains any other characters.
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String Modification Functions

These functions modify the contents of a string. Usually the string is actually a database field. Remember, to
use a database field as a string parameter simply use the name of the field, for example upper(Name).You’ll
often want to use these functions to modify the existing data in a field. For example, you might want to con-
vert all company names to upper case. To convert existing data use the Manipulate Data in Field command
in the Fields menu (see “The Manipulate Data Dialog” on page 230). This command calculates the formula
over and over again—once for each selected record.. Note: In addition to the functions listed here you will
also find methods for modifying strings in “Functions for Taking Strings Apart” on page 295, “Taking Strings
Apart (Text Funnels)” on page 296, “Text Arrays” on page 302 and “Date Arithmetic” on page 307.

search(string,phrase)

This function searches through a string looking for a word or phrase. If
the search is successful, the function returns the position of the phrase
within the string, otherwise the function returns zero. For example, the
formula search(Name,"Dr.") will return a non-zero value (usually 1) if the
name contains Dr., or zero if it does not.

sizeof(name)

This function calculates the amount of memory used by a field cell or a
variable. Name is the name of the field or variable that you want to calcu-
late the size of. The function returns the number of bytes of memory used
by the variable or field cell.

The sizeof( function can be used to decide if a numeric or date field is
empty or not. The example procedure shown below selects all the records
with no price (not the same as records with a price of zero).

select sizeof(Price)=0

 Another use for the sizeof( function is to check if a variable is taking up
too much scratch memory. This example checks to see if the variable
importLetter is more than 500 bytes long. If it is, the procedure clears the
variable.

if sizeof(importLetter)>500
importLetter=""

endif 

wordcount(string) This function counts the number of words in the text.

Function Description

connect(prefix,connector,suffix)

This function appends a prefix and suffix together with a connector in
between. If either the prefix or the suffix is missing then the connector
will also be left out. For example, connect(City,", ",State) combines the city
and state with a comma and space in between, but if either the city or
state is missing then the comma and space will also be left out. See also
the sandwich( and yoke( functions in this table.

defaulttext(text,default)
This function returns the text value supplied in the first parameter. How-
ever, if this text value is empty ("") the function will return the specified
default value.

fixedwidth(string,width)
This function makes the text a fixed width. If the text is shorter than the
specified width, it is padded with spaces. If it is longer than the specified
width, it is cut off.

fixedwidthright(string,width)
This function makes the text a fixed width. If the text is shorter than the
specified width, it is padded with spaces on the left (i.e. the text is right
justified). If it is longer than the specified width, it is cut off on the left.

linestrip(text) This function removes any blank lines from the text.

lower(string)
This function converts all of the letters in the string to lower case. For
example, the formula lower(Terms) will convert NET 30 to net 30, or
C.O.D. to c.o.d. See also the upper and upperword functions.

Function Description
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obscuredigits(number,count)

This function obscures digits (usually a credit card number) with X's. The
first parameter is the text that contains the digits. The second parameter
is the number of digits on the end that will NOT be obscured. For exam-
ple the formula obscuredigits("1234-5678-9876-5432",4) will produce the
value XXXX-XXXX-XXXX-5432. Notice that the function retains any addi-
tional formatting in the text, in this case dashes.

onespace(string) This function removes any extra spaces between words, so that there is
exactly one and only one space between each word.

onewhitespace(string)

This function removes any extra whitespace between words, making sure
that there is one and only one space between each word. Other
whitespace characters (carriage returns, tabs) are converted to spaces and
removed if there is more than one between words.

padzero(text,width)
This function makes the text a fixed width. If the text is shorter than the
specified width, it is padded with 0's on the left (i.e. the text is right justi-
fied). If it is longer than the specified width, it is cut off on the left..

rep(string,count)

This function replicates a string over and over. The number of replica-
tions is specified by the count (a number). This function is handy for cre-
ating a long repeating string. For example to create a string containing
twenty asterisks in a row, use the formula rep("*",20). The count does not
have to be a constant, but it must be an integer.

replace(string,search,replace)

This function searches for a word or phrase within a string and if found,
replaces it with a new word or phrase. The first parameter is the string
that may contain the word or phrase. Usually this parameter is a database
field. The second parameter is the word or phrase to search for. The third
parameter is the new word or phrase.

For example, to replace Corporation with Corp. in the Client field, use the
formula replace(Client,"Corporation","Corp."). To use this formula to
replace the data in the database, use the Formula Fill command. (For a
simple replace case like this, however, it is easier to use the Change com-
mand. The replace( function is useful when you want to perform other
transformations in addition to the replace.)

sandwich(prefix,root,suffix)

The sandwich( function assembles a text item from three smaller text
items. The prefix and suffix are slapped on the ends of the root, just like a
sandwich. However, if the root is empty, the prefix and suffix are also left
off (the result is an empty text item), just as you wouldn’t make a sand-
wich without any meat. 

Suppose you have a database with names and titles, and you want to dis-
play this information in a report with the titles surrounded by parenthe-
ses. The formula below could be used with an auto-wrap text object or
Text Display SuperObject.

Name+sandwich(" (",Title,")")

If the person has a title it will appear in parentheses like this: Steve
Johnson (Sales Mgr). If they don’t have a title then no parentheses will
appear. The sandwich( function is useful any time you have optional data
items combined together with punctuation in between. See also the con-
nect( and yoke( functions in this table.

strip(text)

This function strips off leading and trailing blanks and other whitespace
(carriage returns, tabs, etc.) This function has one parameter, the item of
text that you want to strip. The function removes blanks at the beginning
or end of the text, but does not affect blanks in the middle of the text. It
also removes carriage returns, tabs, or any character with an ASCII value
less than 32.

Function Description
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stripchar(text,range)

This function removes characters you don’t want from a text item. You
specify exactly what kinds of characters you want and don’t want
included in the final output. Text is the item of text that you want to strip.
Range specifies what kinds of characters you want to keep and what
kinds of characters you want to strip away. The range consists of one or
more pairs of characters. Each pair specifies a set of characters you want
to keep. For example, the pair AZ means that you want to keep the char-
acters from A to Z. For alphanumeric characters the set is pretty obvious.
For other types of characters you should check an ASCII chart (see
“ASCII Character Constant Functions” on page 301). For example the
pair #& specifies a set of four characters: #, $, % and &. You can use the
ASCII Chart wizard to try out your character ranges.

If a pair consists of the same character repeated twice in a row, the set is
just that single character. For instance the pair ## means you want to
keep one character: #.

The range may consist of several pairs put together. For example the
range AZaz09.. consists of four pairs, and specifies that all letters, num-
bers, and periods will be kept, with all other characters stripped away.

One handy use for this function is to quickly check if a field or variable
contains any inappropriate characters. If a field or variable changes when
you run it through the stripchar( function it must contain characters that
are not part of the specified range.

striphtmltags(text) This function removes all HTML tags from the text.

stripprintable(text) This function removes any non-displayable characters from the text.

striptoalpha(text)

This function removes everything but alphabetic letters from a text item.
Everything else (numbers, spaces, punctuation, non-English letters, etc.)
will by removed from the text.

One handy use for this function is to quickly check if a field or variable
contains all alphabetic characters. If a field or variable changes when you
run it through the striptoalpha( function it must contain non-alphabetic
characters.

striptonum(text)

This function removes everything but numeric digits from a text item.
Everything else (letters, spaces, punctuation, non-English letters, etc.)
will by removed from the text.

One handy use for this function is to quickly check if a field or variable
contains all numeric digits. If a field or variable changes when you run it
through the striptonum( function it must contain non-numeric charac-
ters.

upper(string)
This function converts all of the letters in the string to upper case. For
example, the formula upper(Terms) will convert net 30 to NET 30, or
c.o.d. to C.O.D. See also the lower( and upperword( functions.

upperword(string)

The upperword( function converts the first letter of each word in the
string to upper case, and all other letters to lower case. For example the
formula upperword(State) will convert new york to New York, or will
convert VERMONT to Vermont. See also the lower and upper functions.

yoke(prefix,joiner,suffix)

This function appends two text items (prefix and suffix) together. If both
are non-blank, a joiner is placed in between. If either (or both) is blank,
the joiner is not used. In some ways this is the reverse of the sandwich(
function.

Function Description
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Converting Between Numbers and Strings

These functions convert numbers into strings and strings into numbers.

ASCII Character Constant Functions

These functions return common ASCII characters.

Function Description

asc(string)

This function converts the first character of the string into a number
based on the ASCII value of the character. For example the formula
asc("Y") returns the value 89, while asc("Z") returns the value 90. See also
the chr( function.

chr(number)

This function converts a number into a single character of text based on
the ASCII value of the number. The number should be an integer between
0 and 255. For example, the letter A has an ASCII value of 65, while the
letter B is 66. You can create special characters with this function; TAB is 9
and RETURN is 13. See also the asc( function.

dollarsandcents(number)
This function converts a number to text formatted as dollars and cents
(for example 98123.45 becomes Ninety eight thousand one hundred
twenty three dollars and 45 cents).

money(number) Converts a number to text, formatted with commas every three digits and
two digits after the decimal point (for example 98,123.45).

nth(number) This function converts a number into an ordinal, i.e. 1=1st, 2=2nd, 3=3rd,
4=4th, etc.

pattern(number,string)

This function converts a number into text, using the string as an output
pattern. For example the formula pattern(Price,"$#.,##") will convert the
price 3458.23 into the string $3,458.23. The pattern adds the $ and the
comma. For more information on numeric output patterns see “Numeric
Output Patterns” on page 196.

str(number)
This function converts a number into text without any special formatting.
If you want to format the number (add commas, set # of digits, etc.) use
the pattern( function.

val(string)

This function converts a string into a number. The string must start with
one or more numeric digits. Everything after the first non-numeric char-
acter will be ignored. For example, the formula val(Address) will return
the number 731 if the address is 731 N. Miller St.

zbpattern(number,pattern)
This function displays a number using a pattern. Unlike the normal pat-
tern( function, the zbpattern( function will output "" if the number is zero.
(Note: zb is short for zeroblank.)

Function Description

info("lineseparator")
This function returns the line separator character on the current platform.
On Macintosh systems this is a carriage return. On Windows PC systems
this is a carriage return followed by a linefeed (CR-LF).

cr() This function generates a carriage return. This is equivalent to chr(13)
and is also the same as ¶.

crlf() This function generates a carriage return line feed. This is equivalent to
chr(13)+chr(10).

lf() This function generates a line feed. This is equivalent to chr(10).

tab() This function generates a tab character. This is equivalent to chr(9) and is
also the same as ¬.

vtab() This function generates a vertical tab character. This is equivalent to
chr(11).
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Text Arrays

An array is a numbered collection of data items. Panorama includes a number of functions and statements
that treat a single text data item as if it were a numbered collection of smaller items. The smaller text data
items must be separated from each other by a delimiter, for instance a comma or carriage return.

Consider the text data item shown below. Panorama would normally treat this as a single item with a length
of 40 characters. The functions described in this section, however, can treat this text as a collection of 7 ele-
ments separated by semicolons.

white;red;orange;yellow;green;blue;black

In this example, the ; is the separator character. You can use any character you want for a separator character,
in fact, you can use different separator characters at different times. You could even build a multi-level array
by using two different separator characters.

Using the array functions and statements provided by Panorama you can extract elements from an array,
change array elements, even sort an array. Since arrays are really text, they can be stored in any variable or
any text field, and they can be edited with the data sheet, a data cell, or a Text Editor SuperObject.

There are many statements and user interface elements that work with text arrays, including lists and pop-up
menus. There are also a number of functions that generate text arrays, including functions for building lists of
files, windows, fields, choices, and data. Most of these statements, user interface elements, and functions
require that carriage returns be used as separators, so that each array element is on a separate line.

It is up to you to keep track of the fact that you are using an array and what the separator character is. Pan-
orama won’t stop you from trying to access the array of colors above as if it were delimited with commas
instead of semicolons, but you probably won’t get the results you wanted unless you use the correct separa-
tor character.

(If you are familiar with the arrays in C or Pascal, Panorama text arrays are quite a bit different, although
both are a numbered collection of items. As with anything unfamiliar, Panorama text arrays probably won’t
look as good as the ones you are used to at first. Panorama arrays do have some significant advantages
though: they don’t have to be declared in advance, each array element can be of unlimited length without
wasting space, and Panorama arrays can be directly edited. It’s also very easy to “pre-fill” a Panorama array
with a list of values.)

Picking a Separator Character

Any ASCII character can be used as a separator character, so you have 256 possible choices. Common separa-
tors include comas, semicolons, slashes, carriage returns, spaces and tabs.

It’s important to pick a separator character that will not occur in the data elements of your array. If your data
may include commas, don’t use the comma as a separator character. If the data might include carriage
returns, don’t use a carriage return. If you want to be extra sure to avoid conflicts, pick a non-printing charac-
ter. You can use the chr( function to generate non-printing characters, for example chr(1), chr(2),
chr(3). Most chr( values below 32 are non-printing except for chr(9) and chr(13), which correspond to
tab and carriage return.

Some Panorama user interface elements and functions use text arrays as parameters or to hold a list of values.
For these applications the separator character is usually required to be a carriage return. For example, the
Pop-Up Menu SuperObject uses a carriage return delimited array to define the list of pop-up menu choices.
The lookupall( function extracts information from another database and places it into an array with what-
ever separator you specify. Consult the documentation for each individual statement, function or SuperOb-
ject to see the exact specifications for any arrays they may use.
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Working With Arrays

Panorama has about a dozen functions and procedure statements for working with arrays. These functions
are described in this table.

Function Description

array(text,item,sep)

This function extracts a single data item from a text array. Text is the item
of text that contains the data you want to extract. Item is the number of
the data item you want to extract. The first item is item 1, the second is
item 2, the third item is 3, etc. Separator is the separator character for this
array. This should be a single character. For carriage return delimited
arrays, use the ¶ character (see “Special Characters” on page 288). For tab
delimited arrays use the ¬ character.

The array( function returns a single item of text from the array. Only the
item itself is returned, the separator characters on each end are not
included. If the item does not exist (for example if you ask for item 12
from a 7 item array) the function will return empty text ("").

There are 7 VHF television stations in Los Angeles. The example proce-
dure below will convert channel numbers into the names of the stations.
For example, the procedure converts Channel 7 into KABC.

Stations=",KCBS,,KNBC,KTLA,,KABC,,KCAL,,KTTV,,KCOP"
«Channel Name»=array(Stations,7,",")

 The example uses an array called Stations. This array uses commas as a
separator character.

arrayboth(a1,a2,sep)
This statement compares two arrays. The result is a list of elements that
are included in both arrays. Note: Empty array elements, if any, will be
ignored. Both arrays must use the same separator.

arraychange(text,value,item,sep)

This function changes a single value inside a text array. Only the one item
is changed, all the other items in the array remain the same. Text is the
text array that contains the data you want to change. Value is the new
value of the data item. Item is the number of the data item you want to
change. Items are numbered starting from 1 (1,2, 3,…). This item must
already exist in the array. The arraychange( function will not add the item
if it does not exist. Sep is the separator character for this array. This
should be a single character. For carriage return delimited arrays, use the
¶ character (see “Special Characters” on page 288). For tab delimited
arrays use the ¬ character. This function returns a copy of the text array,
with the data item changed. If you want to change the original array you
should use an assignment statement (see below).

The example procedure below will change the 5th item of the array to
Navajo White.

 Colors=arraychange(Colors,"Navajo White",5,";")

This example assumes that a field or variable named Colors already
exists.

arraycontains(text,item,sep)

This function checks to see if any element of an array matches the speci-
fied text. For the result to be true, the array element must match the spec-
ified text exactly, including upper and lower case. Otherwise the function
will return false. So checking for "Green" will only match that exact array
element, not "green" or "Olive Green". (Note that this is quite different
from the contains operator, which ignores upper and lower case and
allows a submatch.)

arraydeduplicate(text,separator) This function removes duplicate values from an array. As a byproduct it
also sorts the array.
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arraydelete(text,item,count,sep)

This function deletes one or more elements from the middle of a text
array. Text is the text array that you want to insert elements into. Item is
the spot where you want the elements to be deleted. Count is the number
of elements you want to delete from the array. Sep is the separator charac-
ter for this array. This should be a single character. For carriage return
delimited arrays, use the ¶ character (see “Special Characters” on
page 288). For tab delimited arrays use the ¬ character. This function
returns a copy of the original text array, with the specified elements
deleted from the middle. The example procedure below will delete the
3rd item from the SpeedDial array:

 SpeedDial=arraydelete(SpeedDial),3,1,¶)

arraydeletevalue(text,value,sep)

This function deletes any array elements that match the value parameter.
This mush be an exact match, including upper and lower case. If the
value occurs multiple times in the array, every occurrence of the value
will be removed, with one exception: If the value occurs in two consecu-
tive array elements, only the first occurrence will be deleted.

arraydifference(a1,a2,sep)
This statement compares two arrays. The result is a list of elements that
are in the first array but not the second. (Note: Empty array elements, if
any, will be ignored.) Both arrays must use the same separator.

arrayfirst(text,sep) This function extracts the first element of an array.

arrayinsert(text,item,count,sep)

This function inserts one or more elements into the middle of a text array.
Text is the text array that you want to insert elements into. Item is the spot
where you want the new elements to be inserted. Count is the number of
blank elements you want to insert into the array. Sep is the separator
character for this array. This should be a single character. For carriage
return delimited arrays, use the ¶ character (see “Special Characters” on
page 288). For tab delimited arrays use the ¬ character.

This function returns a copy of the original text array, with the new blank 
array elements inserted into the middle. The example procedure below 
will add 5 new array items to the SpeedDial array between the 2nd and 
3rd array items:

SpeedDial=arrayinsert(SpeedDial),¶,3,5)

The new array items created by arrayinsert( are blank (empty). You can 
fill them in with the arraychange( function.

arraylast(text,sep) This function extracts the last element of an array.

arraylefttrim(text,count,sep)
Removes the first elements of an array. For example 
arraylefttrim(text,2,",") removes the first two elements from a comma sep-
arated array.

arraynotcontains(text,item,sep) This function is the reverse of the arraycontains( function.

Function Description
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arrayrange(text,start,end,sep)

This function extracts a series of data item from a text array. Text is the
item of text that contains the data you want to extract. Start is the number
of the first data item you want to extract. Items are numbered starting
from 1 (1, 2, 3,…). End is the number of the last data item you want to
extract. Items are numbered starting from 1 (1, 2, 3,…). Sep is the separa-
tor character for this array. This should be a single character. For carriage
return delimited arrays, use the ¶ character (see “Special Characters” on
page 288). For tab delimited arrays use the ¬ character.

 This function returns a series of items from the array. It returns the first
item, the last item, and everything in between (including any separators
that are in between). If the last item does not exist (for example if you ask
for item 12 from a 7 item array) the function will return up to the actual
last item in the array. If both requested items do not exist, the function
will return empty text ("").

This example procedure will fill the variable WeekDays with the text
Mon,Tue,Wed,Thu,Fri.

Days="Sun,Mon,Tue,Wed,Thu,Fri,Sat"
WeekDays=arrayrange(Days,2,6,",")

arrayreplacevalue(text,
oldvalue,newvalue,sep)

This function replaces any array elements that match the value parame-
ter. This must be an exact match, including upper and lower case. If the
value occurs multiple times in the array, every occurrence of the value
will be replaced, with one exception. If the value occurs in two consecu-
tive array elements, only the first occurrence will be replaced.

arrayreverse(text,sep)

This function reverses the order of the elements in a text array. In other
words, the first element becomes the last element, the second element
becomes the second to last, etc. Text is the text array that you want to
modify. Sep is the separator character for this array. This should be a sin-
gle character. For carriage return delimited arrays, use the ¶ character
(see “Special Characters” on page 288). For tab delimited arrays use the ¬
character.

The arrayreverse( function reverses the order of the elements of an array.
For example, the formula:

 arrayreverse("1;2;3;4",";")

will produce the array 4;3;2;1.

arraysearch(array,text,start,sep)

This function searches a text array to see if it contains a specific value.
Array is the text array that you want to search. Text is the text that you
want to search for. This parameter may contain the wildcard characters ?
and * . For example, to search for array items that start with John use
John* . To search for any array item containing Pacific use *Pacific*. The
array item must match the text exactly, including upper/lower case. For
more information on wildcard characters, see “A match B” on page 316.
Start is the spot in the array where you want the search to begin from. If
you want to search the entire array, this parameter should be one. Sep is
the separator character for this array. This should be a single character.
For carriage return delimited arrays, use the ¶ character (see “Special
Characters” on page 288). For tab delimited arrays use the ¬ character.

If the arraysearch( function finds an array element that matches what you
are searching for it returns the number of that array element (1, 2, 3, etc.).
If there is no matching element, the function returns 0.

Function Description
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arraysize(text,sep)

This function counts the number of items in a text array. Text is the text
array that you want to count. Sep is the separator character for this array.
This should be a single character. For carriage return delimited arrays,
use the ¶ character (see “Special Characters” on page 288). For tab delim-
ited arrays use the ¬ character.

This function returns a number. This is the number of elements in the
array. If there is no text in the array, the function will return one. If you
need a function that returns zero if there is no text you can use the extract
function with the last parameter set to -1 (see “String Modification Func-
tions” on page 298).

This example uses the arraysize( function to display the number of forms
in the current database. (The dbinfo("forms,"") function creates an array
listing all the forms in the current database, separated by carriage
returns.)

message "This database contains "+
  str(arraysize(dbinfo("forms",""),¶))+" forms"

arraysort(text,separator) This function sorts an array in alphabetical order.

arraystrip(text,sep)

This function removes any blank elements from a text array. Text is the
text array that you want to strip the blank elements from. Sep is the sepa-
rator character for this array. This should be a single character. For car-
riage return delimited arrays, use the ¶ character (see “Special
Characters” on page 288). For tab delimited arrays use the ¬ character.
This function returns a copy of the original text array, with any blank
array elements removed from the array.

arraytrim(text,count,sep)
This function removes the last elements of an array. For example arrayt-
rim(text,2,",") removes the last two elements from a comma separated
array.

makenumberedarray(sep,start,end) This function generates a numeric sequenced array, for example 1, 2, 3, 4,
5. You can specify the starting and ending number of the sequence.

Function Description



Chapter 8:Calculations & Formulas Page 307
Date Arithmetic

Formulas can perform several useful calculations on dates. For example, you can calculate the number of
days between two dates, or you can add or subtract a certain number of days to a date. You can also convert a
date to text using a wide variety of formats.

Usually we think of a date in terms of years, months, and days. Formulas, however, treat dates as a certain
number of days—specifically, the number of days between that date and January 1, 4713 B.C., adjusted for
the Gregorian calendar correction in October 1582. (The date 4713 B.C. is chosen for obscure astronomical rea-
sons). For example, to a formula the date August 7, 1991 is day number 2,448,476.

Fortunately you should never have to worry about numbers like 2,448,476. The formula will automatically
convert a date field into the number of days, perform the calculation, and then convert back into a regular
date again.

Since formulas handle dates as numbers, you can use any numeric operator or function to manipulate dates.
However it doesn’t make much sense to take the square root of a date (although Panorama will let you).
There are really only two numeric operations that make sense on dates—subtracting two dates to find the
number of days in between and adding or subtracting a number of days to a date.

To calculate the number of days between two dates, just subtract one from the other. For example, the for-
mula

«Ship Date»-«Order Date»

will calculate the number of days required to process an order.

To calculate an offset from a given date, just add the number to the date. For example the formula

«Ship Date»+30

calculates the normal due date 30 days after the ship date.

Today’s Date

The today() function returns the number corresponding to today’s date, allowing you to use today’s date in
a formula. For example, to calculate the age of an invoice use a formula like this.

today()-«Ship Date»

To calculate the due date for a library book, use the formula like this.

today()+14

This formula assumes that books are checked out for two weeks.
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Converting Between Dates and Text

These functions allow you to convert a date into text, or text into a date. You should only use these functions
if you want to store the result of a date calculation in a text field instead of a date field, or if you want to
access a date that has been stored as text.

Note: Remember, formulas handle dates as numbers, so these functions actually convert numbers into text
and vice versa. It’s up to you to make sure that these numbers actually represent the correct dates.

Function Description

completedatestr(number) Convert a date to text, including the day of the week (for example Sun-
day, April 20th, 2003).

date(text)

This function converts a text string in a date format into the number rep-
resenting that date. Use this function to include a constant date in your
formula, for example date("12/9/1979"). You should also use this func-
tion to access dates that have been stored in text fields (but why are you
doing that in the first place?).

Several formats are supported, including mm/dd/yy, mm/dd/yyyy,
Month dd, yyyy, and Mon dd, yyyy. Dates in the current week can be rep-
resented by the name of the day, for instance Tuesday or Fri. Dates in the
previous or upcoming week can be represented by adding the words last
or next, for example last friday or next wed.

datepattern(number,pattern)

This function converts a number representing a date into a formatted text
string. The pattern parameter is an output pattern telling the function
how to format the date. For more information on date output patterns,
see “Date Output Patterns” on page 200.

Use the datepattern( function to store a date in a text field, or to display a
formatted date in an auto-wrap text object or Text Display SuperObject.
For example, the formula:

datepattern(«Ship Date»,"Month ddnth, yyyy")

can be used to display the date an order was shipped in the format May
12th, 2003.

datestr(number) Convert a date to text using format mm/dd/yy (for example 4/20/03).

daystr(number) Convert a date to the day of the week (for example Sunday).

eurodatestr(number) Convert a date to text in European format (for example 20-APR-2003).

exportcell(field)

This function takes any database field and converts it to text, using the
appropriate pattern if one has been defined in the Field Properties dialog.
Field is the name of the field to be converted to text.

The function always returns a text type data item. The power of the
exportcell( function is that it does not require you to know what type of
data you are exporting. It simply takes whatever kind of data is in the
field (text, number, date, whatever) and converts it into text.

longdatestr(number) Convert a date to text with format Month ddnth, yyyy (for example April
20th, 2003).

naturaldata(date)

This function converts a date to text in a natural format similar to how
people would refer to the date, for example Today, Tue, Apr 4. If the date
is more than 180 days in the past or is in the future the pattern mm/dd/
yy is used. This is similar to how the Apple Finder displays dates..
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Date Functions

These functions perform various calculations and conversions on date values. Unless specified otherwise the
date is always processed as a numeric value.

Function Description

datevalue(year,month,day)

This function converts three integers into a date. The three integers are
the year, month and date. This function provides a way to create a date
that is independent of the system date settings (the date( function, which
can also create dates, will produce different values in different countries
depending on the date formats used in those countries).

dayofweek(date)

This function computes the day of the week (0-6) of a date, with Sunday
being 0, Monday 1, etc. The function returns a number from 0 to 6. The
days of the week are: 

0  Sunday
1  Monday
2  Tuesday
3  Wednesday
4  Thursday
5  Friday
6  Saturday

The procedure below uses the dayofweek( function to select all weekday
records (monday through friday). 

 select dayofweek(Date)≥1 and dayofweek(Date)≤5

dayvalue(date) This function extracts the day of the month from a date as a numeric
value (1 to 31).

month1st(date)

This function computes the first day of a month. For example, if the date
passed to this function is October 18, 1997, this function will return the
date October 1, 1997. The date is returned as a number.

The example procedure below uses this function to select the orders
placed this month, then displays the count.

select OrderDate≥month1st( today()) and
   OrderDate<month1st(today())+monthlength(today())
message str(info("records"))+" orders this month"

monthlength(date)

This function computes the length (number of days) of a month. For
example, if the date passed to this function is October 18, 1997, this func-
tion will return 31, the number of days in October. This function knows
about leap years and adjusts the length of February accordingly.

The example procedure below uses this function to select the orders
placed this month, then displays the count.

select OrderDate≥month1st( today()) and
   OrderDate<month1st(today())+monthlength(today())
message str(info("records"))+" orders this month"
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monthmath(date,offset)

This function takes a date and computes another date that is one or
months before or after the original date. Date is a number representing
the original date. Offset is the number of months that you want to add or
subtract to the original date. Use a positive number to move forward in
time, a negative number to go backwards. For example, if you offset the
date May 12, 1997 by 2 (two months forward) the result is July 12, 1997. If
you offset the same original date by -2 (two months backward) the result
is March 12, 1997.

If the new date does not exist because a month does not have enough
days in it, the monthmath( function will pick the last day of the month.
For example, if you offset March 31 by 1 month the result is April 30. If
the new month lands in February the function knows about leap years
and adjusts accordingly.

This example calculates a renewal date exactly one year from today.

 monthmath(today(),12)

monthvalue(date) This function extracts the month from a date as a numeric value (1 to 12).

quarter1st(date)
This function computes the first day of a quarter. For example, if the date
passed to this function is August 18, 1997, this function will return the
date July 1, 1997. The date is returned as a number.

quartervalue(date) This function extracts the quarter within a year from a date as a numeric
value (1 to 4).

today() This function returns today’s date (assuming, of course, that your com-
puter clock has been set correctly).

week1st(date)

This function computes the first day of a week (Sunday). For example, if
the date passed to this function is July 12, 1995 (a Wednesday), this func-
tion will return the date July 9, 1997 (a Sunday). The date is returned as a
number.

year1st(date)

This function computes the first day of a year. For example, if the date
passed to this function is July 12, 1995, this function will return the date
January 1, 1995. The date is returned as a number.

The example below calculates the number of days remaining in the cur-
rent year.

yearfirst(year1st( today( ))+366)-today()
 

weekvalue(date) This function extracts the week from a date as a numeric value (this is the
number of weeks since the start of the year, 1 to 52).

yearvalue(date) This function extracts the year from a date as a numeric value.

Function Description
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Time Arithmetic

To Panorama, time is not hours, minutes, and seconds, but simply seconds. To be precise, a time is the num-
ber of seconds since midnight. For example, the time 4:32 AM is 16,320 seconds after midnight. As you can
see, a Panorama time is really a number in disguise. Since times are numbers, it’s easy to compare them, sort
them, or find the difference between them (number of seconds).

Converting Between Times and Text

Unlike dates, Panorama does not automatically provide a time data type that automatically converts a date in
text format into a number. You must use a function to convert time in text format into seconds before you can
do math calculations with the time, and use another function to convert back.

Function Description

now() This function returns the current time (number of seconds since mid-
night). Of course the clock on your computer must be set correctly!

seconds(text)

This function converts text into a number representing a time. The func-
tion has one parameter — the text that you want to convert to a number
representing a time. If the text includes and AM or PM suffix, the number
of seconds is calculated from midnight (12 A.M.), otherwise it is calcu-
lated from 0:00:00 (elapsed time). The text must contain a valid time. Here
are some examples of valid times:

4:13 PM
11:00 AM
2:30
18:45

This function returns a number representing the time. The number is the
number of seconds since midnight. For example, if the time is 10:23 AM
this function will return the number 37,380.

timepattern(number,pattern)

This function converts a number representing a time into text. The func-
tion uses a pattern to control how the date is formatted.

The function has two parameters: number and pattern. Number is the
number that you want to convert to text. This number must be the num-
ber of seconds since midnight. Pattern is text that contains a pattern for
formatting the date. The pattern is assembled from four components: hh
(hours), mm (minutes) ss (seconds), and am/pm. Some of the more com-
mon time patterns are listed here:

Pattern            Converted Text
"hh:mm:ss am/pm"   4:32:17 pm 
"hh:mm am/pm"      4:32 pm 
"hh:mm:ss"         16:32:17 

 If am/pm is left off the pattern the time will be formatted in 24 hour for-
mat, as shown on the last line of the table above. You should also leave off
am/pm for converting elapsed times.
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Time Calculations

Once time has been converted into seconds you can perform arithmetic on it. For example, to calculate the
number of hours worked from a time card use a formula like this (this formula assumes that In and Out are
text fields containing times).

(seconds(Out)-seconds(In))/3600

(The division by 3600 converts the result into hours.)

To find out when a task will be finished that takes 2 1⁄2 hours to complete, use the formula

seconds(«Start Time»)+seconds("2:30")

time(text)

This function converts text into a number representing a time. The func-
tion has one parameter — the text that you want to convert to a number
representing a time. The time function allows you to leave out the colons
in the time, and also allows you to leave off the am/pm. Here are some
examples of valid times:

4:13 PM
11:00 AM
2:30
18:45
230
4p
midnight
noon
afternoon
evening
night
nite 

The time( function is very lenient about the format you use to enter the
time. It will accept a time without colons, for example 425 pm instead of
4:25 pm. If there is no am or pm the time function will try to make an
intelligent guess. For example, 230 is almost certainly 2:30 pm, not 2:30
am. By default, the time( function assumes that any time from 6:00 to
11:59 is AM, and any time from 12:00 to 5:59 is PM, but you can change
these assumptions with the timedefaults statement.

The time( function will also convert “named” times: noon, midnight,
morning, afternoon, evening, and night. This function assumes that
morning is 9:00 am, afternoon is 1:00 pm, evening is 6:00 pm, and night is
10:00 pm. These assumptions can be changed with the timedefaults state-
ment.

timestr(number) Convert a number to text in am/pm time format (for example 9:34 AM).

Function Description
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Simple addition and subtraction does not compensate for time wrapping around midnight. For example, if
you want to calculate the length of a shift that begins at 11 P.M. and ends at 7 A.M., you must add 24 hours to
7AM before subtracting the times. To solve this problem you can use one of the functions described below, or
you can use a SuperDate, which combines time and date into a single number (see “True/False Formulas” on
page 315).

Function Description

time24(time)

This function takes a time and makes sure it falls within a 24 hour period.
If the time is less than 24 hours, it is unchanged. If the time is greater than
24 hours, it is converted to the equivalent time in a 24 hour period (for
example 30:00:00 is converted to 6:00:00).

The time24( function can help with calculations of an ending time from a
start time and duration. The basic formula for such a calculation is shown
here.

EndTime=StartTime+Duration 

This formula works fine unless the interval extends over midnight. The
time24( function adjusts the result to make sure it starts over at zero as it
crosses midnight.

EndTime=time24(StartTime+Duration) 

This formula will correctly calculate that 10:30 PM + 4 hours is 2:30 AM.

timedifference(start,end)

This function calculates the difference between two times. It works cor-
rectly even if the interval between the two times crosses over midnight.
This function returns a time interval between -12 and +12 hours. See also
the timeinterval( function, which returns a time interval between 0 and 24
hours.

There are two parameters, start and end. Start is a number (number of
seconds) representing the starting point of the time interval. End is a
number (number of seconds) representing the ending point of the time
interval. This function returns the number of seconds between the two
times. For example, if the start time is 9:30 PM and the end time is 2:05
AM, the difference would be 4:35. But if the parameters are reversed and
the start is 2:05 AM and the end is 9:30 PM, the difference is -4:35. If the
result is positive, the end is after the start. But if the result is negative, the
start is after the end.

timeinterval(start,end)

This function calculates the time interval between two times. It works
correctly even if the interval between the two times crosses over mid-
night. This function returns a time interval between 0 and 24 hours. See
also the timedifference( function, which returns a time interval between -
12 and +12 hours.

There are two parameters, start and end. Start is a number (number of
seconds) representing the starting point of the time interval. End is a
number (number of seconds) representing the ending point of the time
interval. This function returns the number of seconds between the two
times. For example, if the start tine is 9:30 PM and the end time is 2:05
AM, the interval would be 4:35. But if the parameters are reversed and
the start time is 2:05 AM and the end time is 9:30 PM, the interval is 19:25.
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Time Calculations with Text

Unlike the functions in the previous sections, these functions operate with time values in strings. There aren’t
as many functions available as for times expressed as numbers, but if your input and output values will be in
strings using these function saves the intermediate conversion steps.

Function Reference 
Page Description

texttimedifference(start,end)

This function calculates the difference between two times. Instead of
being expressed as numbers, the input output times are expressed as text
(for example 12:45 pm). This function works correctly even if the interval
between the two times crosses over midnight. This function returns a
time interval between -12 and +12 hours. See also the timeinterval( func-
tion, which returns a time interval between 0 and 24 hours.

There are two parameters, start and end. Start is a string representing the
starting point of the time interval. End is a string representing the ending
point of the time interval. This function returns the time difference
between the start and end. For example, if the start time is 9:30 PM and
the end time is 2:05 AM, the difference would be 4:35. But if the parame-
ters are reversed and the start is 2:05 AM and the end is 9:30 PM, the dif-
ference is -4:35. If the result is positive, the end is after the start. But if the
result is negative, the start is after the end.

texttimeinterval(start,end)

This function calculates the time interval between two times. It works
correctly even if the interval between the two times crosses over mid-
night. This function returns a time interval between 0 and 24 hours. See
also the timedifference( function, which returns a time interval between -
12 and +12 hours.

There are two parameters, start and end. Start is a string representing the
starting point of the time interval. End is a string representing the ending
point of the time interval. This function returns the time between the start
and end. For example, if the start tine is 9:30 PM and the end time is 2:05
AM, the interval would be 4:35. But if the parameters are reversed and
the start time is 2:05 AM and the end time is 9:30 PM, the interval is 19:25.



Chapter 8:Calculations & Formulas Page 315
True/False Formulas

In Panorama as in most programming languages, control flow decisions are made on the basis of formulas
that are either true or false. The most basic true/false formula compares two values to see if they are equal.

PaymentMethod="C.O.D."

This formula will compare the value in the field PaymentMethod with C.O.D. The result will be true if Pay-
mentMethod is C.O.D., and false if it contains anything else (for example Check, Cash, Visa, etc.).

Comparison Operators

Panorama has about a dozen different operators that can compare two values and produce a true false result.
You can type these operators in yourself (see “Special Characters” on page 288), or you can use the Operator
sub-menu in the Function menu to type in the symbols for you. The table below lists the universal compari-
son operators. These comparison operators will work with any type of data: text, numeric, or date.

All of the above operators require that A and B be the same data type. In other words, you cannot directly
compare numbers to text, or text to dates. If A and B are different types you must convert them to the same
type before comparing them, using the str(, val(, pattern(, date( or datepattern( functions. See “Converting
Between Numbers and Strings” on page 301 and “Converting Between Dates and Text” on page 308 for more
information on these functions.

Panorama also has a number of specialized comparison operators that work only with the text data type.

Some of these operators deserves a more complete explanation:.

Operator Example True/False Meaning Notes

= A=B is A equal to B?

≠ A≠B is A not equal to B? Not available on PC

<> A<>B is A not equal to B?

> A>B is A greater than B?

≥ A≥B is A greater than or equal to B? Not available on PC

>= A>=B is A greater than or equal to B?

< A<B is A less than B?

≤ A≤B is A less than or equal to B? Not available on PC

<= A<=B is A less than or equal to B?

Operator Example True/False Meaning

beginswith A beginswith B does A begins with B?

endswith A endswith B does A end with B?

contains A contains B does A contain B?

notcontains A notcontains B does A not contain B?

soundslike A soundslike B does A sound like B (phonetically)?

match A match B does A match the wildcard pattern in B
(disregarding upper/lower case)?

matchexact A matchexact B does A exactly match the wildcard pattern in B?

notmatch A notmatch B
does A not match the wildcard pattern in B

(disregarding upper/lower case)?

notmatchexact A notmatch B does A not exactly match the wildcard pattern in B?
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A soundslike B

This operator checks to see if the text in A “sounds like” the text in B. For example, the formula below will
determine if the LastName sounds like the name Smith.

LastName soundslike "Smith"

This formula will be true if the name is Smith, Smyth or Smythe, and false if the name is Jones or Williams.

The method Panorama uses to determine whether two values sound alike is called “soundex.” This tech-
nique is not very exact, and often will produce extra matches that you might not think really sound similar.
However, it almost never fails to match on names that do sound similar, so it is a good starting point when
you are not sure of an exact spelling.

The soundex technique does require that the first letter of the two values match. For example even though we
think they sound alike, Christy and Kristy will not match because the first letter is different.

A match B

This operator checks to see if the text in A matches a pattern you specify in B. The pattern allows you to set
up very flexible “wildcard” matches where some characters must match and some don’t have to.

The pattern should combine normal characters, which must match the text in A, and wildcard characters: ?
and *. The ? wildcard character will match any character. The * wildcard character (asterisk) will match a
variable number of characters. The best way to understand wildcard matches is probably to look at a few
examples.

Our first example uses the pattern j*johnson. With this pattern the name must begin with j (or J) and end with
johnson (or Johnson, etc.) The characters in between don’t matter.

Name match "j*johnson"

This formula will produce a true result for names like Jim Johnson, Jack Johnson, Joe Johnson, etc. The for-
mula will also be true for names like J346 Ujohnson or J@#opcjohnson.

The second example uses the pattern 926??. With this pattern the zip code must begin with 926 and must be 5
digits long. (Our example assumes that ZipCode is a text field, not a numeric field.)

ZipCode match "926??"

This formula will produce a true result for zip codes like 92631 or 92685 but a false result for zip codes like
89324 or 92685-0301. Here’s a variation that will work with 5 or 9 digit zip codes. The ?? characters mean that
there must be at least five digits, while the * means that any extra characters are ok.

ZipCode match "926??*"

This formula will produce a true result for zip codes like 92631, 92685 or 92685-0301, but a false result for 926
or 9262.

Don’t forget that a space is a normal character. The example below checks for people with a middle initial.
The pattern looks for any number of characters followed by a space, followed by a single character, followed
by a period, followed by another space, followed by any number of characters.

Name match "* ?. *"

This formula will produce a true result for Robert E. Lee or Winston O. Link, but a false result for Frank Tesh,
Billy Martin, or Sara Jessica Parkman.
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The match operator can be used to simulate the beginswith, endswith and contains operators. The table
below shows the equivalent match formulas for each of these operators.

Note: The match operator does not worry about upper or lower case. If upper and lower case are important
to you, use the matchexact operator.

A matchexact B

This operator checks to see if the text in A matches a pattern you specify in B. This operator works exactly the
same as the match operator, except that the normal characters must match exactly, including upper and lower
case. For example, the formula below

Name matchexact "J*Johnson"

will produce a true result for Jeff Johnson, but a false result for JEFF JOHNSON. (However, JEFF Johnson
would produce a true result.)

You can use the matchexact operator instead of beginswith, endswith, or contains if you need an exact upper
and lower case match.

A notmatch B

A notmatchexact B

These operators are the exact opposite of match and matchexact.

Combining Comparisons

The basic comparisons described in the previous section can be combined together for more complicated
decisions. There are four basic operators that can combine or modify decisions: and, or, xor, and not.

A and B

The and operator combines two true/false formulas together so that the result is only true if both formulas
are true. The example procedure below determines if a person is a teenager.

if Age≥13 and Age<20
Status="Teenager"

endif

The result of the formula is only true if the person is 13 or older and less than 20.

These formulas… are the same as these.

A match B+"*" A beginswith B

A match "*"+B A endswith B

A match "*"+B+"*" A contains B

Operator Sample Description

and A and B true if both A and B are true

or A or B true if either A or B are true

xor A xor B true if A and B are different

not not A true if A is false
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A or B

The or operator combines two true/false formulas together so that the result is true if either one of the two
formulas are true. The example below determines if a transaction is being paid with a credit card.

if PaymentMethod="Visa" or PaymentMethod="MasterCard"
Terms="Credit Card"

endif

The result of the formula is only true if the payment method is Visa or MasterCard.

Notice that each side of the or operator must contain a complete formula. The formula below looks right in
English, but will not work in Panorama. The example below is WRONG:

if PaymentMethod="Visa" or "MasterCard"      /* WILL NOT WORK !! */

There must be a comparison on both sides of the or, as shown in the first example.

A xor B

The xor (short for exclusive-or) operator is a bit tricky. Xor combines two true/false formulas together so that
the result is true if one of the two formulas is true, but false if both are true or both are false. Another way to
put it is that the result will be true if A and B are different, but false if they are the same. The example below
determines if two shoes are a pair.

if Shoe1="Left" xor Shoe2="Left"
message "These shoes are a pair"

endif

The result of the formula is only true if one shoe is Left and the other shoe is Right (or to be more precise, not
Left).

not A

The not operator reverses a true-false formula. If the result was true, now it will be false. If it was false, now it
will be true.

if (not (Shoe1="Left" xor Shoe2="Left"))
message "These shoes are not a pair!"

endif

Note: This example shows that if not is used as the very first operator in a formula in a procedure, you must
surround the entire formula with an extra pair of parentheses. If not is in the middle of the formula the extra
parentheses are not necessary. The parentheses are also not necessary if the formula is not in a procedure.

Equals Comparison vs. Assignment

If you have skipped ahead to read about procedures you know that the equals sign is used to assign a value
to a field or variable. The example formula we used earlier to compare two values:

PaymentMethod="C.O.D."

would also be the same formula used to assign the value C.O.D. to the field or variable PaymentMethod. At
first glance this may appear ambiguous…the same formula is used to compare two values and to assign a
value. How do we know when we are assigning and when we are comparing? The answer lies in the context
in which the formula is found.
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In a procedure, an assignment is always by itself, not part of a larger statement. A true-false formula is
always part of another statement, for example if, case, until, while, stoploopif, repeatloopif,
find, select. Here’s an example that shows two formulas that look almost the same, but one is a true-false
formula and one is an assignment.

if PaymentMethod="C.O.D."
ShippingMethod="UPS"

endif

The first formula, PaymentMethod="C.O.D.", is part of the if statement. This formula means: Is the field
(or variable) PaymentMethod equal to C.O.D. (true/false)?

The second formula, ShippingMethod="UPS", is not part of any statement, but stands alone, so this is an
assignment. The statement means: Take the value UPS and copy it into the field or variable named Shipping-
Method.

If an assignment has more than one equals sign, the first equals sign is for the assignment and the rest are for
comparisons. The example assignment below compares B and C. If they are equal (true) the value -1 will be
copied into A. If they are not equal (false) the value 0 will be copied into A.

A=B=C

In other words, A becomes the result of the comparison between B=C, or A = (B=C).

True/False Values

For purposes of calculation, Panorama treats true and false as numbers: true is -1 and false is zero. Panorama
also has two functions that directly generate these values.

Like any other number, you can store a true/false value in a field or variable and then use it later. The exam-
ple below calculates whether a person is a teenager, then uses that information later.

local Teenager
Teenager=Age≥13 and Age<20
...
if Teenager

Price=4.50
else

Price=6.00
endif

Notice that the if statement doesn’t need to compare, it simply uses the result of the comparison that was
calculated earlier. In fact, the if statement (and all other statements that use true/false logic) can use any for-
mula that produces a numeric integer result. The value 0 will be regarded as false, and any non-zero value
will be regarded as true. The example below will be true if the length of the name is non-zero.

if length(Name)
yesno "Is this a home address?"
...

endif

The first line of this example could also have been written if length(Name)≠0. The result is the same
either way.

Function Reference 
Page Description

true() This function always returns true (-1).

false() This function always returns false (0).
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The ? Function

The ?( function allows a formula to make a decision. Will it be door number 1 or door number 2? The function
uses a true-false value to pick from one of two values. The syntax for this function is like this.

?(decision-value,true-value,false-value)

The first parameter, decision-value, is used to pick which of the two choices will be returned as the final
value, the true-value or the false-value.

For example, the formula below can be used to calculate a 10% discount if the quantity is 100 or more—

?( Qty<100 , Price , Price*0.9 )

The decision is based on the comparison Qty<100. If Qty is less than 100, the ? function picks the second
parameter, Price. But if the quantity is 100 or more, the ? function will pick the third parameter,
Price*0.9, for a 10% discount.

If you need to pick from three or more choices you can nest several ? functions together. For example, this for-
mula shows how you can add a third discount level (20% for quantities of 500 or more)—

?( Qty<100 , Price , ?(Qty<500 , Price*0.9 , Price*0.8 ))

Although these examples have used numeric data, text can also be used for either the true-false logic or the
choices. The formula below, for example, could be used by a movie theater to check if a person is a child or an
adult.

?( Age≤12 , "Child" , "Adult" )

Note: The ? function always evaluates all three parameters you give it, even though it really uses only two of
the parameters. This means that you cannot use the ? function to avoid errors (for example divide by zero
errors) because the error will happen before the ? function decides which parameter to use (use the divzero(
function to avoid divide by zero problems).

Converting a Boolean Value to Text

The boolstr( function converts a boolean value to text, either true or false. For example

message boolstr(Qty<100)

will display true if the Qty is less than 100, or false if it is greater or equal to 100.
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Linking With Another Database

Many database applications require multiple database files working together. For example, organizing a
company’s order entry operations usually requires an invoice file, an inventory/price list file, and possibly a
customer file. The primary method for accessing information in other databases is the lookup( function (and
other related functions). This function can search for and retrieve information from any open database. Need
to look up a price or a customer’s credit limit? Chances are the lookup( function is the tool for the job.

When you look up information manually (for example, looking up someone’s number in the phone book),
you are actually performing a multi-step process. You start with one piece of information—a person’s name,
for example. The first step is to locate the correct phone book. Once you’ve located the correct book, you must
search through it to find the name of the person you are looking for. When you find the name, the final step is
to copy down the person’s phone number.

Panorama’s lookup( function follows a similar process when it looks up data. For example, suppose you
want to find out the number of calories in an orange using the database shown here.

Here is the formula for looking up the number of calories in an orange. The parameters to the lookup contain
all the information necessary to locate the information.

The first parameter is called the lookup database. It tells Panorama what database to look in for the informa-
tion, in this case Groceries.

The second and third database tell Panorama how to search for the data you want. In this case Panorama is
being told to “search through the Fruit column until you find Orange.” The field to look in (in this case Fruit)
is called the lookup key field. The data to look for (in this case Orange) is called the lookup data value. By
the way, Panorama is very picky about the lookup data value. It must exactly match the value in the data-
base, or Panorama won’t find a match. In this case only Orange will work — not orange or ORANGE or even
oRaNGe!

lookup database

lookup key field
lookup key value

lookup data field lookup default value

lookup summary level
(almost always zero)
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At this point we come to a fork in the road. Perhaps Panorama found Orange in the database, perhaps not. If
it did the fourth parameter tells Panorama what to do next. This fourth parameter is called the lookup data
field, and it may be any field in the lookup database. In this case it is Calories, so Panorama will lookup the
value in the Calories field (70) and return it as the result of the function.

What if Panorama didn’t find Orange in the database? In that case Panorama simply returns the value of the
fifth parameter, the lookup default value. In this case the default value is 0. The default value should match
the data type of the lookup data field. Since Calories is a numeric field, the default is also numeric. If the
lookup data field had been a text field (for instance Serving Size) the default would need to be text (for exam-
ple "").

The sixth and final parameter to the lookup function is the lookup summary level. This is the minimum
summary level to be searched within the lookup database. Usually the lookup summary level is zero so that
the entire lookup database will be searched. If the level is set to 1 through 7, only summary records will be
searched. This is useful if you want to look up summary information (see “The Summarize & Analyze Dia-
log” on page 167) while ignoring the raw data.

In this example the end result of the lookup is the value 70. The lookup( function is often used by itself, but a
more complicated formula can take this value and perform additional computations. If the result of the
lookup is a text value then all of the text functions described earlier in this chapter can be used to modify the
result.
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The Lookup Wizard

Since the lookup( function is kind of picky about all of its parameters we’ve provided a “fill-in-the-blanks” dialog to help
build the function. To open this dialog first click on the blue ƒ button, then choose Formula>Lookup>LOOKUP(.
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Now the lookup wizard dialog appears.

To create the lookup function, start at the top of the dialog and work your way down. Start by selecting the
database to lookup from (in this case Groceries).
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Next, choose the data you want to retrieve (the lookup data field, which will become the fourth parameter to
the lookup function). In this case we want to retrieve the number of Calories.

The next step is to choose the lookup key field, which in this case is Fruit.



Page 326 Panorama Sheets
Finally, choose the field containing the lookup key value. If there is no such field (perhaps the value is in a
variable) then just choose any field and adjust the formula once the wizard is finished.

Once you’ve made all of the selections press OK to generate the finished formula. For example, if you were
using the Manipulate Data in Field dialog the formula would look like this:

Type Mismatch Problems

One of the most common problems when setting up a lookup function is type mismatches. With some careful
thought, however, you can avoid these problems.

The first source of type mismatch problems is the lookup key field and the lookup key value. The field and
value must be the same type of data. In other words, if the lookup key field is numeric, the lookup key value
must be numeric also. If necessary, you can convert a text key value into numeric with the val( function, or
you can convert a numeric key value into text with the str( function (see “Converting Between Numbers
and Strings” on page 301 for details on both of these functions).

lookup("Catalog","Part#",val(Item),"Price",0,0)

Another source of type mismatch problems is the lookup data field. This field must have the same type of
data as the field you want to store the result in. For example if you look up a price, the result must be stored
in a numeric field.

If you need to store a numeric value in a text field, use the str( function to convert the value. The str( function
should go outside the entire lookup function, for example

str(lookup("Catalog","Item",Desc,"Price",0,0))

Another source for type mismatch problems is the lookup default value. The default value should be the
same type as the lookup data field. If the lookup data field is numeric, the default should be numeric (for
example 0 or 100). If the lookup data field is text, the default should also be text (for example "" or "n/a").
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Lookup Variations

There are actually several different variations of the lookup function. All of the variations have the same six
parameters. The standard lookup function locates the first occurrence of the key (nearest to the beginning of
the file).

Looking Up Rates in a Rate Table

The table( function is designed for looking up rates from a table. For example, this function can be used to
look up shipping rates, tax rates, discount rates, or any kind of stepped rate where the rate changes according
to a sliding scale. To illustrate this function, consider this shipping rate database.

For packages from 0 to 49.99 pounds the rate is 2.50 per pound. For packages from 50 to 99.99 pounds the rate
is 2.35 per pound, from 100 to 249.99 the rate is 2.25 etc. Suppose we use a regular lookup function to look up
the weight, like this.

lookup("Shipping Rates",Weight,PackageWeight,«Rate Per Pound»,0,0)

Function Description

lookup(
This function searches for the first occurrence of the value within the
lookup database. If there is more than one copy of the value in the data-
base this function will find the one closest to the top.

lookuplast(

This function searches for the last occurrence of the value within the
lookup database. If there is more than one copy of the value in the data-
base this function will find the one closest to the bottom. However, there
is one exception. If you are looking up within the current database Pan-
orama will skip the current record. If the current record matches the key
value then Panorama will skip backwards to the next matching record.

lookupselected(

This function searches for the first occurrence of the value within the
selected records in the lookup database. Unselected (invisible) records are
ignored. If there is more than one copy of the value within the selected
records this function will find the one closest to the top.

lookuplastselected(

This function searches for the last occurrence of the value within the
selected records in the lookup database. Unselected (invisible) records are
ignored. If there is more than one copy of the value within the selected
records this function will find the one closest to the bottom.

table(

The table function allows you to lookup data by an approximate match
instead of exact match. If the table function does not find an exact match,
it uses the next lower value. A common example is a shipping rate table.
Rate tables do not have an entry for every possible weight. Instead, the
table only lists weights where the shipping rate changes. For example,
suppose a rate table contains entries for 100 pounds and 250 pounds, and
you have a 158 pound package. The table function will return the rate for
the next lower value, in this case the 100 pound rate.
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This formula will work fine for weights that appear in the table like 50, 100 and 250. But for other weights like
47 or 182 the formula will return the default value, zero. To fix this, use the table function instead of the
lookup function.

table("Shipping Rates",Weight,PackageWeight,«Rate Per Pound»,0,0)

The table function will return the closest lower match. This means that if the PackageWeight is 3, 17 or 42 the
formula will return 2.50. If the PackageWeight is 110 or 246 the formula will return 2.25, etc. Here is a com-
plete formula that calculates the shipping cost for any package.

PackageWeight*table("Shipping Rates",Weight,PackageWeight,«Rate Per Pound»,0,0)

The formula looks up the rate per pound and then multiplies that rate by the package weight.

Looking Up Multiple Fields From One Record

Sometimes you may need to lookup several fields in the same record. For example, when you lookup some-
one’s address you may also want to lookup their city, state, zip code, phone number and recent purchasing
history. In a procedure one way to do this is with multiple lookup( functions, like this.

Address=lookup("Customers",Company,Company,Address,"",0)
City=lookup("Customers",Company,Company,City,"",0)
State=lookup("Customers",Company,Company,State,"",0)
Zip=lookup("Customers",Company,Company,ZipCode,"",0)
Phone=lookup("Customers",Company,Company,"Phone#","",0)

When a procedure contains several lookup( in a row for the same thing like this Panorama doesn’t actually
search the database over and over again. Instead it notices that it is searching for the same item and simply
grabs the data from the record it has already found.

The GrabData Function

The grabdata( function grabs the contents of a field in the current record of any open database. You can
grab data from the current database, or from another database. The function has two parameters — the name
of the database to grab from and the name of the field within that database. For example here is the formula
to look up the number of calories of the currently selected fruit.

grabdata("Groceries",Calories)

The value returned by this function will change depending on what record is active in the Groceries database.

Looking Up Data in the Current File

You can use the lookuplast( function to look up the previous entry, with the same value, in the same database.
For example, in a checkbook database you can automate repetitive payments by looking up the previous pay-
ment to the same company. By using the info("database") function to look up the database name you can
make sure that the formula will continue to work even if the database is renamed.

lookuplast(info("database"),PayTo,PayTo,Amount,0,0)

Suppose that your last check to Pacific Mutual was $178.34. Using the formula above you could automati-
cally enter this value the next time you write a check to this company.

Another application for looking up data in the current file is locating summary information further down in
the database. To do this, set the lookup summary level to a non-zero value so that only summary records will
be located.
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US Post Office Abbreviation Functions

These functions return text arrays that contain lists of official US Post Office abbreviations. These functions
are designed to be used with the arraylookup( and arrayreverselookup( functions.

Database Information

These functions return information about the currently active database.

Function Description

stateabbreviations()
This function returns a list of state abbreviations in this format: AL:ALA-
BAMA;AK:ALASKA; ... This table is designed to be used with the array-
lookup( and arraylookupreverse( functions.

statelookup(state)
This function looks up the name of a state from the state abbreviation (for
example CALIFORNIA from CA). If the parameter does not match any
state then the original value is returned.

uspssecondaryunits()

This function returns a list of USPS secondary suffix designation abbrevi-
ations in this format: APT:APARTMENT;RM:ROOM; ... This table is
designed to be used with the arraylookup( and arraylookupreverse( func-
tions.

uspsstreetsuffixes()
This function returns a list of USPS street suffix abbreviations in this for-
mat: ALY:ALLEY;AVE:AVENUE; ... This table is designed to be used with
the arraylookup( and arraylookupreverse( functions.

Function Description

countsummaries(level)
This function counts the number of summary records in the current data-
base. The level parameter should be from 0 to 7. If 0, all summary records
will be counted. If 1 to 7 then only that specific level will be counted.

dbname() This function returns the name of the current database.

dbpath() This function returns the path of the folder the current database is located
in.

emptydatabase() This function returns true if the current database is empty, false if it is not.

emptyline() This function returns true if the current line (all fields) is empty, false if it
is not.

getautonumber() This function returns the automatically generated number for the next
record that will be added to the database.

listchoices(field,separator)

This function builds a text array containing a list of all the values stored
in a specified field. (Note: this function is not related to the choices data
type.) There are two parameters: field and separator. Field is the name of
the field that contains the values you want to build a list of. Separator is
the separator character for the text array you are building (see “Text
Arrays” on page 302).

The lischoices( function scans the specified field and builds a list of all the
values stored in that field. The list is returned in the format of a text array.
Here is a formula that builds a list of the states in the current database.

listchoices(State,¶)
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seq()

This function returns a sequential numbers (1, 2, 3, etc.). This function
only works in conjunction with the formulafill, select, find and
arrayfilter statements. 

When it is used with the formulafill, find or select statements the
seq() function return a sequential number for each record (the first
selected record is 1, the second is 2, etc.). 

When it is used with the arrayfilter statement, the seq() function
returns a sequential number for each element in the array being pro-
cessed (the first array element is 1, the second is 2, the third is 3, etc.). 

When it is used at any other time, the seq() function returns the number 1. 

This procedure uses the seq() function to select the first 10 records in the
database: 

select seq()≤10 

info("bof") This function returns true if the database is currently on the first visible
record. (Note: "bof" stands for "beginning of file".)

info("databasename") This function returns the name of the current database. If the database
name has a .pan suffix, that suffix is not included. 

info("eof") This function returns true if the database is currently on the last visible
record. (Note: "eof" stands for "end of file".)

info("fieldname") This function returns the name of the current field. See also the
info("modifiedfield") function below.

info("records")

This function returns the total number of records in the current database.
To find out the number of selected records, use info("selected")
(see below).

This example checks to see if all records are selected. If some records are
not selected, the procedure does a selectall statement. 

if info("selected") <info("records")
  selectall 
endif

info("selected")
This function returns the number of selected records in the current data-
base. To find out the total number of records, use info("records")
(see above).

info("summary") This function returns the summary level of the current record, from 0
(data record) to 7 (see “The Summarize & Analyze Dialog” on page 167).

info("visible")

This function returns true/false result based on whether or not the cur-
rent record is visible. Useful for situations where Panorama may scan
invisible records, for example the arraybuild and select statements, also
the Scrolling List SuperObject.

Function Description
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Since we haven’t quite arrived at the age of the totally paperless office, printing is still an important function
of any computer program—including Panorama. This chapter covers the basics of printing.

Printing the Data Sheet

Panorama prints the data sheet exactly as it appears on the screen. If the data sheet is too wide to fit on the
page, Panorama will print extra pages until all the columns are printed.

You can get more data sheet columns on a page several ways. One method is to use the Page Setup dialog to
switch to a wide paper orientation (sideways or landscape), or to reduce the printout to a smaller size (Mac-
intosh only). You can also use a smaller font.

Printing Data Sheet Headers & Footers

The Headers/Footers dialog (File Menu) sets up headers and footers for the data sheet, design sheet, or any
crosstab. (You can set up separate headers and footers for each of these windows.)
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The Headers/Footers dialog allows you to position headers and footers in four locations on the printed page:
top left, top center, top right, and bottom center.

If you want to create a header or footer that is more than one line high, just press the Return key and type in
the additional lines, like this.

When printed this header will look like this.
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You can insert special codes into the header/footer text to print the page number, date, and time. Here’s an
example of how to insert the page number (the printed result is shown above). On the Macintosh the « »
chevron characters are produced by typing Option-\ and Shift-Option-\. On PC systems these characters
are produced by typing Alt-0171 and Alt-0187.

The table below lists some of the special codes that can be inserted into a header or footer:

As the last two entries in this table show, you can actually insert any formula into a header or footer by sur-
rounding the formula with { and }. Here’s an example that uses two formulas to display the database name
and number of records in the footer.

Here’s what the finished footer looks like. See “Calculations & Formulas” on page 273 to learn more about
formulas.

The four buttons just below the header/footer area will insert the most common codes into a header or footer
for you. For example, suppose you wanted the top center header to show the time and date the database was
printed, like this: Printed on May 23rd, 2000 at 4:21 PM. Start by opening the Headers/Footers dialog. Type
Printed on into the Top Center header.

Description Code Example

Page Number «page #» 1

Date «date:mm/dd/yy» 3/7/02

Date «date:Month ddnth, yyyy» April 8th, 2003

Time {timepattern(now(),"hh:mm:ss am/pm"} 2:23:12 PM

Database Name {info("databasename")} Hotels
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Now press the Month dd, YYYY button. Panorama will insert the code for you.

Next type in at and press the hh:mm:ss button.
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Now press OK, and print or preview the data sheet. The top of the printed page will look like this:

Preparing Data For Printing

Before you print the database, you may want to prepare it for printing. If you want the data printed in a cer-
tain order (for example alphabetical by name), you must sort the database before you print it (see “Sorting”
on page 135). If you want to print only a portion of the database (for example, only zip codes in California),
you must use the Find/Select command to make the rest of the database invisible (see “The Find/Select Dia-
log” on page 144). If you want to print subtotals or other summary information, you must group and total the
database before printing (see “The Summarize & Analyze Dialog” on page 167).

The Page Setup Dialog

The Page Setup command in the File Menu displays a dialog that allows you to specify several printing
options. The exact options available depend on the operating system and what kind of printer you are using,
but in general you can control the page size, orientation (tall or wide), and print reduction factor. Here is a
typical Page Setup dialog.
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Each form view has its own separate page setup. The page setup is remembered as part of the form. For
example, a single database can have an invoice that is printed using the tall orientation, and a report that is
printed using the wide orientation (sideways). You don’t have to remember to switch the page setup when
you switch forms—Panorama will do it for you. Incidentally, be sure to save the file after you change the
page setup. If you save the file, Panorama will remember the page setup the next time the file is opened.
(However, not all print options are saved as part of the database. The exact options that are saved vary from
printer to printer.)

The Print Dialog

The Print command also displays a dialog box allowing you to choose printing options. You can choose
which pages to print, how many copies to print, and whether you want to manually feed the paper. The exact
options will depend on the operating system and printer you are using. Here is a typical Print option dialog.

For the exact details on the operation of this dialog see the documentation that came with your printer.
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Printing Labels

To print labels, choose File>Print Labels.

If you’ve used common field names (First, Last, Name, Company, Address, City, State, etc.) Panorama will auto-
matically format the label content for you. Just select the type of label you are using and press the Print
Labels button. (The Page Setup for labels is kept separately for labels and the data sheet. The first time you
print labels you will be asked to set up the Page Setup, or you can change the setup at any time by pressing
the Page Setup button.) When you are done printing labels press the Close button.

Page Setup Options

The dialog allows you to specify various options for printing labels.
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Type of Label

Use the pop-up menu to choose the type of label you want to print.

The bottom section of the dialog displays a preview of the selected labels.
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Label Font and Text Size

Use the pop-up menu to select from a list of common fonts.

Choose Other for a complete list of fonts on your system.
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Label Padding

Each label has a small padding area (margin) around all four edges. You can increase or decrease this pad-
ding.

If you make the padding too large, some of the label text may be cut off.
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Alignment

Within each label, the text can appear in the top left corner, or centered in the middle.

centered on the left,

or centered in the middle.

Label Direction

This option selects whether labels are printed across or down. Across means each row is printed from left to
right, then the next row down, etc. Down means each column is printed from top to bottom, then the next col-
umn to the right, etc.
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Customizing the Label Text

When you open the label dialog for the first time with a new database, Panorama will do the best job it can to
arrange the text on the label. If your field names are standard it will do a pretty good job of this.

If Panorama doesn’t know about the field names you are using it will simply include all of the text columns
in the database in a vertical column.

If this happens, no problem, just click on the text and edit it. You can delete any fields you don’t want on the
label, and also simply type to add any extra text or punctuation you need.
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You can also erase all of the text and build your label from scratch. Fixed text (like Attn: above) is simply
typed in. To include a field name, it must be surrounded with chevron characters (« and »). You can type in
field names manually, but it’s usually easier to insert them by clicking on the + button to the right of the text
and selecting from the pop-up menu.

Note: Only text fields may be used in a label. Numeric and date fields are not allowed. If you need to include
a numeric or date field you should temporarily create a duplicate field and convert the duplicate to text.

Saving Favorite Label Designs

Once you’ve set up a label you may want to save it so that it can be used again. To save a label, click on the
yellow star at the top of the dialog, then choose Add to favorites from the pop-up menu.

You’ll be asked to give a name to your new favorite.
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When you want to re-use your favorite label, just click on the yellow star and choose it from the pop-up
menu.

Note: Each database has its own separate favorite labels. Because the labels include field names, which are
usually different from database to database, you can’t use a favorite set up in one database in any other data-
base.
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Panorama operates on your data in memory, but the data is permanently stored in files on a disk drive. (In
fact, you’ll often find that the words database and file are used interchangeably.) Each Panorama file contains
all the components needed to use the database.

Files, Icons and the Desktop

Before you begin to use Panorama you should be familiar with the basic operation of your computer.
Whether you are using a Macintosh or a Windows based computer, files appear in a “desktop” environment
that allows them to be located, moved, copied and opened. On the Macintosh this desktop environment is
called the Finder. On Windows computers this is simply called the desktop, which you can view with My
Computer or using the Windows Explorer. There are two different kinds of Panorama Sheets icons: data-
bases, and the Panorama application itself.

You can manipulate these icons on the desktop any way you like, just like any other files.

This is the icon for a single Panorama database. On Windows 
machines, these files have the extension .pan. Double click on this icon 
to open the database.

This is the icon for the Panorama application itself, which is usually 
called Panorama (Mac) or Panorama.exe (Windows). You can double 
click this application when you want to create a new database without 
opening an existing database first.
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Launching Panorama

To launch Panorama you can either double click on the Panorama application itself or double click on the
icon for any Panorama database or file set. If you double click on the Panorama application itself the New
Database wizard will appear.

This wizard can be used to create new databases (see “Creating a New Database from Scratch” on page 105),
but it can also be used as a handy “command post” for Panorama using the half dozen or so icons in the top
right corner.

Click here to open the Recent Databases wizard. This wizard makes it easy to re-open data-
bases that were recently opened. See “The Recent Databases Menu and Wizard” on page 348 
for more information.

Click here to open the PDF file you are now reading.

Click here to change the preferences for this wizard, including controlling what happens 
when you double click on the Panorama application icon (see below).
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Changing the Default Launch Action

When you double click on the Panorama application icon Panorama normally opens the New Database wiz-
ard automatically. You can change this, however, by clicking on the Preferences tool in this wizard.

You have several different choices of what action Panorama will take when you double click on its icon. The
most common choices are:

Opening a Database

Before you can work with a database you have to open it. From the desktop the quickest way to do this is to
simply double click on the file’s icon. If Panorama is already running you can use the Open File command
(File Menu) which opens a standard Open File dialog.

Databases and RAM

When a database is opened, Panorama copies the information from the disk into the computer’s internal elec-
tronic memory (RAM). Everything you do to a file takes place in RAM; including data entry, sorting, calculat-
ing, and drawing. If you want to store your work permanently, you must save it from RAM back to the disk
using the Save command.

Most database programs don’t take the extra step of copying the database from the disk into RAM before
working with it. Since your computer can access data in RAM hundreds or even thousands of times faster
than data on the disk, bringing the data into RAM makes Panorama much faster than most other database
programs. If you’ve used other database programs you’ll immediately notice how much “zippier” Panorama
is compared to the programs you are used to.

If your computer has enough RAM available, you can open several Panorama databases at the same time. 

Open the New Database wizard (see “Creating a New Database from Scratch” on 
page 105). This is the default when Panorama is first installed.

Open the Recent Databases wizard (see “The Recent Databases Menu and Wizard” 
on page 348).
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The Recent Databases Menu and Wizard

If a database has been opened recently, you can re-open it by choosing it from the File>Open Recent menu.



Chapter 10:Files Page 349
If the file has been opened before but is not one of the most recent you can find it by choosing the File>Open
Recent>Search Recent command. This opens a window that lists several hundred recently opened data-
bases.

To re-open a database simply double click its name on the list. You can also open the first nine items simply
by pressing the 1 thru 9 keys on your keyboard. There’s no need to press Return, Enter, or anything else,
just press the number and the database will open.

To search for a particular database simply type into the search box at the top of the wizard.

At any time you can press the 1 thru 9 keys to re-open a database. For example type boo1 to open the
Checkbook database, boo2 to launch the Phone Book database, etc. You can re-open any previously opened
database with just a few keystrokes.
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Saving a Database

You can save your work permanently on the disk at any time with the Save, Save As, or Save a Copy As
commands in the File menu. The Save command saves the database permanently on the disk, then allows
you to continue with your work. You should save your work often.

The Save A Copy As command makes a copy of the database under a new name. It leaves the original copy
in memory so you can continue to work on it. This command is like duplicating a sheet of paper and then
continuing to work on the original.

The Save As command also makes a copy of the database under a new name. The Save As command, how-
ever, leaves the new copy in memory—not the original. This command is like duplicating a sheet of paper
and then working on the copy while setting the original aside.

The Save As command allows you to choose the location where you want to save the file, the name of the
new file, and several file options. On Windows computers all Panorama database names end with .pan. This
is called the extension, and it tells the system that this file is a Panorama database. You should not type the
extension into the Save As dialog box—Panorama will automatically add the extension for you.

Appending One Database to Another

To append a database to the end of the current database, choose the Append Database command from the
File menu. This opens a standard dialog for selecting a file.
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Select the database you want to append and press the Choose button. Now a second dialog appears with
options for appending the two databases.

If the Match Fields by Name option is checked, Panorama will examine the two databases and look for fields
with the same names. Only the data in these fields will be appended. For example if both databases contain
fields named Address, City, State and Zip then the information in these fields will be appended. However if
one database has a field named Zip and the other has a field called PostalCode, the data in these fields will
not be appended. The field names must match exactly — Company and COMPANY will not match.

If the Match Fields by Name option is not checked, Panorama will append fields according to their order. In
other words, the first field of the second database will be appended to the first field of the current database,
the second field to the second field, etc. Usually appending two databases this way makes sense only if both
databases have the same fields in the same order. If they don’t, you can open the second database, re-arrange
the fields and then append (see below).

If the Match Fields by Name option is not checked and the database being appended has more fields than the
current database, the extra fields will be ignored. If the data types in the two files are incompatible, some data
may be lost. For example, data will be lost if you try to append text into a numeric field. Panorama will alert
you if this happens, but it cannot tell you exactly what data has been lost.

If the Delete original contents of current database is checked, the second database will replace the current
database instead of being appended to it. Basically this option causes Panorama to completely replace the
contents of the current database with the second database.



Page 352 Panorama Sheets
Monitoring Memory Usage

Each database you open with Panorama is copied into the RAM memory of your computer. For most typical
databases you’ll have plenty of RAM available. You can use the Memory Usage command in the Panorama
Menu to see how much memory is in use and how much is available for expansion or for opening additional
databases. This command opens a statistics window that displays the current memory usage of every open
database, along with overall memory usage statistics.
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Total Recall (Auto-Save/Crash Recovery)

Total Recall allows Panorama to fully recover after a crash -- whether due to a power outage, hardware prob-
lem, system crash, or Panorama bug (never!). When Panorama is relaunched after a crash it asks you if you
want to start over or resume where you left off.

If you press Resume Previous Session Panorama automatically restores everything just as you left it -- all
open files, open windows, etc. Only the last few seconds of work will be lost. It's almost as if nothing has hap-
pened at all — you can just continue with your work as if nothing had happened.

Total Recall does not affect normal file saving, so if you have unsaved changes when the crash occurs, they
will still be unsaved when Panorama is restored (in other words, Revert to Saved can still be used after the
crash/restore cycle). Panorama will even restore any work you've done in a new database that has never
been saved!

Setting the Total Recall Save Frequency

Total Recall works by periodically saving all of Panorama's RAM to disk. It uses the fastest possible tech-
nique for this, so in most cases you'll never even notice this is happening. To adjust how often periodic saves
occur, open the Preferences window and press Total Recall > Adjust Frequency button.

Simply drag the slider to set the time, or to turn the feature completely off.
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Rolling Back Database Changes

As you’ve learned in the previous chapters, Panorama is a powerful tool for working with and manipulating
data, it’s an incredible power tool for your data. Unlike a real power tool, however, you don’t have to worry
about safety or about accidentally destroying data by improper use of the tool. Even if you accidentally
deleted all of your data, Panorama’s capability for rolling back changes will protect you. You can work confi-
dently in the knowledge that your previous work is always safe.

Revert to Saved

Panorama’s first level of rollback is the Revert to Saved command (File Menu). This command recopies the
original file from the disk into RAM. This will undo all the changes made since the last time the file was
saved. By all changes we mean all changes: data entry, sorting, formulas, graphic editing, creating/deleting
forms, crosstabs or procedures—every single thing you’ve done to this database since the last time you
saved. Before Panorama actually goes ahead with this command it asks you to verify that you really want to
do this.

If you press Revert then Panorama will discard all of the changes made since the last time you saved the data-
base.

Time Lapse

Panorama’s Time Lapse feature is like Revert to Saved on steroids. With Time Lapse you can roll back to pre-
vious versions of your database made earlier today or at various times in the past. In addition to doing a full
revert, you can also selectively revert only the data, only the procedures, or only the forms. You can also open
previous versions of the database (called “slices”) in separate windows so that you can compare them with
the current database or even copy and paste data, code or form objects between versions.

Each time you save a database Panorama also makes another copy (“slice”) for the Time Lapse feature. By
default Panorama keeps up to 25 slices of previous versions of the database (more on how Panorama eventu-
ally determines how to “thin out” the slices in a moment.)
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To see the previous slices that have been saved for the current database choose Time Lapse from the File
menu. The slices are displayed in a monthly calendar format.

Choose the year, month and day of the slice you are interested in (it defaults to today). (Note: The 1) Years
and 2) Months lists show the number of slices available in the year and month.) Then choose the exact slice
you are interested in from the list on the right. For each slice the list shows the date and time it was saved, the
number of records, and the contents of the current record at the time the slice was saved.

Once you've selected a slice you can use the tools across the top to work with that slice:

Open Slice Data Sheet —  Click here to open the slice in a separate window. When opening a previous slice
this way Panorama always opens just the data sheet. Panorama ignores any saved window positions, it does
not run any .Initialize procedure, and if this is a shared database it does not connect the database to the server
or try to synchronize the database. The title of the window shows the database name and the date and time
the slice was saved (the original database name may be truncated if necessary).
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As you can see above, the data is all displayed in gray rather than black, and you cannot edit the data. You
can copy it to the clipboard, however.

Though the slice always opens using the data sheet, you can use the View menu to open forms or procedures.
If you try to save the slice Panorama will prompt you for a new file name/location. This makes the slice into
a new, separate database that has no connection with the original database.

Revert Database — Click here to revert the current copy of the database to this previous version. All of the
data, forms, procedures, permanent variables, print settings, etc. are all reverted back to the older version of
the database.

Note: Reverting to a previous slice doesn't prevent you from later reverting to a more recent slice. You can
easily move back in forth in time. Be careful, though, it can get confusing if you don't keep track of what you
are doing.

Revert Data — Click here to revert the just the data to this previous version. All forms, procedures, perma-
nent variables, print settings, etc. are undisturbed. (Essentially Panorama imports the data from the previous
slice into the current copy of the database.)

Revert Procedures — Click here to revert just the procedure code to this previous version. Everything else is
undisturbed. For example, suppose you had made changes to procedures that didn't work out. You could
simply revert the procedures back to the previous code, while keeping all of the updated data, forms, etc. (If
you want to revert just a single procedure, open the previous slice with the Open Slice Data Sheet tool, open
the procedure with the View menu and then manually copy the procedure code.)

Revert Forms — Click here to revert just the procedure code to this previous version. Everything else is
undisturbed.

More Info — Click here to display more information about this saved slice, including a list of the forms, pro-
cedures and crosstabs in the database at the time the slice was saved.

Right Click/Context Menu — In addition to the tools across the top of the window you can also right click on
a slice for a list of operations that can be performed on that slice.

The first six options in this menu are the same as the tools on the top of the window. The last two options
allow you to manually delete saved slices.

Delete — Choose to delete this particular slice.

Delete Before — Choose this to delete all slices saved before this slice. Note: We mean all slices, including
slices saved on previous days, months, and years.
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Time Lapse Preferences

By default Panorama keeps up to 25 “slices” of each database, and it tries to keep slices from a range of peri-
ods, not just the most recent. While in the Time Lapse window you can use the Setup->Global Preferences
dialog to adjust how Panorama decides which slices to keep.

If necessary, you can override the preferences for a specific database. For example, if you have an extra-
important database you may want to keep 50 copies instead of 25. Use the Setup->Preferences Override dia-
log to customize Time Lapse for a particular database.

Important Note: Time Lapse only works with database files that are inside the current users folder. Time
Lapse slices will not be saved if the database is outside this folder (on an external drive, for example).

On the Importance of Backing Up

You’ve heard it before, you’ll hear it again—there’s no substitute for regular backups. Panorama’s Time
Lapse option is great for recovering from your mistakes, but it won’t do you any good if your hard disk fails,
or even gets stolen. Yes, it can happen to you! To protect from fire or theft you should keep your backups at a
separate location. Any experienced user will tell you that “Having good backups means never having to say
you’re sorry!”

Of course some of you will ignore this advice until it happens to you. We get too many sad calls from people
who have lost thousands of records due to a hardware failure. Don’t take a chance on being one of them.
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Finding a Database on the Hard Disk

To find the location of the current database on the hard drive simply choose the Reveal in Finder command
from the File menu.

This will open the folder containing the database and highlight the database file.
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Panorama allows you to freely exchange information between it and other applications. The common terms
for these exchanges are importing and exporting. 

Importing means to transfer information from another program or computer into a Panorama file. The data
can then be manipulated using Panorama’s menu commands and tools. Panorama’s import capabilities allow
you to take advantage of databases that have already been keyed in or databases on other computers (for
instance, on minicomputers or electronic bulletin boards). See “Using the Text Import Wizard” on page 360.

Exporting is the exact opposite of importing. To export data from Panorama means to take data from a Pan-
orama file and make it accessible to another “foreign” program. For example, Panorama data can be exported
to Excel so that it can be included in a spreadsheet. See “Exporting a Text File” on page 370.

Working with Text Files

Panorama cannot directly access information in database or spreadsheet files created by other programs.
Exchanging data between Panorama and another program requires an intermediate text file. A text file is
very basic because it contains just the data—no forms, procedures, graphics, or anything else. Because text
files are so simple, they provide a common interchange format for different programs. Virtually all database,
spreadsheet, and word processing programs can read and write text files. This makes transferring data
between Panorama and another program a two step process. Let’s take Excel as an example. To transfer data
from Panorama to Excel you first must export the data from Panorama as a text file. Then you go into Excel
and import the text file. To transfer data from Excel to Panorama you start by exporting the data from Excel as
a text file. Once the text file has been created you can go into Panorama and import the data from the text file.

On PC systems text files often have a three letter filename extension of .txt, for example My Data.txt. How-
ever, text files may use other extensions as well, such as the .csv (short for comma separated values) file
shown above. Panorama can work with text files with any extension.

On Macintosh systems no extension is required. However we recommend adding .txt to the end of the file-
name anyway. This makes it easier to remember what kind of data is in the file and also improves compatibil-
ity in case the file is ever transferred to a PC system.
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Using the Text Import Wizard

The Text Import Wizard makes it easy to import a text file into an existing database, even if the fields in the
text file are not in the same order as the database fields. Usually you’ll start the process by opening the data-
base you want to import the data into. To illustrate this wizard we’ll use a very simple mailing list file.

To start the import process choose Import Text from the File menu. As you can see the bottom section of the
window shows that we are going to import into the Mailing List file, and lists the five fields in this database.

The next step is to select the text you want to import into this database. There are four possible ways to do
this.

1) Drag a tab or comma delimited text file onto the top half of the wizard.
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2) Drag data directly from a spreadsheet, word processor or text editor onto the top half of the wizard (Mac
only), as shown below.

3) Click on the Choose Text File button, then select a text file containing tab or comma delimited text.

4) Copy tab or comma delimited text into the clipboard, then press the Import from Clipboard button.

The selected text will appear in the top section of the wizard.
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If the imported text is already in the correct arrangement you can simply click on the Favorites button (yel-
low star), choose ALL IMPORT COLUMNS from the pop-up menu, then press the Import button. Other-
wise, the next step is setting up the import configuration. There are several ways to do that, but usually the
easiest is to drag fields from the top to the bottom section of the wizard. 

When you release the mouse the wizard will update the import configuration.
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You’ll need to drag each field you want to import down from the top to the bottom.

Sometimes the data you want to import doesn’t match the fields in the database. In this case the database has
only a single Name field, but the import data contains separate first and last names. Somehow these separate
fields will need to be combined as the data is imported. The import wizard allows you to do this with a for-
mula (see “Calculations & Formulas” on page 273). To edit the formula for a field double click anywhere in
the field’s column.

double click 
in column to 
edit formula
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Within this formula you can include any import field by typing the field number in between « and » charac-
ters (see “Special Characters” on page 288, or simply use the Fields menu to type in the field number for you).
To “glue” two text items together you can use the + symbol (see “Gluing Strings Together” on page 294). To
include constant text in the formula put the text inside quotes (see “Constants” on page 284). The illustration
below shows a formula that combines the first and last name into a single field (with a space in between).

Press the OK button to preview the result of this formula.

You are almost ready to import the data. Before you do, make sure that the Append or Replace option you
want is selected. Append will append the new data to whatever data is already in the database, while
Replace will erase and replace the existing data.) You may also want to choose to skip the first line of the
imported data.

Now press the Import button. The wizard imports the data into the original database.

result

formula
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Common Import Formulas

Using a formula you can combine import fields, split import fields, convert to upper case or lower case, and
much much more. You’ve already learned how to combine two or more import fields together with the +
symbol like this (see “Gluing Strings Together” on page 294).

«1»+" "+«2»

«2»+", "+«1»

To pick out a single word (for example a first or last name) you can use the firstword( or lastword(
functions (see “Text Arrays” on page 302). Here is a formula for picking the first name from a combined name
field (assumed to be the first field, «1», and using the format First Last, for example John Smith).

firstword(«1»)

To convert text to upper case use the upper( function (see “String Modification Functions” on page 298).
This formula extracts the last name and converts it to upper case.

upper(lastword(«1»))

To extract only a limited number of characters use a text funnel (see “Taking Strings Apart (Text Funnels)” on
page 296). This formula extracts the first five characters from a zip code.

«6»[1,5]

This table lists some common formulas that can be useful when importing.

Formula Description

firstword(«1») extract the first word of the first import column

lastword(«1») extract the last word of the first import column

«1»+" "+«2» combine the first and second import columns (with a space in between)

trimstart(«1»,2) include everything but the first two characters of the first import column

trim(«1»,3) include everything but the last two characters of the first import column

«1»[2,4] extract the 2nd thru 4th characters from the first import column

upper(«1») include first import column, converted to upper case (all caps)

lower(«1») include first import column, converted to lower case

upperword(«1») include first import column, first character of each word capitalized

striptoalpha(«1») include first import column, but only alphabetic characters

stripchar(«1»,"09..--") include first import column, but only numeric digits, periods, and minus signs 
(useful for importing numbers when there are extraneous characters like cur-
rency symbols)
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Here is an example that uses several of these techniques.

To learn more about Panorama formulas see “Calculations & Formulas” on page 273.

firstword(«1»)

upper(lastword(«1»))
«5»[1,5]
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More Import Configuration Techniques

This section describes some additional techniques for setting up the import configuration.

Tab Width

The top section of the Text Import wizard displays the data to be imported in fixed width columns. Click on
the Tab Width icon to change the width of these columns.

Configuration Context Menus

As an alternate to dragging columns you can set up the configuration by right clicking on either the top or
bottom section of the wizard. Right clicking on an imported column allows you to choose a database field to
“slot” the imported column into.
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Right clicking on a database field allows you to choose an import column to “slot” into that field. You can
also edit the formula associated with the field, or clear the field.

Rearranging and Deleting Import Columns

If you make a mistake you can simply drag the column to the correct position, or drag it completely out of the
bottom section to remove it.

You can also remove a column by right-clicking on it and choosing Clear from the pop-up menu.

Starting Over

To start over, simply drag another text file onto the top section of the dialog. Or, you can click on the trash can
icon.

Clear Import Configuration clears out the bottom section of the wizard. Reset Wizard clears the entire wiz-
ard, after using this option you must re-select the text to be imported.

Choosing a Database to Import Into

The Text Import Wizard normally imports into database that was active when the wizard was opened. How-
ever, you can use the Database menu to choose to import into any open database. Simply choose the data-
base you want to import into and then set up the configuration.



Chapter 11:Importing & Exporting Data Page 369
Importing into a New Database

The Text Import wizard is for importing into an existing database. If you decide you would rather import
into a new database, click the Import into new database icon. (This icon does not appear until you have
selected a text file.)

Saving the Import Configuration for Later

To save an import configuration for later, click on the Favorites icon and choose Add to favorites.

You’ll be asked to give the new favorite a name. (If you use the name of the text file being imported, Pan-
orama will automatically use this favorite configuration if you later re-import this text file.)

Later you can use the pop-up menu to bring back the saved configuration.
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If you want to delete or rename a favorite, first select it, then click on the Favorites star again. Then choose
Remove or Rename.

ALL IMPORT COLUMNS. In addition to the favorites you set up, Panorama automatically sets up a favor-
ite called ALL IMPORT COLUMNS. This favorite sets up a configuration where the first imported text field
goes into the first database field, the second database field into the second field, etc.

Exporting a Text File

To export the selected records (see “Finding vs. Selecting” on page 139) in the current database into a text file,
use the Text Export Wizard. This wizard allows you to specify the order of the fields being exported, and to
manipulate the data as it is being exported (converting it to upper case, for example, or combining several
database fields into one export field). The wizard can even be used to convert the database into an HTML
table. To illustrate this wizard we will use this database of national parks.
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To begin the export process choose Export Text from the File menu. The top section of the dialog shows the
database being exported, the bottom section shows a preview of the exported text. When you first open the
wizard, it is automatically configured to export all fields in the database, in the order they appear in the data-
base.

Use the pop-up menu to choose the format of the exported text.

database

export
preview
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If you are using a Macintosh you can export the text simply by dragging from the Export Text icon to wher-
ever you need to go. For example, you can drag the icon onto any folder (any Finder window).

You can also drag onto any application that can receive dropped text. For example, you can drag onto a Num-
bers spreadsheet, as shown here:
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Many word processors can also handle tabular data. For example, you could drag exported Panorama data
directly into a table in Pages, like this:

If you are using a Windows system, or if you don’t want to drag, just click on the Export Text icon instead of
dragging. This opens a dialog that allows you to select a location for the exported text. You can also use the
Export menu to export to a file or to the clipboard (right clicking on the Export Text icon also displays this
menu.)
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Customizing the Export Field Arrangement

When you first open the Text Export wizard it defaults to exporting all of the fields in the database. You can
easily customize this if you need a different arrangement. If you want to start from scratch, click on the Clear
icon (you can always go back to all fields by clicking on the yellow star and choosing ALL FIELDS from the
Template pop-up menu). Then you can drag fields from the database (top section) to the export (bottom sec-
tion).

If you make a mistake don't worry, just re-drag the column into the correct spot. Or you can drag a column
out of the export area to remove it.
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Another method for setting up the configuration is to right click on an export column. This gives you options
for editing the column options (more on that in a moment), inserting a deleting columns, and setting the col-
umn to a database field.

There is a similar pop-up menu if you right click on a database field.

Preview Tab Width

The wizard defaults to displaying the previewed export columns on 1.5 inch spacings. To change the spacing,
click on the Preview Tab Width icon and choose the width from the pop-up menu.
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Customizing Export Column Properties

So far we've assumed that the columns in exported text will consist of unmodified database fields -- re-
arranged, perhaps, but otherwise unchanged. However, it's possible for Panorama to manipulate the data as
it is exported. You can combine two database fields into one exported column, split one database field into
two export columns, force to upper or lower case, etc. If the Include Title Line option has been enabled you
can also customize the title of each column. To make these changes simply double click on any column in the
lower section of the wizard, or right click and choose Edit Column Properties from the pop-up menu. This
dialog will appear:

To manipulate the data as it is being exported, edit the formula. You can use any function or operator as part
of the formula. For example, this formula converts the category field to upper case as it is being exported:

For assistance in constructing a formula, press the Build Formula icon. This opens the Manipulate Data dia-
log, which you can use to build a formula step-by-step (see “The Manipulate Data Dialog” on page 230).
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When you close the Column Properties dialog the wizard shows a preview of what the manipulated export
column will look like (in this case the field is being converted to all upper case as it is exported).

The Text Export Wizard allows you to use any valid Panorama formula (see “Text Formulas” on page 294) to
create each item.

Export Templates

If you think you’ll need to use an export configuration more than once you can save it as a template. The first
step is to set up the configuration (as described in the previous section). Once the configuration is set up you
can save it with the Save Template or Save Template As… commands in the Template menu. This menu is
available in the menu bar or by clicking the yellow star:
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The wizard will prompt you to type in a name for the new template (the default is the name of the text file
being imported).

Once a template has been saved you can open it again by selecting it from the Template menu. (Note: The
template is actually stored in the database being imported into (in this case National Parks). The template is
only available when that database is being exported from. Each database may contain its own separate set of
templates, which makes sense since the export configuration used with one database is not likely to work
with any other database.)

The wizard loads the entire export configuration, ready to go. You can use the configuration as is or modify it
before you actually import the data.

If you want to delete or rename a template choose the Rename/Delete Templates… command from the Tem-
plate menu. To rename a template first click on it and then press the Rename button. A dialog appears allow-
ing you to type in a new name. To delete a template press the Delete button.

When you are done press the OK button.

Choosing a Database to Export From

The Text Export Wizard normally exports from database that was active when the wizard was opened. How-
ever, you can use the Database menu to choose to export from any open database. Simply choose the data-
base you want to export from and then set up the configuration.
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Panorama preferences are accesible from the Panorama menu. Choosing Panorama-> Preferences opens the
main preferences window (the exact configuration may vary somewhat):

Double clicking on Panorama opens…

This option controls what happens when you double click on the Panorama application. The most common
options are the Recent Databases wizard (allowing you to quickly open previously used databases) and the
Open File dialog (this was the default in earlier versions of Panorama.)
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Open With Panorama

Clicking on the Fix Database Launch Info button opens a secondary window.

This window can be used on Macintosh computers to fix database files that have lost their connection with
Panorama (for example if they have been copied to a PC and back, or even copied on a USB memory stick
that is formatted for PC systems instead of Mac systems). Simply drag the files from the Finder onto this win-
dow.

There are two options. Set Creator Code tells MacOS that this is a general Panorama database, and will allow
it to work with any copy of Panorama. The Always open with this copy of Panorama ties the database to this
exact copy of Panorama, even if there are multiple copies of Panorama installed on your system. This is the
same as clicking on the file in the Finder, choosing Get Info, then using the Open With pop-up menu.

Total Recall

Clicking the Adjust Freqency button opens a secondary window that allows you to turn Total Recall on and
off, and to adjust how frequently Total Recall saves memory to the disk.

Simply drag the slider to set the time, or to turn the feature completely off. See “Total Recall (Auto-Save/
Crash Recovery)” on page 353 to learn more about this feature.

Data Sheet Options - Minimum Smooth Text Size

This option controls whether or not text in the data sheet is smoothed (this option is for Mac OS X only, on
Windows systems it will always be smoothed if smooth text is available). The pop-up menu allows you to
choose whether to always smooth, never smooth, or to only smooth above a specified point size.
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Data Sheet Options - Background Colors

In the data sheet, Panorama normally displays data cells with a light green background and summary
records with various shades of blue. This section of the preferences allows you to change these colors. For
example you could change the data background to white, gray or yellow. To change a color simply click on
one of the eight color swatches.

Use the color picker to choose the color, then press OK. Any open datasheets will update to show the new
color.

New Database Options

These options control the font and text size for new databases.
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Search Options

These options customize the operation of the Find/Select dialog. See “Customizing the Find/Select Dialog”
on page 165 for more information.

Data Manipulation Options

These options customize the operation of the Manipulate Data in Field dialog. See “Customizing the Manip-
ulate Data Dialog” on page 261 for more information.

Data Analysis Options

These options customize the operation of the Summarize & Analzye dialog (see “The Summarize & Analyze
Dialog” on page 167).

Allow Numeric Group Fields

The Summarize & Analzye dialog normally lists only text and date fields in the group pop-up menu. If you
want to list numeric fields also, check this option.

Allow Subset Analysis

The Summarize & Analzye dialog normally selects all of the data in the database before peforming the anal-
ysis. If you want to be able to analyze a selected subset of a database check this option.

Warnings

The Warn before deleting data from multiple records option controls whether Panorama will warn you (with
an alert) before deleting data from multiple records in the database. Since Panorama’s Time Lapse feature
allows you to recover previous versions of your databases, you may want to turn off this warning.
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